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Except as provided in writing signed by an officer to Biochrom Ltd, this system and any 
related documentation are provided “as is” withoutwarranty of any kind, expressed or 
implied, including that the system is “error free.”This information is presented in good 
faith, but Biochrom Ltd does not warrant, guarantee, or make any representations 
regarding the use or the results of the use of this system and related documentation in 
terms of correctness,accuracy, reliability, currentness, omissions, or otherwise. The entire 
risk as to theuse, results, and performance of this system and related documentation is 
assumed bythe user. 
 
Except as expressly provided herein, Biochrom Ltd makes noother warranty, whether oral 
or written, expressed or implied, as to any matterwhatsoever, including but not limited to 
those concerning merchantability and fitnessfor a particular purpose, nor is freedom from 
any patent owned by Biochrom Ltd or by others to be inferred. 
 
LIMITATIONS OF LIABILITY 
Biochrom Ltd shall not be liable, to any extent whatsoever, forany damages resulting from 
or arising out of the use or performance of this systemand related documentation or the 
procedures specified in this manual, regardless offoreseeability or the form of action, 
whether in contract, tort (including negligence),breach of warranty, strict liability or 
otherwise, and including but not limited todamages resulting from loss of data, loss of 
anticipated profits, or any special,indirect, incidental or consequential damages. In no 
event shall Anthos LabtecInstruments GmbH’s liability to the user exceed the amount paid 
by the user to Biochrom Ltd hereunder. The user assumes full responsibility for the results 
obtained from the use of this system and related documentation and forapplication of 
such results. 
 
Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. IBM is a trademark of 
International Business Machines Corporation in the United States, other countries, or 
both. Pentium is a registered trademark of Intel Corporation. Adobe, Acrobat, and 
Postscript are either registered trademarks or trademarks of Adobe Systems Incorporated 
in the United States and/or other countries. All other trademarks appearing in this manual 
are owned by their respective companies.iii 
ADAP Software for Zenyth 200 Operating Manual 
Warranty and Returned Goods Requirements 
All standard Biochrom Ltd policies governing returned goodsapply to this product. Subject 
to the exceptions and upon the conditions stated below,the Company warrants that the 
products sold under this sales agreement shall be freefrom defects in workmanship and 
materials for two years after delivery of theproducts to the original Purchaser by the 
Company, and if any such product shouldprove to be defective within such two years 
period, the Company agrees, at its option,either (1) to correct by repair or at the 
Company’s election by replacement, any suchdefective product provided that investigation 
and factory inspection discloses thatsuch defect developed under normal and proper use, 
or (2) to refund the purchaseprice. The exceptions and conditions mentioned above are as 
follows: 
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Components or accessories manufactured by the Company which by their nature are not 

intended to and will not function for one year are warranted only to reasonable service for a 

reasonable time. What constitutes a reasonable time and a reasonable service shall be 

determined solely by the Company. A complete list of such components and accessories is 

maintaine at the factory. 

 

The Company makes no warranty with respect to components or accessoriesnot manufactured 

by it. In the event of defect in any such component or accessory, the Company will give 

reasonable assistance to Purchaser in obtaining from the manufacturer’s own warranty. 

 

Any product claimed to be defective must, if required by the Company, be returned to the 

factory, transportation charges prepaid, and will be returned to Purchaser with transportation 

charges collect unless the product is found to be defective, in which case the product must be 

properly decontaminated of any chemical, biological, or radioactive hazardous material. 

 

 The Company shall be released from all obligations under all warranties, either expressed or 

implied, if any product covered hereby is repaired or modified by persons other than its own 

authorized service personnel, unless such repair by others is made with the written consent of 

the Company. 

 

If the product is a reagent or the like, it is warranted only to conform to the quantity and 

content and for the period (but not in excess of one year) stated on the label at the time of 

delivery. It is expressly agreed that the above warranty shall be in lieu of all warranties of 

fitness and of the warranty of merchantability, and that the company shall have no liability for 

special or consequential damages of any kind or from any cause whatsoever arising out of the 

manufacture, use, sale, handling, repair, maintenance, or replacement of any of the products 

sold under the sales agreement. Representatives and warranties made by any person, 

including dealers and representatives of the Company, which are consistent or in conflict with 

the terms of this warranty, shall not be binding upon the Company unless reduced in writing 

and approved by an expressly authorized officer of the Company. Parts replaced during the 

warranty period are warranted to the end of the instrument warranty.  
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1. Installing and Launching ADAP Software 
 

1.1. Overview 

The ADAP software is a Windows®-based control program for the Zenyth 200 
spectrophotometer.  
 
Two versions of the ADAP software are available for the Zenyth 200: ADAP Basic and 
ADAP Primsa. 
 
ADAP Basic software, which is provided with the instrument, is capable of performing 
several types of photometric measurements on microplate and cuvette samples: 

 
• Single wavelength or bichromatic endpoint 
• Single wavelength or bichromatic kinetic 
• Multiwavelength 
• Spectral scan 
• Linear scan 
• Area scan 

 
Note: Linear and area scan measurements may be performed only on microplates. 
Upgrading to the ADAP Prisma software adds the ELISA and Quantitation modules, 
which feature advanced programming and evaluation capabilities. 
 
Note: An instrument-dependent license code is required to access the ADAP Prisma 
functionality. The code is provided when purchasing an ADAP Prisma software license.  

 
The ELISA module features the ability to: 
 

 Define and perform quantitative evaluations, including curve fitting, and standard 

curves. 

 Define and perform qualitative evaluations, including cutoff formulas and groups. 

 Define plate layouts, including programming of blanks, standards and controls. 

 Eliminate replicates and program test validation formulas. 

 Recalculate reduced data from kinetic assays. 

 Assign sample IDs. 

 Configure multitest assays. 

 
The Quantitation module features the ability to: 
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 Quickly and easily define and perform quantitative assays, including quantitation of 

samples with unknown concentrations. 

 Define and perform spectral scan and multiwavelength assays. 

 Perform the most common cuvette applications including: 

 Measuring nucleic acid concentration 

 Measuring oligo concentration, melting point, and conversion to pmol/μL. 

 Measuring direct protein concentration at 280 nm. 

 Determining the purity of DNA preparations. 

 Monitoring bacterial growth with preset or user-defined conversion factors. 

1.2. Installing the ADAP Software 

 
Installing the ADAP software requires: 

 

 Meeting the minimum computer system requirements for the ADAP software. 

 Running the setup program. 

1.2.1.  System Requirements 

 
Before installing the ADAP software, refer to Table 1-1 to ensure the target computer 
system meets the minimum requirements. Where relevant, Table 1-1 also lists 
recommended but not essential system requirements. 

 
TABLE 1-1. ADAP BASIC SOFTWARE SYSTEM REQUIREMENTS 

 

COMPONENT  MINIMUM REQUIREMENTS  

CPU  Pentium® II 500 Mhz recommended 
Pentium® 133 Mhz minimum 

RAM  16 MB minimum  
64 MB recommended 

Hard Drive  50 MB free space 

Monitor  640x480 resolution  

CD-ROM  Drive 4X 

Mouse  IBM® compatible 

Serial Port 1 free serial port per instrument connected 

Operating Systems  Windows® 95 (Y2K update required) 
Windows® 98 (Y2K update 2 required) 
Windows® 98 Second Edition 
Windows® Millennium Edition 
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Windows NT® 4 (Service Pack 5 or higher) 
Windows® 2000 
Windows® XP 
Windows® 7 
Windows® Vista 

Web Browser Internet 
Explorer 4.01 (Service 
Pack 2 or later) 

Web Browser Internet Explorer 4.01 (Service Pack 2 or 
later) 

Database  Microsoft Data Access Components (MDAC) 2.6* 

Keyboard 101 key Keyboard 101 key 

*The ADAP software installer automatically installs MDAC 2.6 if it is not present on the 
system. 
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1.2.2. Running the Setup Program 

 
The ADAP software setup program installs all of the components required for the 
ADAP software to run. 
 
To install the ADAP software: 
 
Note: Before installing the ADAP software on a computer equipped with Windows® NT 
4, 2000, XP, Windows 7 or Vista set up with multiple user accounts, the user must log 
into an account with Administrator privileges. Users logged into an account with 
Limited access are not permitted to install the software. 

 
1. Exit all open Windows programs before running the ADAP software setup 

program. 

2. Insert the ADAP software installation CD into the CD-ROM drive. After a few 

seconds, the welcome page will open: 

Note: If the ADAP software setup program does not appear automatically, use 
Windows Explorer to locate the CD-ROM drive and open Setup.exe. 

 
3. Follow the instructions in the setup wizard to install the software. 

4. When the software installation is complete, choose Close to exit the setup 

program. 

5. The ADAP software is ready to use. 

OR 
If prompted, choose Restart. After the computer restarts, the ADAP software will 
be ready to use. 

 

1.2.3. Launching the ADAP Software 

 
To launch the ADAP software: 
 
1. From the Windows® Start menu, choose Programs>Anthos Software>ADAP. 

2. The first time the ADAP software is launched, License Code appears: 
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Note: A License Code is required only for the ADAP Prisma software. 
 
Note: To access License Code after running the ADAP software for the first time, from t

 the Windows menu, choose About, and then choose License Code. 
 
3. Choose Add License Code to verify the License Code entered. 

Note: If the license code cannot be verified, re-enter it and choose Add License Code 
again. 
OR 
Choose OK to close License Code if no license code was entered. 

 
Note: Delete Code is used to delete time-limited promotional License Codes used to 
demonstrate advanced software features. Service codes used by Anthos service 
engineers to test instrument functionality may also be deleted. 
 

4. Choose OK to close License Code. Login appears (Figure 1-2). 

 
 

5. Enter the User Name and Password.  

TABLE 1-2. GENERIC USER NAMES AND PASSWORDS 
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Note: If a password is forgotten, contact the system administrator or Biochrom 
service. 
 
Note: The first user who logs into the ADAP software should accept the role of system 
administrator. Log in using the generic system administrator user name and password 
in Table 1-2. After logging in the first time, the password should be changed. 
 

6. Choose OK. ADAP appears. 

 
  

 

     

  

User Name  Password  User Level 

sadmin sadmin System administrator(user level 3) 

admin admin Local administrator (user level 2) 

user user User (user level 1) 
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2.   
 

3.  User Login and System 

3.1. Overview 

The ADAP software has the ability to manage up to 50 different users. Only authorized 
users are able to operate the system, and are identified in the user activity log and on 
printed reports generated by the software. A hierarchy with three different user levels is 
implemented: 

 Level 1 — These users can perform Quick, Test, and Multitest measurements. 
However, they may not create, edit, or delete test definitions or configure system 
and instrument parameters. 
 

 Level 2 (local administrator) — Along with performing Quick, Test, and Multitest 
measurements, Level 2 users are allowed to create, edit, and delete test 
definitions and configure some system and instrument parameters. 

 

 Level 3 (system administrator) — These users have the same privileges as Level 1 
and Level 2 users, and may also add and delete Level 1 and Level 2 users, edit 
existing user information for Level 1 and Level 2 users, and provide user 
passwords. They may add Level 3 users, but may not edit or delete Level 3 
accounts after they are created. 

 
Note: Test and Multitest measurements are available only in the ADAP Prisma 
software. 

 
User administration includes: 
 

 Accepting the role of system administrator the first time the software is run 
(refer to Section 2.2, Accepting the Role of System Administrator the First Time 
the ADAP Software is Run). 
 

 Logging into the ADAP software  
 

 Changing a password. 
 

 Adding and deleting users, as well as editing user information. 
 

 Viewing the user log. 
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3.1.1. Accepting the Role of System Administrator  

 
The first time the software is run, the person logging in must accept the role of system 
administrator (Level 3) and immediately change the default provided password. 
 

Note: More than one user may assume the role of a system administrator. 
 

A system administrator (Level 3) can: 

 Add Level 1, Level 2, and Level 3 users. 

 Delete Level 1 and Level 2 users. 

 Edit existing user information of Level 1 and Level 2 users 

 Provide user passwords for Level 1, Level 2, and new Level 3 users. 

 

A system administrator (Level 3) cannot: 

 Delete other Level 3 users. 

 Edit existing user information of other Level 3 users. 

3.2. Logging Into the ADAP Software 

Authorized users must log in with their individual user name and password each time 
ADAP software is started. 
 

Note: After seven minutes of inactivity, users are automatically logged out and 
must log in again to continue using the software. 
 
The first time a user logs in, the default user name and password in Table 2-1 must be 
used according to the user level. After logging in with a default user name and 
password, the password should be changed. 
 

3.2.1. To log into the ADAP software: 

1. From the Start menu, choose Programs>Anthos Software>ADAP. The ADAP 

software starts up and Login appears (Figure 2-1). 
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2. Enter the User and Password. 

Note: If a password is forgotten, contact the system administrator or Biochrom 
service. 

 
3. Choose OK. 

Note: If a Level 1 or Level 2 user attempts to access a software function they do 
not have permission to perform, Login appears. To access the software function, a 
User and Password for a user with permission to perform the function must be 
entered. 
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TABLE 2-1. DEFAULT USER NAMES AND PASSWORDS 
 
 
 
 
 
 

3.2.2. Changing a Password 

The user should change the password after logging in the first time with a default user 
name and password (Table 2-1). However, users may change their password at any 
time. 
 
To change a password: 
1. Start the ADAP software. 

OR 
 
From the Setup menu, choose Change User. Login appears. 
 
 
2. Enter a valid User Name and Password. Change Password appears

 

 
3. Choose Change Password. Login expands to display password information.  

 

 

4.  In New Password, enter the new password. 

Note: Passwords are case sensitive and limited to 15 characters, including spaces. 

User Name  Password  User Level 

sadmin sadmin System administrator(user level 3) 

admin admin Local administrator (user level 2) 

user user User (user level 1) 
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5. In Confirm, enter the new password a second time. 

6. Choose OK. The user is logged in and the password is changed.  
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3.2.3. Adding, Editing, and Deleting Users 

Only system administrators (Level 3) can add, edit, and delete users. For Level 1 and 
Level 2 users, a system administrator can add and delete users, edit user information 
and assign passwords. A system administrator can create new system administrator 
(Level 3) accounts, but cannot edit or delete other system administrator accounts after 
they have been created. 
 

 Adding New Users 

A system administrator (Level 3) creates new user names and passwords for new 
users. 

 
To add a new user: 
 
1. Start the ADAP software. 

OR  
From the Setup menu, choose Change User. 
OR 
From the toolbar, choose User. Login appears  

 
 

2. Enter a valid system administrator (Level 3) User Name and Password. A Change 

Password button appears 

3. Choose Change Password. Login expands to display detailed user information. 
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4. In User, enter a user name for the new user. 

5. In Password, enter the password the new user will use to login to the ADAP 

software. 

Note: Passwords are case sensitive and limited to 15 characters including spaces. 
 

6. In Full Name, enter the full name of the new user. 

Note: A user’s Full Name appears in the user log table and on printed reports 
generated by the software. 
 

7. Select the desired Level for the new user (refer to Section 2.1, Overview) 

8. Choose OK to add the user and exit Login. The user may now log on using the new 

user name and password. 

OR 
 
Choose Add User to add another user. 
 
OR 
 
Choose Cancel to delete the new user from the list and exit Login. 

 
Deleting Users 
A system administrator (Level 3) can delete Level 1 and Level 2 users. 

Note: Only system administrators (Level 3) can delete users. However, they are not 
permitted to delete other system administrators. 
 

To delete a user: 
1. Start the ADAP software. 

OR 
From the Setup menu, choose Change User. 
OR 
From the toolbar, choose User. Login appears. 
 

2. Enter a valid system administrator (Level 3) User Name and Password.Change 

Password appears:  
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3. Choose Change Password. Login expands to display detailed user information 

 

 
4. In User, select the user to be deleted. 

5. Choose Delete User. The user is removed from the user list. 

6. Choose OK to delete the selected user from the software and exit Login. 

OR 
Choose Cancel to prevent deleting the selected user from the software and exit Login. 

 
Note: Only one user may be deleted each time Login is open. To delete additional 
users, exit Login, then reopen it to delete the next user. 

 
Editing Existing User Information 
A system administrator (Level 3) can edit existing user information, including user name, 
password, full name, and user level, for Level 1 and Level 2 users. 

Note: Only system administrators (Level 3) can edit existing user information. 
However, they are not permitted to edit user information for other system 
administrators. 
 

To edit user information: 
1. Start the ADAP software. 

OR 
 
From the Setup menu, choose Change User. 
 
OR 
 
From the toolbar, choose User. Login appears 
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2. Enter a system administration (Level 3) User Name and Password. Change Password 

appears. 

 

3. Choose Change Password. Login expands to display detailed user information. 

 
 
4. In User, select the desired user to edit. 

 
5. Edit the user information as desired. 

 
6. Choose OK to save changes made to the user information and exit Login. 

 

OR 

Choose Cancel to discard changes made to the user information and exit Login. 
 

3.2.4. Viewing the User Log Table 

The ADAP software maintains an activity log that tracks certain events performed in 
the software. The log may be saved in text format so that it can be imported into other 
software applications. 
 
An event is added to the log whenever: 

• A user logs into the ADAP software. 
• Quick measurements are run or have parameters changed. 
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• A test definition is created or modified (ADAP Prisma only). 
• Tests or multitest assays are run or reevaluated (ADAP Prisma only). 
• A database error is reported. 
• The ADAP software is closed. 
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To view the log table: 
 

From the Database menu, choose View Log Table. Log-Table appears. 

 

Saving the Entire Log Table as a Text File 

The entire log table can be saved as a tab-delimited text file which can be 
imported into another software application, such as a spreadsheet or database. 

 
To save the data in Log-Table as a text file: 

 
1. From the File menu, choose Save. Save As appears. 

2. Browse to the desired folder to save the history log file. 

3. In File name, enter a file name for the history log. 

4. Choose Save to save the history log to a text file. 

 
Copying the Entire Log Table to the Clipboard 
 
The entire log table can be copied to the clipboard as tab-delimited text and 
pasted into any application using the Paste command. 
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Note: The contents of the entire log table will be copied. Portions of the log table 
cannot be copied separately. 

 
To copy the data in Log-Table to the clipboard: 
 
1. From the Edit menu, choose Copy. The contents of the Log-Table are copied 

to the clipboard. 

2. Open or switch to the application where the log contents will be pasted. 

3. Choose the Paste command to paste the history log into a new or existing file. 

Note: Most applications have a standard shortcut of CTRL+V assigned to the Paste 
command. 
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3. Configuring the Instrument to Perform Measurements 

3.1 Overview 

Before performing measurements, the instrument setup and system settings must be 
configured. Instrument setup includes configuring communications and temperature 
settings. System settings designate the file format and storage location of measurement 
results data, the language in which the ADAP software is run, and the text of printout 
header lines. 
 
Configuring the ADAP software includes: 

 Configuring the instrument setup  

 Configuring system settings  

Note: Only users with Level 2 (administrator) and Level 3 (system administrator) 

access may configure instrument setup and system settings. 

3.1. Configuring the Instrument Setup 

Instrument parameters are displayed and configured in Instrument. 
  
Instrument is divided into five configuration areas: 

 Instrument — Configures communications settings and displays instrument 
information. 

 Filter — Displays the range of wavelengths available for measurements. No 
configuration is required. 

 Installed Plates — Displays plate formats that can be used by the instrument. 

 Temperature — Displays and sets the internal instrument temperature. 

 Service Code — For Biochrom Service Engineers only. 
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3.1.1. To access Instrument: 

1. From the Setup menu, select Instrument. Instrument appears: 

 
2. The options in Instrument configure communications settings between the 

computer and Zenyth 200 and display current information about the 
connected instrument. 

 
3. To configure the communications settings:  

 

a. In Baudrate, select Auto Sense or the desired baud rate for 
communication between the ADAP software and the microplate 
reader. Setting a specific Baudrate, such as 9600, requires that the 
Baudrate setting on the instrument match that in the ADAP 
software. 

 
Note: The Zenyth 200 supports baudrates of 9600, 19200, and 
38400. 
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b. In COM Port, select Auto Sense or the serial communications port 
on the back of the computer to which the microplate reader is 
connected. 
 

c. In Instrument Type, select Zenyth 200. 
 

d. Select Read Configuration. Plate formats stored in the instrument 
are read and displayed in Installed Plates. 

 

 

3.1.2. Viewing Installed Plates 

Installed Plates displays all the plate formats that can be used in 
measurements performed by the instrument. 

 
Note: Installed Plates is automatically populated when Read Configuration is 
selected in Instrument. 
 

3.1.3. Setting the Instrument Temperature 

The Zenyth 200 features the ability to perform temperature-controlled 
incubations. 
To set the temperature: 

 

1. In Type, select Celsius or Fahrenheit. 

Note: The Fahrenheit scale is available only on instruments sold in the 
United States. 
 

2. Choose Read Temperature to display the current instrument temperature. 

3. In Set Temperature, enter the desired temperature for incubation. 

Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
 

4. Choose Set Temperature to prepare the Zenyth 200 for incubation. 

5. To determine when the desired incubation temperature has been reached, 
choose Read Temperature until the current temperature of the Zenyth 
200 matches the desired incubation temperature. 
 
Note: The incubation temperature will remain at the current setting until 
Set Temperature is changed. 
 
Note: To turn temperature control off, in Set Temperature, enter 0. 
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3.2. Configuring System Settings 

System settings, including data storage path, raw data format, and printout headers, 
are configured in Setup-System. 

 
To configure system settings: 
 
1. From the Setup menu, select System. Setup-System appears. 

 

2. To create a new database, select the desired local or network drive. Folders on the 
selected drive are displayed in the upper. 
 

3. Browse to the desired location where the database will be created by double-
clicking the desired folders. 

 
Note: Changing the Path when a database already exists creates a new database 
and makes the original database inaccessible to the ADAP software. Plate layouts, 
test definitions, and test results stored in the original database will not be 
available to the ADAP software unless the to the database is restored. 

4. In Raw data, choose the desired file format for saving raw data: 
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a. • TXT — Saves the raw data as a text file readable by most word 
processing applications. 
 

b. • XML — Saves the raw data as an XML file. XML is a format designed for 
sharing information over the Web. 

 

 
5. In Database, select Access to store measurement data in the ADAP software 

database. 
 
Note: If no Database options are selected, options for manually saving the data 
appear after each measurement. If no save option is selected at this time, the 
measurement data is not saved. 
 
Note: Selecting Access ensures that all measurement data is saved and may be 
exported to text files for viewing in other software applications. For example, after 
a measurement is completed and saved, exporting the measurement data from 
the database is the only method available to create a text file with the data 
arranged as a matrix. 
 

6. In Database, select a text file format to store measurement data in text files. 

 None — Text files are not saved. 

 Text File PLT — Saves measurement results as a *.plt file with text formatting 
that can be read by the Zenyth 200st standalone software. 
 

 Text File Structure, TAB — Saves measurement results in tab delimited 
columns that can be imported into many spreadsheet and database 
applications. 

 

 Text File Structure, Semicolon — Saves measurement results in semicolon-
delimited columns that can be imported into many spreadsheet and database 
applications. 

 

 Text File Matrix— Saves measurement results in tab-delimited matrices that 
can be imported into many spreadsheet and database applications. 

 
Note: Measurement data may be saved simultaneously in the ADAP software 
database and in text files. 

 
Note: If no Database options are selected, manual options for saving data 
appear after each measurement. If no save option is selected at this time, the 
measurement data is not saved. 
 

7. In Language, select whether to run the ADAP software in English or German. 
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8. In Printout Line 1 + 2, enter the header text that will appear on all printouts of 
measurement results. 
 

9. Choose Save to save the new settings. Setup-System closes. 
 
OR 

 
Choose Cancel to close Setup-System without saving changes. 

 
Manually Controlling the Instrument With the ADAP Software 
4.1 Overview 
The ADAP software provides two Functions tabs that permit manually controlling 
many instrument operations independently from measurements. Functions 1 controls 
operations such as loading and ejecting microplates and displays instrument 
information (refer to Section 4.2, Using Functions 1). Functions 2 calibrates the 
lamps and transports and provides manual control of microplate shaking (refer to 
Section 4.3, Using Functions 2). 
To access the Functions tabs: 
1. From the Setup menu, choose Instrument. Instrument appears (Figure 4-1). 
2. Choose the desired Functions tab to display: Functions 1 or Functions 2. 
The selected tab is displayed (Figure 4-1). 
4-2 Manually Controlling the Instrument With the ADAP Software 
Anthos Labtec Instruments GmbH 
4.2 Using Functions 1 
Functions 1 is divided into two sections: Functions and Information 
(Figure 4-1). Functions controls several common instrument operations (refer to 
Section 4.2.1, Performing Functions). Information displays information about the 
connected instrument (refer to Section 4.2.2, Viewing Information). 
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Figure 4-1. Instrument — Functions 1 
Manually Controlling the Instrument With the ADAP Software 4-3 
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4.2.1 Performing Functions 
The options in Functions control basic instrument operations as described in 
Table 4-1. Functions that report the status of instrument components display results 
in Information (Figure 4-2). 
Table 4-1. Functions 1: Functions 
Functions Operation 
Moves the plate transport inside the instrument. 
Moves the plate transport outside the instrument. 
Moves all mechanical components of the 
instrument to home positions. 
Stops all operations in progress. 
Note: This function is not available. 
Continuously updates and displays in Information 
the ADC value of the instrument until 
Information is closed. 
Continuously updates and displays in Information 
the current state of all instrument sensors until 
Information is closed. 
Checks that a microplate is inserted in the 
instrument. 
Resets the air cycle count after replacing the air 
filter on the instrument. 
4-4 Manually Controlling the Instrument With the ADAP Software 
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4.2.2 Viewing Information 
The options in Information display instrument setting information as described in 
Table 4-2. 
When an option is selected in Information, the specific instrument information 
relating to the selected option appears in Information (Figure 4-2). 
Figure 4-2. Information displaying instrument status 
Table 4-2. Functions 1: Information Options 
Information Operation 
Displays in Information the current state of the 
instrument: OK, Ready, Error, or Standby. 
Displays in Information the current status of 
several mechanical components, including 
installed options and ADC values. 
Displays the current status of the light sources in 
Information. 
Displays current alerts, errors, and warnings in 
Information. 
Displays in Information the instrument log file 
that records all commands sent by the software to 
the instrument and execution errors. 
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Note: The instrument Log File is primarily 
intended for Anthos service engineers. 
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Information can be: 
• Copied to the clipboard (refer to Section 4.2.2.1, Copying Instrument 
Information to the Clipboard). 
• Saved as a text file (refer to Section 4.2.2.2, Saving Instrument Information 
in a Text File). 
• Printed (refer to Section 4.2.2.3, Printing Instrument Information). 
4.2.2.1 Copying Instrument Information to the Clipboard 
Information can be copied to the clipboard and then pasted into another application 
such as a word processor. 
To copy the information to the clipboard: 
From the File menu, choose Copy. The information is copied to the clipboard 
and can be pasted in any application using the Paste command. 
Note: Most applications have a standard shortcut of CTRL+V 
assigned to the Paste command. 
4.2.2.2 Saving Instrument Information in a Text File 
Information can be saved as a text file (*.txt), a format that can be opened by most 
word processors. 
To save the information as a text file (*.txt): 
1. From the File menu, choose Save. Save As appears. 
2. In Save As, browse to the desired directory where the file will be saved. 
3. In File name, enter a name for the text file. 
4. Choose Save. The text file is saved in the specified directory location with the 
specified File name. 
4-6 Manually Controlling the Instrument With the ADAP Software 
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4.2.2.3 Printing Instrument Information 
To print the information in Information: 
1. From the File menu, choose Print. Print appears (Figure 4-1). 
Figure 4-1. Print 
2. In Printer, select the desired printer to print the information. All printers that are 
properly installed and configured on the computer are listed. 
3. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
4. Choose OK to print the information. 
Note: If the selected printer is configured to print to a file, such as an 
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The 
printed file is saved to the ADAP software home directory. 
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4.3 Using Functions 2 
Functions 2 is divided into two sections: Adjustments and Functions (Figure 4-3). 
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Adjustments calibrate the lamps and plate and optics transports (refer to Section 
4.3.1, Adjusting the Instrument). Functions provides manual control over shaking 
microplates (refer to Section 4.3.2, Manually Shaking Microplates). 
Note: The Set Valve, Dispense, and Set Pump Voltage functions are not 
available for the Zenyth 200. 
Figure 4-3. Instrument — Functions 2 
4-8 Manually Controlling the Instrument With the ADAP Software 
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4.3.1 Adjusting the Instrument 
When the ADAP software controls the instrument, two adjustment options, Adjust 
Lamp and Auto Calibration are available to users with Level 3 (system 
administrator) access. Select the desired operation to perform the action described in 
Table 4-3. 
4.3.2 Manually Shaking Microplates 
Shaking permits microplates loaded in the instrument to be shaken outside of a 
measurement. 
To perform a shaking operation: 
1. In Mode, select the desired shaking intensity: Low, Medium, or High. 
2. In Time, enter the length of time to perform the shaking operation. 
3. Choose Shaking to shake for the specified Mode and Time. 
Table 4-3. Functions 2: Adjustment Options 
Adjustment Operation 
Checks the deuterium and halogen lamps and 
calibrates lamp output and gain values. 
Displays status in Information 
Calibrates the plate and optics transports. 
Displays the calibration values in Information. 
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4.4 Quick Access to Frequently Performed 
Operations 
Several frequently performed operations can be accessed quickly from the 
ADAP software menus and toolbar: 
• Set Temperature (refer to Section 4.4.1, Setting Instrument Temperature). 
• Eject Plate (refer to Section 4.4.2, Ejecting Plates). 
• Load Plate (refer to Section 4.4.3, Loading Plates). 
• Initialize Instrument (refer to Section 4.4.4, Initializing the Instrument). 
4.4.1 Setting Instrument Temperature 
The Zenyth 200 is capable of performing temperature-controlled incubations of 
microplates. Refer to the user’s manual for Zenyth 200 for more information. 
To set the temperature: 
1. From the Reading menu, choose Set Temperature. 
OR 
From the toolbar, choose Temperature. Temperature appears (Figure 4-4). 
Note: Actual Temperature displays the current temperature inside the 
instrument. 
Note: The temperature scale used is determined by the setting in 
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Instrument (refer to Section 3.2, Configuring the Instrument Setup). 
The Fahrenheit scale is only available on instruments sold in the United 
States. 
Figure 4-4. Temperature 
4-10 Manually Controlling the Instrument With the ADAP Software 
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2. In Temperature, enter the desired incubation temperature. 
Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
The incubation temperature will remain at the current setting until a 
different temperature is entered. 
To turn temperature control off, enter 0. 
3. Choose OK to set the incubation temperature and close Temperature. 
OR 
Choose Cancel to close Temperature without changing the incubation 
temperature. 
4.4.2 Ejecting Plates 
To move the plate carrier and microplate outside the instrument: 
From the Reading menu, choose Eject Plate. 
OR 
From the toolbar, choose Eject Plate. 
4.4.3 Loading Plates 
To move the plate carrier and microplate inside the instrument: 
From the Reading menu, choose Load Plate. 
OR 
From the toolbar, choose Load Plate. 
4.4.4 Initializing the Instrument 
To move all mechanical components of the instrument to home positions: 
From the Reading menu, choose Initialize Instrument. 
OR 
From the toolbar, choose Initialize Instrument. 
5-1 
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5 Transferring Data Between the 
Instrument and Computer 
5.1 Overview 
Test and plate definitions; measurement results; and instrument EEPROM, firmware, 
and software updates can be transferred between the computer and Zenyth 200. 
Depending on type, data is transferred by choosing data transfer options in Down/ 
Upload within the ADAP software or by copying files using a local area network, 
floppy disk, or Microsoft ActiveSync® outside of the ADAP software. 
Note: Down/Upload is available only to users with Level 2 (administrator) and 
Level 3 (system administrator) access. 
Note: Refer to Section 5.5, Transferring Data Between the Zenyth 200st and 
Computer Using Microsoft Windows® for information about transferring data 
between the computer and instrument outside of the ADAP software. 
The ADAP software automatically recognizes whether the connected instrument is a 
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standalone Zenyth 200st or a computer-controlled Zenyth 200rt. The types of data 
that can be transferred vary by instrument capability. Refer to Table 5-1 for more 
details. 
Table 5-1. Data Transfer by Instrument Capability 
Data Type Zenyth 200st Zenyth 200rt Section 
Firmware Yes Yes Refer to Section 5.2, Updating 
Firmware, EEPROM Data, and 
Standalone Software. 
EEPROM data Yes Yes 
Standalone software Yes No 
Plate definitions Yes Yes Refer to Section 5.3, Editing and 
Transferring Plate Formats. 
Test definitions Yes No Refer to Section 5.4, Importing and 
Exporting Test Definition Files. 
Measured plate 
results 
Yes No Refer to Section 5.5, Transferring Data 
Between the Zenyth 200st and Computer 
Using Microsoft Windows® and Section 
5.5.1, Importing Measurement Results 
From the Zenyth 200st to the ADAP 
Software Database. 
5-2 Transferring Data Between the Instrument and Computer 
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5.2 Updating Firmware, EEPROM Data, and 
Standalone Software 
Firmware transfer functions in Down/Upload permit instrument firmware, 
EEPROM data, and standalone software to be transferred between the computer 
Zenyth 200. Transfer functions for instrument firmware are reserved for Anthos 
service engineers and require a valid service code to access. 
Users with Level 2 (administrator) and Level 3 (system administrator) can: 
• Upload EEPROM data from the Zenyth 200 to the computer (refer to 
Section 5.2.1, Uploading EEPROM Data from the Zenyth 200 to the 
Computer). 
Note: EEPROM data should only be uploaded to the computer 
by an Anthos service engineer. 
Note: Downloading updated EEPROM data to the Zenyth 200 
requires a valid service code. 
• Update the standalone software on a Zenyth 200st by transferring files via a 
local area network, floppy disk, or Microsoft ActiveSync® (refer to Section 
5.5, Transferring Data Between the Zenyth 200st and Computer Using 
Microsoft Windows®). 
Transferring Data Between the Instrument and Computer 5-3 
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5.2.1 Uploading EEPROM Data from the Zenyth 
200 to the Computer 
EEPROM data from the Zenyth 200 can be uploaded to the computer using the 
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EEPROM Data function in Down/Upload. 
Note: EEPROM data should only be uploaded to the computer by an Anthos service 
engineer. 
Note: Downloading updated EEPROM Data to the Zenyth 200 requires a valid 
service code. 
To upload EEPROM data from the Zenyth 200: 
Note: Before transferring data, the Zenyth 200st must be placed in Remote Control 
mode. Refer to the instrument user’s manual for more information. 
1. From the Setup menu, choose Instrument. Instrument appears 
(Figure 5-1). 
Figure 5-1. Instrument 
5-4 Transferring Data Between the Instrument and Computer 
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2. Choose Down/Upload (Figure 5-2). 
Figure 5-2. Instrument — Down/Upload 
Upload 
EEPROM Data 
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3. In the Instrument -> PC column, choose EEPROM Data. Save As appears 
(Figure 5-3). 
Figure 5-3. Saving EEPROM Data 
4. Browse to the directory where the uploaded EEPROM data file will be saved. 
5. In File name, choose a name for the EEPROM data file 
6. Choose Save to create the backup plate definition file. Information appears, 
displaying EEPROM data. 
Figure 5-4. Information displaying uploaded EEPROM data 
7. Close Information. 
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5.3 Editing and Transferring Plate Formats 
The Zenyth 200 supports microplate formats ranging from 6 to 384 wells. 
Dimensions for each plate format are stored in a plate definition file on the 
instrument. This plate definition file may be uploaded to the computer where it can be 
edited using the ADAP software. Plate formats can be added, edited, or deleted from 
the plate definition file. When editing is complete, the plate definition file can be 
downloaded back to the Zenyth 200. 
Note: Zenyth 200 plate data (*.plt) files are not the same as plate definition (*.plt) 
files used by the ADAP software. 
When a plate definition file is downloaded to the instrument, all plate formats saved 
in the file are copied to the instrument firmware, erasing all previously stored plate 
formats. For this reason, backing up plate definition files uploaded from the 
instrument is important (refer to Section 5.3.1, Uploading and Backing Up Plate 
Formats Stored in the Zenyth 200). 
Note: Edit Plate Definition can edit plate formatting information stored in any plate 
definition file saved on the computer. However, it is intended to be used only to edit 
plate formats currently stored in the instrument firmware. 
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Edit Plate Definition provides the ability to: 
• Create and edit plate formats (refer to Section 5.3.2, Creating and Editing 
Plate Formats). 
• Delete plate formats (refer to Section 5.3.3, Deleting Plate Formats). 
Transferring Data Between the Instrument and Computer 5-7 
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Once editing plate formats is complete, plate definition (*.plt) files can be 
downloaded to the Zenyth 200 firmware (refer to Section 5.3.4, Downloading Plate 
Formats to the Zenyth 200). 
Figure 5-5. Down/Upload — edit and transfer plate definition options 
Edit and 
transfer plate 
definitions 
5-8 Transferring Data Between the Instrument and Computer 
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5.3.1 Uploading and Backing Up Plate Formats 
Stored in the Zenyth 200 
Before editing a plate format, all plate formats uploaded from the Zenyth 200 to the 
computer should be backed up. Backing up the original plate formatting information 
is critical because each time edited plate formats are downloaded to the instrument, 
the original plate formatting information stored in the instrument is overwritten. 
To upload and backup plate formats: 
Note: Before transferring data, the Zenyth 200st must be placed in Remote Control 
mode. Refer to the instrument user’s manual for more information. 
1. In the ADAP software, from the Setup menu, choose Instrument. Instrument 
appears (Figure 5-1). 
2. Choose Down/Upload (Figure 5-5). 
3. In Test/Plate Definition, choose Plate Definition under Instrument -> PC to 
transfer the stored plate definition file from the instrument to the computer. Save 
As appears (Figure 5-6). 
Figure 5-6. Save As 
4. Browse to the directory where the uploaded plate formats will be stored in a plate 
definition (*.plt) file. 
5. In File name, choose a name for the file; for example, 
default_plates_backup.plt. 
6. Choose Save to create the backup plate definition file. 
7. Repeat steps 3 – 5 to create a second copy of the plate definition file. This is the 
file that will be edited and transferred back to the instrument. 
8. In File name, choose a name for the plate definition that will be edited and 
transferred back to the instrument. Use a name similar to that given to the backup 
file; for example default_plates.plt. 
9. Choose Save. 
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5.3.2 Creating and Editing Plate Formats 
Plate formats uploaded from the instrument and stored in a plate definition (*.plt) can 
be created and edited. 
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To create or edit a a plate format: 
1. Upload and backup plate formats using the steps detailed in Section 5.3.1, 
Uploading and Backing Up Plate Formats Stored in the Zenyth 200. 
2. In Test/Plate Data Transfer, choose Edit Plate Definition. Open appears 
(Figure 5-7). 
Figure 5-7. Opening a plate definition file 
3. Browse to and select the plate definition (*.plt) file to edit. 
5-10 Transferring Data Between the Instrument and Computer 
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4. Choose Open. Plate Definition appears (Figure 5-8). 
Figure 5-8. Plate Definition 
5. To create a new plate format, in Name, enter a name for the new plate format. 
OR 
To edit an existing plate format, in Name, select the desired plate format to edit. 
6. In Well, select the number of wells on the plate. 
Note: 1536-well plates are not supported by the Zenyth 200. 
Note: Refer to the graphic in Plate Definition (Figure 5-8) showing the dimensions 
when configuring steps 8-12. All measurements are in millimeters (mm). Plate 
dimensions should be measured, or taken from the specifications provided by the 
plate manufacturer. 
7. In A0X, enter the distance from the edge of the X-axis of the microplate to the 
center of the first well in the X-axis. 
8. In A0Y, enter the distance from the edge of the Y-axis of the microplate to the 
center of the first well in the Y-axis. 
9. In Delta X, enter the distance between well centers in the X-axis. 
10. In Delta Y, enter the distance between well centers in the Y-axis. 
11. In Diameter, enter the diameter of each well. 
Note: The Diameter must be smaller than the values for Delta X and 
Delta Y. 
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12. From the File menu, choose Save to save the new or edited plate format to the 
plate definition file. 
13. From the File menu, choose End to close Plate Definition. 
Note: To transfer the plate formats from the computer to the instrument, refer to 
Section 5.3.4, Downloading Plate Formats to the Zenyth 200. 
5.3.3 Deleting Plate Formats 
Plate formats uploaded to the instrument and stored in a plate definition (*.plt) file 
can be deleted. 
To delete a plate format: 
1. Upload and back up plate formats using the steps detailed in Section 5.3.1, 
Uploading and Backing Up Plate Formats Stored in the Zenyth 200. 
2. In Test/Plate Data Transfer, choose Edit Plate Definition. Open appears 
(Figure 5-9). 
Figure 5-9. Opening a plate definition file 
3. Browse to and select the plate definition (*.plt) file to edit. 
5-12 Transferring Data Between the Instrument and Computer 
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4. Choose Open. Plate Definition appears (Figure 5-10). 
Figure 5-10. Plate Definition 
5. In Name, select the desired plate format to delete from the list. 
6. From the Edit menu, choose Delete. A confirmation appears (Figure 5-11). 
Figure 5-11. Confirmation to delete plate definition 
7. Select Yes to delete the plate format from the plate definition file. 
Note: To transfer plate formats from the computer to the instrument, refer to Section 
5.3.4, Downloading Plate Formats to the Zenyth 200. 
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5.3.4 Downloading Plate Formats to the 
Zenyth 200 
Plate formats stored in a plate definition (*.plt) file can be transferred from the 
computer to the Zenyth 200. 
To transfer plate formats: 
Note: Before transferring data, the Zenyth 200st must be placed in Remote Control 
mode. Refer to the instrument user’s manual for more information. 
1. From the Setup menu, choose Instrument. Instrument appears (Figure 5-1). 
2. Choose Down/Upload (Figure 5-5). 
3. Choose Plate Definition under PC -> Instrument. Open appears 
(Figure 5-12). 
Figure 5-12. Opening a plate definition file 
4. Browse to the directory where plate definition file is saved and select it. 
5. Choose Open to transfer the plate definition file which includes the plate 
formats from the computer to the instrument. 
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5.4 Importing and Exporting Test Definition Files 
The ADAP Prisma software stores all test definitions in the ADAP database. Test 
definitions created and used by the Zenyth 200st standalone software are stored as 
individual *.dwr files. The functions in Import/Export Test Files converts test 
definitions into the desired format so that they may be transferred between the 
computer and instrument. 
Note: Test definitions may be imported to and exported from the ADAP Basic 
software; however, upgrading to the ADAP Prisma software is required to create, 
read, or modify test definitions. 
• Import to Database imports test definition files (*.dwr) created by the 
Zenyth 200st standalone software into the ADAP software database (refer to 
Section 5.4.1, Importing Test Definitions to the Test Database). 
• Export from Database exports test definitions stored in the ADAP 
software database to individual test definition files (*.dwr) that can be read 
by the Zenyth 200st standalone software (refer to Section 5.4.2, Exporting 
Test Definitions from the Test Database). 
Note: Use a local area network, floppy disk, or Microsoft ActiveSync® to transfer 
test definition files (*.dwr) between the Zenyth 200st and computer (refer to Section 
5.5, Transferring Data Between the Zenyth 200st and Computer Using Microsoft 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

Windows®). 
Figure 5-13. Down/Upload — Import/Export Test Files 
Import/export 
test files 
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5.4.1 Importing Test Definitions to the Test 
Database 
Test definition files that have been uploaded from the Zenyth 200st can be imported 
into the ADAP database. 
Note: Before the test definition can be imported to the database, it must have already 
been uploaded to the computer from the Zenyth 200st (refer to Section 5.5, 
Transferring Data Between the Zenyth 200st and Computer Using Microsoft 
Windows®). 
To import a test definition into the test database: 
1. In the ADAP software, choose Instrument from the Setup menu. Instrument 
appears (Figure 5-1). 
2. Choose Down/Upload (Figure 5-13). 
3. In Import/Export Test Definition, choose Import to Database. Open appears 
(Figure 5-14). 
Figure 5-14. Opening a test definition to import into database 
4. Browse to and select the test definition to import to the test database. 
5. Choose Open. The selected test definition file is imported to the ADAP software 
database. 
5.4.2 Exporting Test Definitions from the Test 
Database 
Test definition files stored in the ADAP software database can be exported to a test 
definition file that can be downloaded to the Zenyth 200st. 
To export a test definition from the database to a file: 
1. In the ADAP software, From the Setup menu, choose Instrument. Instrument 
appears (Figure 5-1). 
2. Select the Down/Upload tab to display it (Figure 5-13). 
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3. In Import/Export Test Definition, choose Export from Database. Selection 
appears (Figure 5-15). 
Figure 5-15. Select test to export 
4. Select the test definition to export from the test database. 
Note: Choose Matchcode to search for test definitions containing 
specific test definitions (refer to Section 7.2.1.1, Using Matchcode to 
Search for Saved Measurement Results). 
5. Choose OK. The selected test definition file is exported from the ADAP software 
test database as a test definition file that can be downloaded to the instrument. 
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5.5 Transferring Data Between the Zenyth 200st and 
Computer Using Microsoft Windows® 
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Test definitions, measurement results, and software upgrades may be transferred 
between the computer and the Zenyth 200st over a local area network, via floppy 
disk, or by using Microsoft ActiveSync®. Data transfers conducted with these 
methods use the Windows® operating systems installed on the computer and 
instrument, and do not require the ADAP software or the Zenyth onboard software to 
be running at the time of the transfer. 
Note: The ADAP software currently does not support transferring test definitions, 
measured plate data, and standalone software updates between the computer and 
Zenyth 200st using the options in the Down/Upload tab. 
Instead of using the Down/Upload tab to transfer test definitions, measured plate 
data, and standalone software updates between the computer and Zenyth 200st, test 
definitions stored in the ADAP software database must be exported to individual test 
definition (*.dwr) files before they can be transferred to the Zenyth 200st (refer to 
Section 5.4, Importing and Exporting Test Definition Files). 
Data transfer methods: 
• Local area network (LAN) — Connect the Zenyth 200st standalone 
instrument to a local area network (LAN) using the built-in Ethernet adaptor 
on the instrument and copy data between shared folders on the computer and 
instrument. Refer to the instrument user’s manual for more information. 
• Floppy disk — Copy files from the instrument to a floppy disk. Refer to the 
instrument user’s manual for more information about connecting a USBcompatible 
floppy drive to the instrument. 
• Microsoft ActiveSync® — Use ActiveSync® to synchronize data stored on 
a PC and an instrument running the Windows® CE operating system, such 
as the Zenyth 200st. For the most recent information about ActiveSync®, 
visit the Microsoft website (http://www.microsoft.com) and perform a 
search for ActiveSync. 
5.5.1 Importing Measurement Results From the 
Zenyth 200st to the ADAP Software 
Database 
Measurement results from tests defined and performed using the Zenyth 200st 
standalone software may be imported to the ADAP software database for future 
evaluation. 
To import measurement results: 
1. On the Zenyth 200st instrument, use Windows® CE to browse to the directory 
where the measured plate (*.plt) and test definition (*.dwr) files are stored. 
Note: Both the measured plate (*.plt) and test definition (*.dwr) files must be 
transferred to the computer before importing them into the database. For 
multiwavelength, kinetic and area, linear, and spectral scan measurements, the raw 
data file (*.raw or *.txt) must also be transferred. 
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2. Transfer the measured plate file (*.plt), test definition file (*.dwr), and, if 
necessary, the raw data file (*.raw or *.txt) to the same directory on the computer 
using a Local Area Network (LAN), floppy disk, or Microsoft ActiveSync (refer 
to Section 5.5, Transferring Data Between the Zenyth 200st and Computer Using 
Microsoft Windows®). 
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3. In the ADAP software, choose Instrument from the Setup menu. Instrument 
appears. 
4. Choose Down/Upload (Figure 5-13). 
5. In Import/Export Test Definition, choose Import to Database. Open appears 
(Figure 5-16). 
Figure 5-16. Selecting Evaluated Plates 
6. In File of type, select Evaluated Plates File (*.plt). 
7. Select the desired measured plate file (*.plt) and choose Open. The selected 
measured plate file, test definition file (*.dwr), and, if required, raw data file 
(*.raw or *.txt) are automatically imported to the ADAP software database. 
ADAP Software for Zenyth 200 Operating Manual 
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6 Performing Quick Measurements 
6.1 Overview 
The ADAP software is capable of performing photometric Quick measurements. 
Quick measurements are configured in Quick-Read, which is designed to allow 
measurement parameters to be changed quickly and easily (Figure 6-1). Quick 
measurements do not require defining tests. 
Note: Tests may only be defined and run in the ADAP Prisma software. Tests offer 
additional measurement parameters that are configured in test definitions which may 
be saved, reused, and modified. Test definitions are created in both the ELISA and 
Quantitation modules. Refer to Chapter 8, Defining and Running Tests In the ELISA 
Module and Chapter 10, Defining and Running Tests In the Quantitation Module for 
more information about defining tests. 
Configuration options in Quick-Read change depending on which format is selected: 
microplate or cuvette. To learn about how configuration options vary between 
formats: 
• Refer to Section 6.1.1, Configuration Options for Microplates for more 
information about configuring Quick measurements for microplate samples. 
OR 
• Refer to Section 6.1.2, Configuration Options for Cuvettes for more 
information about configuring Quick measurements for cuvette samples. 
6-2 Performing Quick Measurements 
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This chapter breaks down the process of configuring and performing Quick 
measurements into three tasks: 
• Selecting the sample format: microplate or cuvette, and the type of Quick 
measurement to perform (refer to Section 6.2.1, Selecting Plate Format and 
Measurement Mode). 
• Configuring the options for the chosen Quick measurement (refer to Section 
6.2, Configuring Photometric Quick Measurements). 
• Running the Quick measurement on microplate samples and save the 
measurement results (refer to Section 6.3, Running and Saving Quick 
Measurements on Microplate Samples). 
OR 
• Running the Quick measurement on cuvette samples and save the 
measurement results (refer to Section 6.4, Running and Saving Quick 
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Measurements on Cuvette Samples). 
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6.1.1 Configuration Options for Microplates 
For Quick measurements performed on microplate samples, Quick-Read provides 
options to configure (Figure 6-1): 
• Load Plate & Eject Plate — Loads and unloads microplates into the 
Zenyth 200. 
• Plate Type — Chooses the type of microplate used in the Quick 
measurement. 
• Measurement Position — Permits the user to select which wells on a 
microplate are read in a Quick measurement. 
• Measurement Mode — Selects the type of Quick measurement performed 
and configures measurement options. 
• Shaking — Shakes microplates at a user-selected Intensity and period of 
Time. Shaking occurs at the beginning of a Quick measurement, or 
immediately when Shake Now is selected. 
Figure 6-1. Quick-Read — configuration options for microplate samples 
Measurement Mode 
Choose the type of Quick 
measurement to perform and 
configure measurement-specific 
options. 
Sample Format 
Choose microplate and configure 
Plate Type and wells to measure. 
Shaking 
Only microplates may be shaken in 
a Quick measurement. 
Load Plate & Eject Plate 
Loads and unloads the microplate 
into the Zenyth 200. 
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6.1.2 Configuration Options for Cuvettes 
For Quick measurements performed on cuvette samples, Quick-Read provides 
options to configure (Figure 6-2): 
• Measurement Mode — Selects the type of Quick measurement performed 
and configures measurement options. 
Note: Linear and area scan measurements are not available for 
cuvette samples. 
• Transmission — Measures the percentage transmission instead of the 
optical density (OD) of cuvette samples. 
. 
Figure 6-2. Quick-Read — configuration options for cuvette samples 
Measurement Mode 
Choose the type of Quick 
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measurement to perform and 
configure measurement-specific 
options. 
Sample Format 
Choose Cuvette. No additional 
format parameters need to be 
configured. 
Load Plate & Eject Plate 
Both functions are available in case 
microplates need to be loaded or 
ejected from the instrument. 
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6.2 Configuring Photometric Quick Measurements 
Photometric Quick measurements can be performed on microplate and cuvette 
samples. Configuring a quick measurement requires: 
• Selecting the format: microplate or cuvette (refer to Section 6.2.1, Selecting 
Plate Format and Measurement Mode). 
• Configuring the measurement mode: 
• Endpoint photometric (refer to Section 6.2.2, Configuring an Endpoint 
Photometric Quick Measurement). 
• Multiwavelength (refer to Section 6.2.3, Configuring a Multiwavelength 
Photometric Quick Measurement). 
• Kinetic photometric (refer to Section 6.2.4, Configuring a Kinetic 
Photometric Quick Measurement). 
• Spectral scan (refer to Section 6.2.5, Configuring a Spectral Scan 
Photometric Quick Measurement). 
• Area scan (refer to Section 6.2.6, Configuring an Area Scan Quick 
Measurement). 
• Linear scan (refer to Section 6.2.7, Configuring a Linear Scan Quick 
Measurement). 
Note: To perform Quick measurements on a standalone Zenyth 200st using the 
ADAP software, put the instrument in Remote Control mode. Refer to the 
instrument user’s manual for more information about Remote Control mode. 
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6.2.1 Selecting Plate Format and Measurement 
Mode 
Quick measurements can be configured to read microplate or cuvette samples. The 
configuration options available change depending on which format is selected. When 
Microplate is the selected Format, Plate Type and Measurement Position must be 
configured; cuvettes require no additional formatting parameters be configured. After 
configuring formatting parameters, the Measurement Mode, or type of Quick 
measurement, is selected. 
Note: Refer to Section 6.1.1, Configuration Options for Microplates and Section 
6.1.2, Configuration Options for Cuvettes for an overview of which how 
configuration options change depending on which sample Format is selected. 
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To configure the Format and select Measurement Mode: 
1. From the Reading menu, choose Quick. 
OR 
Choose Quick-Read. Quick-Read appears (Figure 6-3). 
Figure 6-3. Quick-Read 
2. Choose the Format: Microplate or Cuvette. 
3. If Microplate is the selected Format, in Plate Type, select the plate definition of 
the plate being measured. 
Note: Selecting a new Plate Type automatically invalidates the 
current layout selected in Set Sample because well dimensions and the 
number of wells on the plate may have changed. 
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4. In Measurement Position, select All to perform measurements on samples in 
all wells on the microplate. 
Note: When Cuvette is the selected Format, Measurement Position 
options are not available. 
Note: Deselecting All does not automatically deselect all previously 
selected wells; they must be deselected manually in Set Sample. 
OR 
Choose Set Sample to select which wells on the microplate are measured. Set 
Sample appears (Figure 6-4). 
Note: Before selecting wells in Set Sample, deselect All if it is 
currently selected. 
Figure 6-4. Set Sample 
5. Click and drag over the wells to be measured. 
6. Select a command from the Edit menu or by right-clicking on the selected wells: 
• Set/De-select all wells — Selects/deselects all wells on the 
microplate. 
• Set/De-select actual row — Selects/deselects all wells in the same 
row as the initial well selected (Figure 6-4). 
• Set/De-select actual column — Selects/deselects all wells in the 
same column as the initial well selected (Figure 6-4). 
• Set/De-select selected well — Selects/deselects wells selected by 
dragging. 
Wells selected by 
dragging mouse. 
Choosing Set actual 
column selects all 
wells in column 5. 
Choosing Set actual row 
selects all the wells in row 4. 
Initial well selected. 
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7. Choose OK to close Set Sample. 
Note: The Measurement Position layout defined in Set Sample is 
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saved after a measurement is run. If the next measurement requires a 
different layout, reset it by selecting and deselecting All. Then, in Set 
Sample, select the wells to measure in the new measurement. 
8. In Measurement Mode, select the type of Quick measurement to perform: 
• Endpoint Photometric — performs a single-wavelength or 
bichromatic endpoint measurement (refer to Section 6.2.2, Configuring 
an Endpoint Photometric Quick Measurement). 
• Multiwavelength — performs up to eight absorbance or transmission 
measurements at different user-specified wavelengths (refer to Section 
6.2.3, Configuring a Multiwavelength Photometric Quick 
Measurement). 
• Kinetic Photometric — performs a series of single-wavelength or 
bichromatic measurements over a specified time interval for each 
sample (refer to Section 6.2.4, Configuring a Kinetic Photometric Quick 
Measurement). 
• Scan Wavelength — performs a spectral scan measurement at all 
wavelengths within a user-specified bandwidth (refer to Section 6.2.5, 
Configuring a Spectral Scan Photometric Quick Measurement). 
• Scan Area — performs a series of absorbance or transmission 
measurements at a number of points across each well (refer to Section 
6.2.6, Configuring an Area Scan Quick Measurement). 
Note: Scan Area Quick measurements are only available 
when reading microplates. 
• Scan Linear — performs a series of transmission measurements along 
a linear axis that crosses the center of each well (refer to Section 6.2.7, 
Configuring a Linear Scan Quick Measurement). 
Note: Scan Linear Quick measurements are only available 
when reading microplates. 
9. Configure the Quick measurement selected in Measurement Mode by 
following the steps listed in its respective section. 
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6.2.2 Configuring an Endpoint Photometric 
Quick Measurement 
An endpoint photometric Quick measurement performs a single absorbance or 
transmission measurement on samples at a user-specified wavelength between 190 
and 1000 nm. If desired, a bichromatic endpoint measurement may also be 
performed. Bichromatic measurements perform a second measurement using a 
Reference Filter. This measurement is subtracted from the first to calculate the final 
result. 
Note: Endpoint photometric transmission measurements may be performed only on 
cuvette samples. 
To configure an endpoint photometric Quick measurement: 
1. Choose the Format, Plate Type, Measurement Position, and Measurement 
Mode following the steps in Section 6.2.1, Selecting Plate Format and 
Measurement Mode. 
2. If Cuvette is the selected Format, select Measure Transmission to measure 
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transmission instead of absorbance, if desired. 
Note: Endpoint photometric transmission measurements may only be 
performed on cuvette samples. 
3. In Wavelength, enter the desired measurement wavelength (Figure 6-5). 
Figure 6-5. Quick-Read — Endpoint Photometric measurement 
4. To perform a bichromatic endpoint measurement, in Reference Filter, enter the 
desired wavelength. 
Note: When a Reference filter is selected, the final measurement 
result is calculated by subtracting the Reference Filter measurement 
from that of the Measurement filter. 
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5. If desired, select Shaking to shake the microplate prior to the measurement. 
Quick-Read expands to display Shaking options (Figure 6-6). 
Note: Shaking may only be performed with microplates. 
Note: If shaking is not desired, go to step 8. 
Figure 6-6. Quick-Read — Shaking 
6. In Intensity, select the intensity of the shaking: Low, Medium, or High. 
7. In Time, select the length of time to shake in seconds. 
Note: Choose Shake Now to immediately shake the plate for the 
Intensity and Time specified. 
8. To perform the Quick measurement on microplate samples, follow the steps in 
Section 6.3, Running and Saving Quick Measurements on Microplate Samples. 
OR 
To perform the Quick measurement on cuvette samples, follow the steps in 
Section 6.4, Running and Saving Quick Measurements on Cuvette Samples. 
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6.2.3 Configuring a Multiwavelength 
Photometric Quick Measurement 
A multiwavelength photometric Quick measurement performs up to eight absorbance 
or transmission measurements for each well or cuvette sample at different userspecified 
wavelengths between 190 and 1000 nm. 
To perform a multiwavelength photometric Quick measurement: 
1. Choose the Format, Plate Type, Measurement Position, and Measurement 
Mode following the steps in Section 6.2.1, Selecting Plate Format and 
Measurement Mode. 
2. If Cuvette is the selected Format, select Measure Transmission to measure 
transmission instead of absorbance, if desired. 
Note: Multiwavelength photometric transmission measurements may 
only be performed on cuvette samples. 
3. Choose the Number of Wavelengths to measure. A field for each 
Wavelength appears (Figure 6-7). 
Figure 6-7. Quick-Read — Multiwavelength photometric measurement 
4. In Wavelength, enter a measurement wavelength in each field. 
6-12 Performing Quick Measurements 
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5. If desired, select Shaking to shake the microplate prior to the measurement. 
Quick-Read expands to display Shaking options. 
Note: Shaking may only be performed with microplates. 
Note: If shaking is not desired, go to step 8. 
6. If Shaking is selected, in Intensity, select the intensity of the shaking: Low, 
Medium, or High. 
7. If Shaking is selected, in Time, select the length of time to shake in seconds. 
Note: Choose Shake Now to immediately shake the plate for the 
Intensity and Time specified. 
8. To perform the Quick measurement on microplate samples, follow the steps in 
Section 6.3, Running and Saving Quick Measurements on Microplate Samples. 
OR 
To perform the Quick measurement on cuvette samples, follow the steps in 
Section 6.4, Running and Saving Quick Measurements on Cuvette Samples. 
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6.2.4 Configuring a Kinetic Photometric Quick 
Measurement 
A kinetic photometric Quick measurement performs a user-specified series of 
absorbance or transmission measurements on each sample at user-specified intervals. 
Single or bichromatic measurements may be performed at user-specified wavelengths 
between 190 and 1000 nm. Bichromatic measurements perform a second measurement 
in each cycle using a Reference Filter. This measurement is subtracted from 
the first, then final measurement results are calculated using a data reduction method. 
Note: Kinetic photometric transmission measurements may only be performed on 
cuvette samples. 
To perform a kinetic photometric Quick measurement: 
1. Choose the Format, Plate Type, Measurement Position, and Measurement 
Mode following the steps in Section 6.2.1, Selecting Plate Format and 
Measurement Mode. 
2. If Cuvette is the selected Format, select Measure Transmission to measure 
transmission instead of absorbance, if desired. 
Note: Kinetic photometric transmission measurements may only be 
performed on cuvette samples. 
Figure 6-8. Quick-Read — Kinetic Photometric measurement 
6-14 Performing Quick Measurements 
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3. In Wavelength, enter the desired measurement wavelength (Figure 6-8). 
4. To perform a bichromatic kinetic measurement, in Reference Filter, enter the 
desired wavelength. 
Note: When a Reference filter is selected, the second measurement is 
subtracted from the first before calculating the final measurement 
results using a data reduction method. 
5. If desired, select Shaking to shake the microplate prior to the measurement. 
Quick-Read expands to display Shaking options. 
Note: Shaking may only be performed with microplates. 
Note: If shaking is not desired, go to step 11. 
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6. If Shaking is selected, in Intensity, select the intensity of the shaking: Low, 
Medium, or High. 
7. If Shaking is selected, in Time, select the length of time to shake in seconds. 
Note: Choose Shake Now to immediately shake the plate for the 
Intensity and Time specified. 
8. In Interval, enter the amount of time in seconds between measurement cycles. 
Note: The Interval may range from 1 to 65,535 seconds. 
9. In Cycle, enter the number of measurements to perform on each sample. 
Note: Kinetic measurements may be set to perform 2 to 100 Cycles. 
10. In Data Reduction, select the data reduction method. Refer to Section 6.2.4.1, 
Data Reduction Methods, for descriptions of the Data Reduction methods. 
Note: The configuration parameters Smoothing Points, Lower Limit, 
Upper Limit and In/Decrease become available depending on which 
data reduction method is selected. Refer to the Additional Configuration 
column in Table 6-1 for details. 
11. To perform the Quick measurement on microplate samples, follow the steps in 
Section 6.3, Running and Saving Quick Measurements on Microplate Samples. 
OR 
To perform the Quick measurement on cuvette samples, follow the steps in 
Section 6.4, Running and Saving Quick Measurements on Cuvette Samples. 
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6.2.4.1 Data Reduction Methods 
In kinetic measurements, data reduction methods are used to determine a single value 
per sample based on the results of a sequence of measurements over a period of time. 
Table 6-1 describes the twelve data reduction methods supported by the ADAP 
software. 
Table 6-1. Data Reduction Methods 
Data Reduction Method Description Additional 
Configuration 
Average Slope 
Determines the average slope of the reaction curve by 
calculating the average of all linear regressions 
calculated over each group of Smoothing Points in the 
kinetic reading sequence. A decreasing slope shows a 
decline. 
Smoothing Points 
Delta OD Difference between the first and last kinetic 
measurements in optical density (OD). N/A 
Delta OD — Max. Slope 
Difference in OD between the first measurement and the 
center point of the maximum slope. 
Note: The center point of the maximum slope is 
calculated by determining the center point between the 
smoothing points of the regression line with the 
maximum slope. 
Smoothing Points 
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Delta Time — Absolute Time elapsed from one preselected OD value to another. Lower 
Limit 
Upper Limit 
Delta Time — Max. Slope 
Time difference in seconds between the first 
measurement and the occurrence of the center point of 
the maximum slope. 
Note: The center point of the maximum slope is 
calculated by determining the center point between the 
smoothing points of the regression line with the 
maximum slope. 
Smoothing Points 
Delta Time — Relative 
Time elapsed in seconds from the first measurement to 
reaching a set increase/decrease amount from the first 
OD measurement. 
In-/Decrease 
Maximum Declining Slope 
Determines the maximum declining rate of the reaction 
curve by calculating a linear regression over each group 
of Smoothing Points in the kinetic reading sequence. 
Smoothing Points 
Maximum Inclining Slope 
Determines the maximum inclining rate of the reaction 
curve by calculating a linear regression over each group 
of Smoothing Points in the kinetic reading sequence. 
Smoothing Points 
Maximum Slope 
Maximum slope of the curve in OD/min. The line with 
the highest slope is calculated. Also the maximum 
reaction speed. 
Note: The accuracy of this calculation depends on the 
number of measurement cycles selected. 
Smoothing Points 
6-16 Performing Quick Measurements 
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Mean Determines the mean value per sample within a 
sequence of measurements. N/A 
Time Peak Value Used to detect the time elapsed until the peak value is 
reached. Smoothing Points 
Peak Value Used to detect the highest value per sample within a 
sequence of measurements. Smoothing Points 
Table 6-1. Data Reduction Methods 
Data Reduction Method Description Additional 
Configuration 
Performing Quick Measurements 6-17 
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6.2.5 Configuring a Spectral Scan Photometric 
Quick Measurement 
A spectral scan Quick measurement performs absorbance or transmission 
measurements at all wavelengths within a user-specified bandwidth. 
To perform a spectral scan photometric Quick measurement: 
1. Choose the Format, Plate Type, Measurement Position, and Measurement 
Mode following the steps in Section 6.2.1, Selecting Plate Format and 
Measurement Mode. 
2. Select Measure Transmission to measure transmission instead of absorbance, 
if desired. 
3. In Start Wavelength, enter the shortest wavelength to be measured in the 
spectral scan (Figure 6-9). 
Note: Spectral scan measurements can be made within the range of 
190 to 1000 nm. 
Figure 6-9. Quick-Read — Scan Wavelength measurement 
4. In End Wavelength, enter the longest wavelength to be measured in the 
spectral scan. 
5. If desired, select Shaking to shake the microplate prior to the measurement. 
Quick-Read expands to display Shaking options (Figure 6-9). 
Note: Shaking may only be performed with microplates. 
Note: If shaking is not desired, go to step 8. 
6-18 Performing Quick Measurements 
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6. If Shaking is selected, in Intensity, select the intensity of the shaking: Low, 
Medium, or High. 
7. If Shaking is selected, in Time, select the length of time to shake in seconds. 
Note: Choose Shake Now to immediately shake the plate for the 
Intensity and Time specified. 
8. To perform the Quick measurement on microplate samples, follow the steps in 
Section 6.3, Running and Saving Quick Measurements on Microplate Samples. 
OR 
To perform the Quick measurement on cuvette samples, follow the steps in 
Section 6.4, Running and Saving Quick Measurements on Cuvette Samples. 
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6.2.6 Configuring an Area Scan Quick 
Measurement 
Area scan Quick measurements perform absorbance or transmission measurements at 
a number of points across each well. Area scans can measure samples on 6-, 12-, 24-, 
48-, and 96-well microplates, and are performed at the maximum resolution allowed 
by the plate type. 
Note: Area scan measurements may be performed only on microplate samples. 
To perform an area scan Quick measurement: 
1. Choose the Format, Plate Type, Measurement Position, and Measurement 
Mode following the steps in Section 6.2.1, Selecting Plate Format and 
Measurement Mode. 
2. If desired, select Measure Transmission to measure transmission instead of 
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absorbance. 
Note: Linear scan measurements perform only transmission 
measurements. 
3. In Wavelength, enter the desired measurement wavelength (Figure 6-10). 
Figure 6-10. Quick-Read — Scan Area measurement 
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4. If desired, select Shaking to shake the microplate prior to the measurement. 
Quick-Read expands to display Shaking options. 
Note: If shaking is not desired, go to step 7. 
5. If Shaking is selected, in Intensity, select the intensity of the shaking: Low, 
Medium, or High. 
6. If Shaking is selected, in Time, select the length of time to shake in seconds. 
Note: Choose Shake Now to immediately shake the plate for the 
Intensity and Time specified. 
7. Run the Quick measurement following the steps in Section 6.3, Running and 
Saving Quick Measurements on Microplate Samples. 
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6.2.7 Configuring a Linear Scan Quick 
Measurement 
Linear scan Quick measurements perform transmission measurements at 25 points 
along a linear axis crossing the center of each measured well. Linear scans may be 
performed only on 96-well plates. 
To perform a linear scan Quick measurement: 
1. Choose the Format, Plate Type, Measurement Position, and Measurement 
Mode following the steps in Section 6.2.1, Selecting Plate Format and 
Measurement Mode. 
2. In Wavelength, enter the desired measurement wavelength (Figure 6-11). 
Figure 6-11. Quick-Read — Scan Linear measurement 
3. If desired, select Shaking to shake the microplate prior to the measurement. 
Quick-Read expands to display Shaking options. 
Note: If shaking is not desired, go to step 6. 
4. If Shaking is selected, in Intensity, select the intensity of the shaking: Low, 
Medium, or High. 
5. If Shaking is selected, in Time, select the length of time to shake in seconds. 
Note: Choose Shake Now to immediately shake the plate for the 
Intensity and Time specified. 
6. Run the Quick measurement following the steps in Section 6.3, Running and 
Saving Quick Measurements on Microplate Samples. 
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6.3 Running and Saving Quick Measurements on 
Microplate Samples 
After configuring microplate and measurement parameters, Quick measurements are 
run from Quick-Read. 
Note: Refer to Section 6.4, Running and Saving Quick Measurements on Cuvette 
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Samples for information about running Quick measurements on cuvette samples. 
1. In Quick-Read, choose Eject Plate to eject the plate carrier from the 
instrument (Figure 6-12). Place the microplate to be read onto the carrier, and 
choose Load Plate to load the microplate into the instrument. 
Figure 6-12. Quick-Read 
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2. Choose Start to begin the measurement. When the measurement is complete, 
Plate-ID appears (Figure 6-13). 
Note: To stop a measurement in progress before it completes, choose 
STOP Measurement. 
OR 
In Quick-Read, choose Cancel to return to the ADAP software main screen 
without performing the measurement. 
Figure 6-13. Plate-ID 
3. In Input Plate-ID, rename the plate, if desired. 
4. Choose OK to save the measurement results to the database. 
Note: The default name format for saved measurement results is YYYYMMDD-N, 
where YYYY is the year, MM the month, DD the day, and N the number of the 
measurement made that day. 
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6.4 Running and Saving Quick Measurements on 
Cuvette Samples 
Cuvette samples are manually loaded into the cuvette holder at the back of the 
instrument after the Quick measurement is configured and the light output from the 
lamp has stabilized. Up to 50 cuvette samples can be processed, one at a time, in a 
single Quick measurement. 
Running cuvette measurements is controlled from Cuvette Reading, which includes 
options to perform blank measurements and re-read samples. When the measurement 
is complete, the results are previewed in Cuvette Reading. 
Note: Refer to Section 6.4.1, Reading Cuvette Blank Samples for more information 
about reading blank samples. 
To run a cuvette measurement: 
1. In Quick-Read, choose Start (Figure 6-14). Cuvette Reading appears 
(Figure 6-15). 
Figure 6-14. Quick-Read — cuvette spectral scan 
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2. In Samples to read, select the sample ID for the first sample to read. 
Note: Action provides instructional prompts throughout the reading. 
Note: Do not insert the cuvette into the cuvette holder until prompted. 
Note: The instrument can be initialized by choosing Initialize 
Instrument from the Option menu. Refer to Table 4-1 for more 
information about initializing the instrument. 
Figure 6-15. Cuvette Reading — Select sample to read 
6-26 Performing Quick Measurements 
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3. Choose Read to start the measurement. Before inserting the cuvette into 
the cuvette holder, allow the instrument to initialize and stabilize the light output 
of the lamp (Figure 6-16). Place Cuvette appears in Action when the cuvette 
may be loaded. 
Note: To perform a blank measurement before reading cuvette 
samples, refer to Section 6.4.1, Reading Cuvette Blank Samples. 
Note: Time left displays the time remaining until lamp stabilization is 
complete. Lamp stabilization may take up to 60 seconds. 
After 10 minutes of inactivity, the Zenyth 200 automatically turns the 
lamp off. The next cuvette measurement performed will require the 
maximum 60-second lamp stabilization time. 
Figure 6-16. Cuvette Reading — Lamp stabilization 
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4. When Place Cuvette appears in Action, insert the cuvette into the cuvette 
holder with the clear sides facing the left and right sides of the instrument (Figure 
6-17). The measurement begins automatically once the cuvette is loaded. 
Note: For all types of measurements except kinetic, the cuvette must 
be placed in the holder within 20 seconds after Place Cuvette appears. 
Time left displays the time remaining to insert the cuvette. If the 20 
seconds expires before the cuvette is inserted in the cuvette holder, the 
error, Bright measurement not valid any longer, appears. Choose 
Read to perform a new lamp stabilization. 
Note: The cuvette holder door does not need to be closed during the 
measurement. Refer to the instrument user manual for more details on 
inserting cuvettes into the cuvette holder. 
Note: Choose Stop Measurement or File>Cancel to cancel a 
measurement in progress. 
Figure 6-17. Cuvette Reading — Place Cuvette 
5. When the measurement is complete, remove the cuvette. Samples Read 
displays sample IDs and the status of the measurement: OK or Error. Kinetic, 
multiwavelength, and spectral scan Quick measurements display a Graph 
Preview of the measurement results (Figure 6-18). Endpoint measurements 
display OD in Actual Value (Figure 6-19). 
Note: Endpoint and Kinetic measurement results are displayed 
immediately. Wavelength measurement results are displayed after the 
cuvette is removed from the cuvette holder. 
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Figure 6-18. Cuvette Reading — spectral scan results with Graph Preview 
Note: Kinetic graphs are updated after removing the cuvette because 
the instrument makes a second bright measurement and recalculates the 
results. 
Figure 6-19. Cuvette Reading — endpoint results with Actual Value 
Graph Preview 
Displays a preview graph of 
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measurement results for 
kinetic, multiwavelength and 
spectral scan measurements. 
Actual Value 
Displays OD after an 
endpoint measurement. 
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Note: OD is displayed in Actual Value even if the Quick measurement is 
configured to measure transmission. Actual Value is also displayed for kinetic 
endpoint measurements. 
6. If desired, in Samples to read, select another sample and repeat steps 3 – 5 to 
perform the Quick measurement again. 
Note: Up to 50 samples can be read in a single Quick measurement. 
OR 
If desired, in Samples read, select a sample, choose Reread, and repeat steps 4 
and 5 to perform the Quick measurement on that sample again. 
OR 
From the File menu, choose End to close Cuvette Reading and save the 
measurement results. Plate-ID appears (Figure 6-20). 
Figure 6-20. Plate-ID for a cuvette measurement 
7. In Input Plate-ID, rename the measurement results, if desired. 
8. Choose OK to save the measurement results to the database. 
Note: The default name format for saved cuvette measurements is YYYYMMDDNc, 
where YYYY is the year, MM the month, DD the day, N the number of the 
measurement made that day, and c denotes cuvette. 
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6.4.1 Reading Cuvette Blank Samples 
A blank sample may be run before performing Quick measurements on cuvette 
samples. The blank value is subtracted from the measurement results for subsequent 
samples read in the Quick measurement. 
Note: If desired, a new blank sample can be read at any point during a Quick 
measurement. The new blank value is then subtracted from subsequent 
measurements. 
To read a blank sample: 
1. Choose Read Blank. Before inserting the blank sample into the cuvette holder, 
allow the instrument to initialize and stabilize the light output of the lamp. Place 
Cuvette appears in Action when the cuvette may be loaded. 
Note: Time left displays the time remaining until lamp stabilization is 
complete. Depending on the type of Quick measurement being 
performed, lamp stabilization may take up to 60 seconds. 
Figure 6-21. Cuvette Reading — Lamp stabilization time 
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2. When Place Cuvette appears in Action, insert the cuvette into the cuvette 
holder with the clear sides facing the left and right sides of the instrument. The 
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blank measurement begins automatically once the cuvette is loaded. 
Note: For all types of measurements except kinetic, the cuvette must 
be placed in the holder within 20 seconds after Place Cuvette appears. 
Time left displays the time remaining to insert the cuvette. If the 20 
seconds expires before the cuvette is inserted in the cuvette holder, the 
error, Bright measurement not valid any longer, appears. Choose 
Read Blank to perform a new lamp stabilization. 
Note: The cuvette holder door does not need to be closed during the 
measurement. Choose Stop Measurement to cancel a blank 
measurement in progress. 
3. When the blank measurement is complete, remove the cuvette. The blank value 
obtained will be automatically subtracted from following cuvette measurements. 
Note: The Read Blank button displays *Blank Active* when a blank 
measurement is being used in the calculation of measurement results. 
4. To perform measurements on cuvette samples and save the measurement results, 
follow steps 2–8 in Section 6.4, Running and Saving Quick Measurements on 
Cuvette Samples. 
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7 Viewing Quick Measurement 
Results 
7.1 Overview 
After a Quick measurement is performed and saved, the measurement results are 
displayed in a series of tabs in the ADAP software main window. The tabs displayed 
vary depending on the type of measurement performed. 
Note: Refer to Chapter 6, Performing Quick Measurements for detailed information 
about performing Quick measurements. 
The layout of information displayed in measurement results tabs varies depending on 
whether the Quick measurement was performed on microplate or cuvette samples: 
• Measurement results for microplate samples are displayed in rows and 
columns that correspond to the layout of wells on the plate (refer to Section 
7.1.1, Viewing Measurement Results for Microplate Samples). 
• Measurement results for cuvette samples are displayed in columns, one 
cuvette measurement per column (refer to Section 7.1.2, Viewing 
Measurement Results for Cuvette Samples). 
All Quick measurement results are stored in the ADAP software database and 
may be: 
• Opened for viewing, printing, or exporting (refer to Section 7.2, Viewing 
Saved Quick Measurement Results). 
• Viewed in the ADAP software main window (refer to Section 7.3, Viewing 
Quick Measurement Results). 
• Printed as a hard copy or data file such as an Acrobat® PDF (refer to Section 
7.4, Printing Quick Measurement Results). 
• Exported to another application such as a word processor or spreadsheet 
(refer to Section 7.5, Exporting Quick Measurement Results to Other 
Applications). 
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7.1.1 Viewing Measurement Results for 
Microplate Samples 
Measurement results for microplate samples are displayed in rows and columns that 
correspond to the layout of wells on the plate; for example, Figure 7-1 displays results 
for samples on a 96-well plate. To easily identify specific samples, rows and columns 
use the same well labels imprinted on the microplate. 
Figure 7-1. Measurement results for a 96-well microplate 
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7.1.2 Viewing Measurement Results for Cuvette 
Samples 
Measurement results for cuvette samples are displayed in columns, one cuvette per 
column. Measurement results for up to 50 cuvette samples may be displayed—the 
maximum number of cuvette samples that can be read in a single Quick measurement. 
Column labels correspond to the sample ID chosen for the cuvette sample when the 
Quick measurement was run; for example, column 4 displays the result for cuvette 
PR4 (refer to Section 6.4, Running and Saving Quick Measurements on Cuvette 
Samples). 
Note: Use the scroll bar at the bottom of the tab to access measurement results for 
samples not visible onscreen. 
Figure 7-2. Measurement results for cuvette samples 
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7.2 Viewing Saved Quick Measurement Results 
All Quick measurement results are saved in the ADAP software database and may be 
opened for viewing, printing, and exporting (refer to Section 7.2.1, Opening Saved 
Quick Measurement Results). 
Searching for saved measurement results by name is possible with Matchcode, the 
search feature built into the ADAP software (refer to Section 7.2.1.1, Using 
Matchcode to Search for Saved Measurement Results). 
7.2.1 Opening Saved Quick Measurement 
Results 
All Quick measurement results are saved in the ADAP software database and may be 
opened at any time. 
To view saved measurement results: 
1. From the Database menu, select Open Saved Plate. Selection appears 
(Figure 7-3). 
Note: Open Saved Plate also accesses cuvette measurement results. 
Cuvette measurement results saved with the default file name provided 
by the ADAP software are identified by the c at the end of the filename; 
for example, 20030530-4c. 
Note: Saved measurement results are listed in descending 
chronological order by measurement date. 
Figure 7-3. Selection — saved Quick measurements 
Viewing Quick Measurement Results 7-5 
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2. Select the measurement results to view. Only one plate may be viewed at a time. 
Note: To narrow the list by date, select dates in from and to, and 
choose update list. 
To search for a specific plate ID by characters in the Plate ID name, 
choose Matchcode (refer to Section 7.2.1.1, Using Matchcode to 
Search for Saved Measurement Results). 
3. Choose OK to view the measurement results. 
OR 
Choose Cancel to close Selection without opening a saved plate 
OR 
Choose Delete to delete the selected measurement results from the database. 
7.2.1.1 Using Matchcode to Search for Saved 
Measurement Results 
Matchcode is the search feature that appears in Selection. Depending on from 
which screen or tab Selection is accessed, Matchcode performs searches for saved 
measurement results or test definitions. Matchcode provides wildcard operators, * 
and ?, which simplify searching by allowing users to search for a set of possible 
characters in the filename (see Table 7-1). 
Note: A valid licence code for the ADAP Prisma software is required to view test 
definitions located by Matchcode. Refer to Chapter 8, Defining and Running Tests In 
the ELISA Module and Chapter 10, Defining and Running Tests In the Quantitation 
Module for more information about test definitions. 
To search for measurement results by plate ID: 
1. From Selection, choose Matchcode. Plate-ID appears (Figure 7-4). 
Figure 7-4. Plate-ID 
7-6 Viewing Quick Measurement Results 
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2. In Input Plate-ID, enter a plate ID or test definition name. 
Note: Input Plate-ID also refers to saved measurement results for 
cuvette samples and test definition names. 
3. Choose OK. Plate IDs or test definition names that match the search query 
appear in Selection. 
Note: If Matchcode finds no matches to the search query, choose update list to 
display the entire list of plate IDs or test definitions again. 
Table 7-1. Matchcode wildcard operators 
Wildcard Pattern Result 
*a* Lists all plate IDs or test definition names 
with an a in the ID or name. 
a* Lists all plate IDs or test definition names 
with an a at the beginning of the ID or name. 
*a Lists all plate IDs or test definition names 
with an a at the end of the ID or name. 
alph? Lists all plate IDs or test definition names 
with alph followed by an additional 
character. For example, alpha or alphb. 
Viewing Quick Measurement Results 7-7 
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7.3 Viewing Quick Measurement Results 
Quick measurement results are displayed in a series of tabs in the ADAP software 
main window. The tabs displayed vary for each measurement type: 
• Endpoint photometric — Displays OD (optical density) and Status for 
absorbance measurements; Transmission and Status for transmission 
measurements performed on cuvette samples (refer to Section 7.3.1, Viewing 
Endpoint Photometric Measurement Results). 
• Kinetic photometric — Displays Reduced Data, Status, Raw Data, and 
Kinetic Graph (refer to Section 7.3.2, Viewing Kinetic Photometric 
Measurement Results). 
• Multiwavelength — Displays Raw Data, Graphic, Status, and Curve Info 
(refer to Section 7.3.3, Viewing Multiwavelength Photometric Measurement 
Results). 
• Spectral scan — Displays Graphic, Status, and Curve Info (refer to Section 
7.3.4, Viewing Spectral Scan Measurement Results). 
• Linear scan — Displays Raw Data Scan, Scan, Status, and Curve Info 
(refer to Section 7.3.5, Viewing Linear Scan Measurement Results). 
• Area scan — Displays Raw Data, Scan, and Status (refer to Section 7.3.7, 
Viewing Area Scan Measurement Results). 
7-8 Viewing Quick Measurement Results 
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7.3.1 Viewing Endpoint Photometric 
Measurement Results 
Measurement results for endpoint photometric measurements are displayed in two 
tabs: 
• OD — Displays the optical density measurement for each well or cuvette 
sample (refer to Section 7.3.1.1, Viewing Optical Density (OD) 
Measurement Results). 
OR 
Transmission — If transmission for cuvette samples was measured, 
displays percentage of transmission (refer to Section 7.3.1.2, Viewing 
Transmission Measurement Results) 
• Status — Displays which wells or cuvette samples were measured 
successfully and which were not because of errors during measurement 
(refer to Section 7.3.1.3, Viewing Sample Status). 
Viewing Quick Measurement Results 7-9 
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7.3.1.1 Viewing Optical Density (OD) Measurement 
Results 
OD displays the optical density measurement for each well or cuvette sample (Figure 
7-5). For bichromatic measurements, OD is calculated by subtracting measurements 
made with the reference filter from the measurements made with the primary filter. 
Note: Refer to Section 7.4.1, Printing General Measurement Results for information 
about printing OD measurement results. 
Figure 7-5. Measurement results — OD (microplate) 
7-10 Viewing Quick Measurement Results 
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7.3.1.2 Viewing Transmission Measurement Results 
For transmission measurements performed on cuvette samples, Transmission 
displays percentage transmission values, not absorbency (Figure 7-6). For example, 
0.000 refers to no transmission of light, which in terms of optical density (OD) is 
overflow. 100.000 refers to 100% transmission, which is 0 OD. 10.000 equals 10% 
transmission, which is 1 OD. 
Note: When Transmission is measured in an endpoint photometric measurement, 
optical density (OD) results are not reported in the measurement results. 
Note: Refer to Section 7.4.1, Printing General Measurement Results for information 
about printing Transmission measurement results. 
Figure 7-6. Measurement results — Transmission (cuvette) 
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7.3.1.3 Viewing Sample Status 
Status displays which wells or cuvette samples were measured successfully and 
which were not because of errors during the measurement (Figure 7-7): 
• OK — The well was measured successfully. 
• Error — The well was not measured because an error occurred. 
• Calc Error — The well was not measured because an error occurred; for 
example, division by zero in a transformation formula. 
Note: Calc Error appears only in measurement results from tests 
run in the ADAP Prisma software. 
• Overflow — A measurement could not be made because the optical density 
(OD) was above the indication limit. 
• Underflow — A measurement could not be made because reduced data 
could not be calculated. 
• Not Used — The well was not selected to be measured in the plate layout. 
Note: Not Used appears only in measurement results from tests 
run in the ADAP Prisma software. 
Note: Refer to Section 7.4.1, Printing General Measurement Results for information 
about printing Status results. 
Figure 7-7. Measurement results — Status (microplate) 
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7.3.2 Viewing Kinetic Photometric Measurement 
Results 
Results for kinetic photometric Quick measurements are displayed in four tabs: 
• Reduced Data — Displays the results for each well or cuvette sample 
calculated using the data reduction method configured for the Quick 
measurement (refer to Section 7.3.2.1, Viewing Kinetic Measurement 
Reduced Data). 
• Status — Displays which wells or cuvette samples were measured 
successfully and which were not because of errors during measurement 
(refer to Section 7.3.1.3, Viewing Sample Status). 
• Raw Data — Displays measurement results for each cycle performed in the 
measurement (refer to Section 7.3.2.2, Viewing Kinetic Measurement Raw 
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Data). 
• Kinetic Graph — Displays a graph of the kinetic measurement results for 
each well or cuvette sample (refer to Section 7.3.2.4, Viewing the Kinetic 
Graph for an Individual Well or Cuvette Sample). 
Viewing Quick Measurement Results 7-13 
ADAP Software for Zenyth 200 Operating Manual 
7.3.2.1 Viewing Kinetic Measurement Reduced Data 
Reduced Data displays the results for each well or cuvette sample calculated using 
the data reduction method configured in the Quick measurement (Figure 7-8). The 
actual tab name changes to reflect what type of results have been calculated. For 
example, most Slope reduction methods display OD/min, while Time reduction 
methods display t(sec) (refer to Section 6.2.4.1, Data Reduction Methods). 
Note: When no data reduction method is configured in the Quick measurement, the 
tab is labeled N/A and no data is displayed in the tab. 
Note: Refer to Section 7.4.1, Printing General Measurement Results for information 
about printing Reduced Data measurement results. 
Figure 7-8. Measurement results — reduced data (microplate) 
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7.3.2.2 Viewing Kinetic Measurement Raw Data 
Raw Data displays measurement results for each cycle of a photometric kinetic 
measurement (Figure 7-9). The cycle currently displayed and number of cycles in the 
measurement are shown to the right of Next Cycle. 
To view results from a different cycle: 
Choose Previous Cycle to view the measurement results from the preceding 
cycle. 
OR 
Choose Next Cycle to display results from the following cycle. 
To print Raw Data for all cycles: 
Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data and Curve 
Info). 
Figure 7-9. Measurement results — kinetic measurement raw data (microplate) 
Currently 
displayed cycle 
Number of cycles in 
measurement 
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7.3.2.3 Viewing Kinetic Measurement Graphs 
Kinetic Graph displays graphs of the kinetic measurement results for all wells or 
cuvette samples. The time or cycle number is plotted on the x-axis; Raw Data is 
plotted on the y-axis. The resulting graph shows how the measurement value varied 
over time. 
To change the Kinetic Graph view: 
• Use the scroll bars to view graphs for all wells or cuvette samples, if 
necessary. 
• Click on a well to view a detailed graph of the individual well or cuvette 
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sample (refer to Section 7.3.2.4, Viewing the Kinetic Graph for an Individual 
Well or Cuvette Sample). 
To print Kinetic Graph: 
Choose Print Graph to print the graphs for all wells or cuvette samples 
measured on a single page (refer to Section 7.4.3, Printing Graphs). 
Figure 7-10. Measurement results—Kinetic Graph (microplate) 
7-16 Viewing Quick Measurement Results 
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7.3.2.4 Viewing the Kinetic Graph for an Individual Well 
or Cuvette Sample 
Kinetic Graphs for individual wells or cuvette samples can be viewed in detail. 
Positioning the cursor over any point on the curve displays the x and y coordinate 
values of that position in the upper right corner of the tab. 
To display the Kinetic Graph for a single well or cuvette sample: 
In Kinetic Graph, click on the desired well to view. Kinetic Graph displays the 
detailed kinetic graph for the selected well or cuvette sample (Figure 7-11). 
To return to the main Kinetic Graph view: 
Click on the detailed kinetic graph. Kinetic Graph displays kinetic graphs for all 
wells or cuvette samples (Figure 7-10). 
Note: Print Graph prints kinetic measurement graphs for all measured wells and 
cuvette samples, not the individual well or cuvette sample being viewed in detail 
(refer to Section 7.4.3, Printing Graphs). 
Figure 7-11. Kinetic graph for a single well or cuvette sample 
y-axis 
Raw data values 
x-axis 
Time or number of cycle 
Curve 
Displays the x- and y-axis values 
corresponding to the location of the 
cursor when positioned over the graph. 
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7.3.3 Viewing Multiwavelength Photometric 
Measurement Results 
Results for multiwavelength photometric Quick measurements are displayed in four 
tabs: 
• Raw Data — Displays measurement results for each wavelength chosen in 
the Quick measurement (refer to Section 7.3.3.1, Viewing Multiwavelength 
Measurement Raw Data). 
• Graphic — Displays a graph of multiwavelength measurement results for 
each well or cuvette sample (refer to Section 7.3.3.1, Viewing 
Multiwavelength Measurement Raw Data). 
• Status — Displays which wells or cuvette samples were measured 
successfully and which were not because of errors during measurement 
(refer to Section 7.3.1.3, Viewing Sample Status). 
• Curve Info — Displays optical density and percentage transmission values 
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for a single sample at each wavelength measured. In the ADAP Prisma 
software, more detailed information about the curve, including peak and 
valley data, is also displayed (refer to Section 7.3.3.4, Viewing 
Multiwavelength Measurement Curve Info). 
7-18 Viewing Quick Measurement Results 
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7.3.3.1 Viewing Multiwavelength Measurement Raw Data 
Raw Data displays the optical density (OD) for each well or cuvette sample at each 
wavelength measured (Figure 7-12). Results for each measured wavelength are 
displayed separately. The wavelength currently being displayed is indicated near the 
center of the tab. 
Note: For transmission measurements performed on cuvette samples, Raw Data 
displays transmission results instead of optical density. 
To view results from a different measurement wavelength: 
Choose Previous Filter to view the results from the previous measured 
wavelength. 
OR 
Choose Next Filter to display results from the next measured wavelength. 
To print Raw Data measurement results for all wavelengths: 
Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data and Curve 
Info). 
Figure 7-12. Measurement results — multiwavelength Raw Data (cuvette) 
Wavelength 
currently displayed 
Number of 
wavelengths 
measured 
Viewing Quick Measurement Results 7-19 
ADAP Software for Zenyth 200 Operating Manual 
7.3.3.2 Viewing Multiwavelength Measurement Graphs 
Graphic displays graphs of multiwavelength measurement results for all wells or 
cuvette samples (Figure 7-13). The measurement wavelength is plotted on the x-axis; 
the OD or transmission values are plotted on the y-axis. 
To change the Graphic view: 
• Use the scroll bars to view graphs for all samples, if necessary. 
• Click on a sample. Choose an option from the menu that appears: 
• Curve Info — Displays the Curve Info tab (refer to Section 7.3.3.4, 
Viewing Multiwavelength Measurement Curve Info) 
• Zoom Graph — Displays a detailed graph of the results for the selected 
sample (refer to Section 7.3.3.3, Viewing the Multiwavelength Graph for 
an Individual Sample). 
• Show Graph — Displays the Graph window where curves for all 
samples can be studied in greater detail with additional viewing and 
calculation options (refer to Section 7.3.6, Viewing and Performing 
Calculations on Curves in the Graph Window). 
Note: Show Graph is only availible in the ADAP Prisma 
software. 
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To print Graphic: 
Choose Print Graph to print the graphs for all wells or cuvette samples measured 
(refer to Section 7.4.3, Printing Graphs). 
Figure 7-13. Measurement results — multiwavelength Graphic (cuvette) 
7-20 Viewing Quick Measurement Results 
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7.3.3.3 Viewing the Multiwavelength Graph for an 
Individual Sample 
The multiwavelength Graphic for an individual well or cuvette sample can be viewed 
in detail. Positioning the cursor over any point on the curve displays the x and y 
coordinate values of that position in the upper right corner of the tab. 
To display the multiwavelength Graphic for a single well or cuvette sample: 
1. In Graphic, click on the desired well to view. 
2. Choose Zoom Graph from the menu that appears. Graphic displays the detailed 
multiwavelength graph for the selected well or cuvette sample (Figure 7-14). 
To return to the main multiwavelength Graphic view: 
Click on the detailed multiwavelength graph. Graphic displays multiwavelength 
graphs for all wells or cuvette samples (Figure 7-13). 
Note: Print Graph prints multiwavelength graphs for all measured wells and 
cuvette samples, not the individual well or cuvette sample being viewed in detail 
(refer to Section 7.4.3, Printing Graphs). 
Figure 7-14. Multiwavelength Graphic for a single well or cuvette sample 
y-axis 
OD or transmission values 
x-axis 
Wavelength 
Curve 
Displays the x- and y-axis values 
corresponding to the location of the 
cursor when positioned over the graph. 
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7.3.3.4 Viewing Multiwavelength Measurement Curve 
Info 
Curve Info displays the OD and transmission values at each wavelength measured 
for a single sample (Figure 7-15). The ADAP Prisma software also displays more 
detailed information about the curve, including values of peaks, valleys, and average 
slope. 
To view Curve Info for a different well or cuvette sample: 
Choose Previous Sample to view Curve Info for the previous sample. 
OR 
Choose Next Sample to view Curve Info for the next sample. 
To print Curve Info measurement results for all samples: 
Choose Print. 
To print Curve Info tables for the displayed sample: 
Right click in a Curve Info table and choose the desired printing option (refer to 
Section 7.4.2.1, Printing Curve Info Data Tables). 
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Figure 7-15. Measurement results — multiwavelength Curve Info (cuvette) 
Curve Info 
This data appears only in the 
ADAP Prisma software. 
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7.3.4 Viewing Spectral Scan Measurement 
Results 
Results for spectral scan Quick measurements are displayed in three tabs: 
• Graphic — Displays graphs of spectral scan measurement results for all 
samples (refer to Section 7.3.4.1, Viewing Spectral Scan Graphs). 
• Status — Displays which wells or cuvette samples were measured 
successfully and which were not because of errors during measurement 
(refer to Section 7.3.1.3, Viewing Sample Status). 
• Curve Info — Displays optical density and percentage transmission values 
for a single sample at all points measured. In the ADAP Prisma software, 
more detailed information about the curve, including peak and valley data, is 
also displayed (refer to Section 7.3.4.3, Viewing Spectral Scan Curve Info). 
Viewing Quick Measurement Results 7-23 
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7.3.4.1 Viewing Spectral Scan Graphs 
Graphic displays graph of spectral scan measurement results for all samples (Figure 
7-16). The wavelengths measured are plotted on the x-axis; OD values are plotted on 
the y-axis. 
To change the Graphic view: 
• Use the scroll bars to view graphs for all samples, if necessary. 
• Click on a sample. Select an option from the menu that appears: 
• Curve Info — Displays the Curve Info tab (refer to Section 7.3.4.3, 
Viewing Spectral Scan Curve Info). 
• Zoom Graph — Displays a detailed graph of the results for the selected 
sample (refer to Section 7.3.4.2, Viewing the Spectral Scan Graph for an 
Individual Sample). 
• Show Graph — Displays the Graph window where curves for all 
samples can be studied in greater detail with additional viewing and 
calculation options (refer to Section 7.3.6, Viewing and Performing 
Calculations on Curves in the Graph Window). 
Note: Show Graph is only availible in the ADAP Prisma 
software. 
To print Graphic: 
Choose Print Graph to print the graphs for all wells or cuvette samples 
measured (refer to Section 7.4.3, Printing Graphs). 
Figure 7-16. Measurement results — spectral scan Graphic 
7-24 Viewing Quick Measurement Results 
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7.3.4.2 Viewing the Spectral Scan Graph for an 
Individual Sample 
The spectral scan Graphic for an individual well or cuvette sample can be viewed in 
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detail. Positioning the cursor over any point on the curve displays the x and y 
coordinate values of that position in the upper right corner of the tab. 
To display the spectral scan Graphic for a single well or cuvette sample: 
1. In Graphic, click on the desired well to view. 
2. Choose Zoom Graph from the menu that appears. Graphic displays the detailed 
spectral scan graph for the selected well or cuvette sample (Figure 7-17). 
To return to the main spectral scan Graphic view: 
Click on the detailed spectral scan graph. Graphic displays spectral scan graphs 
for all wells or cuvette samples (Figure 7-16). 
Note: Print Graph prints spectral scan graphs for all measured wells and cuvette 
samples, not the individual well or cuvette sample being viewed in detail (refer to 
Section 7.4.3, Printing Graphs). 
Figure 7-17. Spectral scan Graphic for a single well or cuvette sample 
x-axis 
Wavelength 
y-axis 
OD value 
Curve 
Displays the x- and y-axis values 
corresponding to the location of the 
cursor when positioned over graph. 
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7.3.4.3 Viewing Spectral Scan Curve Info 
Curve Info displays the OD and transmission values at all wavelengths measured 
across the selected spectrum for a single sample (Figure 7-18). The ADAP Prisma 
software also displays more detailed information about the curve, including values of 
peaks, valleys, and average slope. 
To view Curve Info for a different well or cuvette sample: 
Choose Previous Sample to view Curve Info for the previous sample. 
OR 
Choose Next Sample to view Curve Info for the next sample. 
To print Curve Info measurement results for all samples: 
Choose Print. 
To print Curve Info tables for the displayed sample: 
Right click in a Curve Info table and choose the desired printing option (refer to 
Section 7.4.2.1, Printing Curve Info Data Tables). 
Figure 7-18. Measurement results — spectral scan Curve Info (cuvette) 
Curve Info 
This data appears only in the 
ADAP Prisma software. 
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7.3.5 Viewing Linear Scan Measurement Results 
Results for linear scan Quick measurements are displayed in four tabs: 
• Raw Data Scan — Displays values from the 25 measurement points across 
center of each well (refer to Section 7.3.5.1, Viewing Linear Scan 
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Measurement Raw Data). 
• Scan — Displays graphs of the linear transmission profiles for all wells 
measured (refer to Section 7.3.5.2, Viewing Linear Scan Graphs). 
• Status — Displays which samples were measured successfully and which 
were not because of errors during measurement (refer to Section 7.3.1.3, 
Viewing Sample Status). 
• Curve Info — Displays the transmission values for a single sample at all 25 
measurement points. In the ADAP Prisma software, more detailed 
information about the curve, including peak and valley data, is also 
displayed (refer to Section 7.3.5.4, Viewing Linear Scan Curve Info). 
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7.3.5.1 Viewing Linear Scan Measurement Raw Data 
Raw Data Scan displays values from the 25 measurement points across the center of 
each well (Figure 7-19). 
Note: Raw data values displayed are percentage transmission values, not 
absorbency. For example, 0.000 refers to no transmission of light, which in terms of 
OD is overflow. 100.000 refers to 100% transmission, which is 0 OD. 10.000 equals 
10% transmission, which is 1 OD. 
The currently displayed measurement point and total number of measurement points 
are shown to the right of Next Cycle. 
To view results from a different measurement point: 
Choose Previous Cycle to view the measurement results from the previous 
measurement point. 
OR 
Choose Next Cycle to display results from the next measurement point. 
To print Raw Data Scan measurement results for all cycles: 
Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data and Curve 
Info). 
Figure 7-19. Raw Data tab for a Linear Scan Measurement 
Currently displayed 
measurement point 
Number of 
measurement points 
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7.3.5.2 Viewing Linear Scan Graphs 
Scan displays graphs of the linear transmission profile for all wells on the plate 
(Figure 7-20). A linear transmission graph displays the transmission measured at 25 
points across the center of the well. The y-axis refers to transmission percentage; the 
x-axis refers to measurement positions. 
Note: Data in the graphs are percentage transmission values, not absorbency. For 
example, 0.000 refers to no transmission of light, which in terms of OD is overflow. 
100.000 refers to 100% transmission, which is 0 OD. 10.000 equals 10% 
transmission, which is 1 OD. 
Figure 7-20. Measurement results — linear scan graphs 
Viewing Quick Measurement Results 7-29 
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To change the Scan view: 
• Use the scroll bars to view graphs for all wells on the plate, if necessary. 
• Click on a sample. Choose an option from the menu that appears: 
• Curve Info — Displays the Curve Info tab (refer to Section 7.3.5.4, 
Viewing Linear Scan Curve Info). 
• Zoom Graph — Displays a detailed graph of the results for the selected 
sample (refer to Section 7.3.5.3, Viewing the Linear Scan Graph for 
Individual Wells). 
• Show Graph — Displays the Graph window where curves for all 
samples can be studied in greater detail with additional viewing and 
calculation options (refer to Section 7.3.6, Viewing and Performing 
Calculations on Curves in the Graph Window). 
Note: Show Graph is only availible in the ADAP Prisma 
software. 
To print Scan: 
Choose Print Graph to print the graphs for all wells measured (refer to Section 
7.4.3, Printing Graphs). 
7-30 Viewing Quick Measurement Results 
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7.3.5.3 Viewing the Linear Scan Graph for Individual 
Wells 
Linear scan graphs for individual wells can be viewed in detail. 
To display the linear scan graph for an individual well: 
1. In Scan, click on the desired well to view. 
2. Choose Zoom Graph from the menu that appears. Scan displays the detailed 
linear scan graph for the selected well (Figure 7-21). 
To return the main Scan view: 
Click on the detailed linear scan graph. Scan displays linear scan graphs for all 
wells (Figure 7-21). 
Note: Print Graph prints linear scan graphs for all measured wells, not the 
individual well being viewed in detail (refer to Section 7.4.3, Printing Graphs). 
Figure 7-21. Linear scan graph for a single well 
y-axis 
% transmission 
x-axis 
Measurement position 
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7.3.5.4 Viewing Linear Scan Curve Info 
Curve Info displays the transmission values at all 25 measurement points for a single 
sample (Figure 7-22). The ADAP Prisma software also displays more detailed 
information about the curve, including values of peaks, valleys, and average slope. 
To view Curve Info for a different well: 
Choose Previous Sample to view Curve Info for the previous sample. 
OR 
Choose Next Sample to view Curve Info for the next sample. 
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To print Curve Info measurement results for all samples: 
Choose Print. 
To print Curve Info tables for the displayed sample: 
Right click in a Curve Info table and choose the desired printing option (refer to 
Section 7.4.2.1, Printing Curve Info Data Tables). 
Figure 7-22. Measurement results — linear scan Curve Info 
Curve Info 
This data appears only in the 
ADAP Prisma software. 
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7.3.6 Viewing and Performing Calculations on 
Curves in the Graph Window 
In the ADAP Prisma software, Graph provides options to view, compare, and 
perform curve fitting on graphs for multiwavelength, spectral scan, and linear 
measurement results. Graphs for all samples measured are displayed simultaneously 
and color coded for differentiation (Figure 7-23). 
Note: Graph is available only with a valid ADAP Prisma software license. 
Figure 7-23. Graph 
To open Graph: 
From the Graph tab in multiwavelength measurement results, the Graphic tab in 
spectral scan measurement results, or the Scan tab in linear scan measurement 
results, click on a sample graph and choose Show Graph from the menu that 
appears. 
To close Graph: 
From the File menu, choose End. 
Note: To save smoothed curves before closing Graph, from the File 
menu, choose Save Calc Container (refer to Section 7.3.6.4.2, 
Saving Smoothed Curves). 
Note: To clear Graph, from the Options menu, choose Clear Graph. 
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Graph provides the ability to: 
• View individual curves (refer to Section 7.3.6.1, Viewing Individual Curves). 
• View the properties of individual curves in text form (refer to Section 
7.3.6.2, Viewing the Properties of an Individual Curve). 
• Change the graph view by zooming in on specific areas of Graph (refer to 
Section 7.3.6.3, Changing the Graph View by Zooming). 
• Smooth curves using curve fitting methods (refer to Section 7.3.6.4, Using 
Curve Fitting Methods to Smooth Curves). 
• Calculate the area under curves (refer to Section 7.3.6.5, Calculating the 
Area Under Curves). 
• Copy Graph as a bitmap image that can be pasted into other software 
applications (refer to Section 7.3.6.6, Copying the Contents of Graph). 
• Print the contents of Graph (refer to Section 7.3.6.7, Printing the Contents 
of Graph). 
7-34 Viewing Quick Measurement Results 
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Anthos Labtec Instruments GmbH 
7.3.6.1 Viewing Individual Curves 
When Graph is opened, curves for all samples measured are displayed. Individual 
curves can be selected and viewed. 
To view an individual curve: 
1. From the Options menu, select Draw Single Line. 
2. In Select Line, choose the individual curve to view. Graph displays only the 
chosen curve (Figure 7-24). 
Figure 7-24. Graph displaying an individual curve 
Note: To view the X and Y values for a point on the curve, position the cursor over 
the desired point. Actual Values displays the X and Y values at that position. 
Curve Value displays the OD or transmission value at the curve peak or valley 
nearest to the current cursor position. 
Area under Curve displays the calculated value for the area under a curve (refer to 
Section 7.3.6.5, Calculating the Area Under Curves). 
To display all curves after viewing an individual curve: 
From the Options menu, choose Restore Graph 1:1. Graph displays all 
curves in the measurement results. 
Note: Draw Single Line remains enabled until it is toggled off by 
selecting it again. When enabled, each time a curve is chosen in Select 
Line, Graph displays the chosen curve individually. 
Select Line 
Choose an individual curve 
curve to display. 
Position the cursor over the curve 
to view the X and Y values for that 
point on the curve in Actual Values. 
Actual Values 
Displays the X and Y values at 
the cursor position, Curve 
Value, and Area under Curve. 
The peak or valley nearest to the current 
cursor position is displayed in Actual 
Values as Curve Value. 
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7.3.6.2 Viewing the Properties of an Individual Curve 
Detailed information about curve properties, including OD and transmission values, 
curve peak and valley values, and average slope, may be viewed in text form for any 
curve displayed in Graph. Curve properties may also be: 
• Copied to other applications (refer to Section 7.3.6.2.1, Copying Curve 
Properties to Other Applications). 
• Saved as text files (refer to Section 7.3.6.2.2, Saving Curve Properties as 
Text Files). 
• Printed (refer to Section 7.3.6.2.3, Printing Curve Properties). 
To view curve properties: 
1. In Select Line, choose the desired curve. 
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2. From the File menu, choose Curve Properties. Information appears 
(Figure 7-25). 
Figure 7-25. Information — curve properties 
To close Information: 
From the File menu, choose End. 
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7.3.6.2.1 Copying Curve Properties to Other Applications 
Curve properties displayed in Information can be copied to the clipboard. The 
properties can then be pasted into another application for storage or further analysis. 
To copy curve properties: 
1. From the File menu, choose Copy. 
2. Open or switch to the application where the curve properties will be pasted. 
3. Paste the curve properties into a new or existing file using the Paste command 
for the application. 
Note: Most applications have CTRL+V assigned as the Paste 
command keyboard shortcut. 
7.3.6.2.2 Saving Curve Properties as Text Files 
Curve properties displayed in Information can be saved as text files which can be 
viewed in any text editor or imported into many statistical software packages or 
spreadsheet applications. 
To save curve properties as a text file: 
1. From the File menu, choose Save. Save As appears (Figure 7-26). 
Figure 7-26. Save As 
2. Browse to the desired location to save the text file. 
3. Enter a File name for the text file. 
4. Choose Save to save the file 
OR 
Choose Cancel to return to the ADAP software without saving the curve 
properties as a text file. 
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7.3.6.2.3 Printing Curve Properties 
Curve properties displayed in Information can be printed. Printing may output hard 
copies or files; for example, Acrobat® PDF documents. 
To print curve properties: 
1. In the File menu, choose Print. Print appears (Figure 7-27). 
Figure 7-27. Print 
2. In Printer, select the desired printer to print the information. All printers that are 
properly installed and configured on the computer are listed. 
3. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
4. Choose OK to print curve properties. 
Note: If the selected printer is configured to print to a file, such as an Acrobat PDF 
(*.pdf), a prompt asking for the filename appears. The printed file is saved to the 
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ADAP software home directory. 
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7.3.6.3 Changing the Graph View by Zooming 
Graph provides two methods of zooming to change the graph view: 
• Zooming in and out by fixed percentages (refer to Section 7.3.6.3.1, 
Zooming by Fixed Percentages). 
• Zooming in by dragging over the desired region (refer to Section 7.3.6.3.2, 
Zooming by Dragging Over the Desired Region). 
7.3.6.3.1 Zooming by Fixed Percentages 
The graph view may be changed by zooming in and out at fixed increments between 
50% and 200%. 
Note: The ability to zoom in or out is disabled when the option the option to 
calculate the area under a curve is enabled (refer to Section 7.3.6.5, Calculating the 
Area Under Curves). 
To zoom in or out: 
From the Options menu, choose Zoom, and then the desired fixed percentage to 
zoom. 
Note: When zoomed in, use the scroll bars to access regions of the graph view not 
visible. 
To reset the original graph view: 
From the Options menu, choose Zoom>100%. 
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7.3.6.3.2 Zooming by Dragging Over the Desired Region 
Zooming in on a section of the graph view may be accomplished by dragging over the 
desired region to enlarge. 
Note: The ability to zoom by dragging is disabled when the option to calculate the 
area under a curve is enabled (refer to Section 7.3.6.5, Calculating the Area Under 
Curves). 
To zoom in by dragging: 
1. Position the cursor at the desired starting position for the selection, then depress 
and hold the mouse button down. 
2. Drag the mouse until the desired region is selected (Figure 7-28). The selected 
region is highlighted in blue. 
3. Release the mouse button. Graph displays a zoomed view of the selected region. 
Note: When zoomed in by selection, regions of the graph not visible are not 
accessible. To view regions not included in the zoom selection, choose Restore 
Graph 1:1 to reset the graph view to 100%. 
Figure 7-28. Selecting a zoom region 
To reset the original graph view: 
From the Options menu, choose Restore Graph 1:1. 
Selected Region 
The graph view will zoom so that 
the selected region fills Graph. 
Starting position 
for selection 
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Ending position 
for selection 
7-40 Viewing Quick Measurement Results 
Anthos Labtec Instruments GmbH 
7.3.6.4 Using Curve Fitting Methods to Smooth Curves 
Curves can be smoothed using one of the five curve fitting methods available in the 
ADAP software. 
Smoothed curves may also be: 
• Deleted (refer to Section 7.3.6.4.1, Deleting Smoothed Curves). 
• Saved (refer to Section 7.3.6.4.2, Saving Smoothed Curves). 
• Opened (refer to Section 7.3.6.4.3, Opening Saved Smoothed Curves). 
To apply a curve fitting method to a curve: 
1. In Select Line, choose the curve to smooth. 
Note: If desired, the curve to smooth can be viewed individually (refer 
to Section 7.3.6.1, Viewing Individual Curves). 
2. From the Edit menu, choose the curve fitting method to apply: 
• Smooth Curve Linear — Curve is smoothed by a linear regression 
calculation (refer to Section 8.2.3.2.1, Curve Fitting Models). 
• Smooth Curve Mean — Curve is smoothed using mean values. 
• Smooth Curve Cubic Spline Low — Curve is smoothed by a cubic 
spline calculation (refer to Section 8.2.3.2.1, Curve Fitting Models). 
Note: Choose this option when the deviation of 
measurement points is low. 
• Smooth Curve Cubic Spline Medium — Curve is smoothed by a 
cubic spline calculation (refer to Section 8.2.3.2.1, Curve Fitting 
Models). 
Note: Choose this option when the deviation of 
measurement points is medium. 
• Smooth Curve Cubic Spline High — Curve is smoothed by a cubic 
spline calculation (refer to Section 8.2.3.2.1, Curve Fitting Models). 
Note: Choose this option when the deviation of 
measurement points is high. 
The smoothed curve is calculated and displayed with the original curve. In 
Select Line, smoothed curves are labeled using the format curve fitting method 
(original curve label); for example Mean (Well 1.1). 
3. To smooth additional curves, repeat steps 1 and 2 above. 
7.3.6.4.1 Deleting Smoothed Curves 
Smoothed curves displayed in Graph can be deleted. Deleting a smoothed curve 
removes it from the graph view, but does not delete smoothed curve data saved in 
Calc Container files. 
To delete smoothed curves: 
From the Edit menu, choose Delete Calc Container. Smoothed curves are 
removed from the graph view. 
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7.3.6.4.2 Saving Smoothed Curves 
Smoothed curve data can be saved for further evaluation. Smoothed curves are stored 
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in a Calc Container, a text file that may be opened by most word processors, 
spreadsheets, and database applications. 
To save a Calc Container: 
1. From the File menu, choose Save Calc Container. Save As appears 
(Figure 7-29). 
Figure 7-29. Save As — Calc Container 
2. Browse to the desired location to save the text file. 
3. Enter a File name for the file. 
4. In Save as type, select the type of file to save: 
• TXT — Saves the smoothed curve data in a text file that can be opened 
by many word processing, spreadsheet, and database applications. 
• XML — Saves the smoothed curve data in an XML file. XML is a 
format designed for sharing information over the Web. 
Note: The DWR file type is also available. DWR Calc 
Containers are designed to save test definition data, and 
should not be used to save smoothed curves. 
5. Choose Save to save the file. 
OR 
Choose Cancel to return to the ADAP software without saving the Calc 
Container. 
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7.3.6.4.3 Opening Saved Smoothed Curves 
Saved Calc Containers with smoothed curve data can be opened and viewed in 
Graph. 
To open a Calc Container: 
1. From the File menu, choose Open. Open appears (Figure 7-30). 
Figure 7-30. Opening a saved Calc Container 
2. Browse to and select the Calc Container file to open. 
Note: If necessary, select the File of type that stores the Calc 
Container data: Result Container TXT (*.txt) or Result Container 
XML (*.xml). Only files of the selected type are displayed in Open. 
3. Choose Open to open the Calc Container. 
OR 
Choose Cancel to close Open without opening a Calc Container. 
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7.3.6.5 Calculating the Area Under Curves 
The area under a curve can be calculated. The actual area calculated can be modified 
by dragging the start and/or endpoint of the straight line that indicates the bottom 
border of the area calculated. 
Note: The ability to calculate the area under a curve is disabled when the graph view 
is zoomed in or out (refer to Section 7.3.6.3, Changing the Graph View by Zooming). 
To calculate the area under a curve: 
1. In Select Line, choose the desired curve. 
Note: If desired, select an individual curve to view in Graph (refer to 
Section 7.3.6.1, Viewing Individual Curves). 
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2. From the Options menu, choose Calculate Area under Curve. A blue 
straight line with endpoints appears (Figure 7-31). The calculated area under the 
curve is displayed in Actual Values. 
Figure 7-31. Graph — calculating the area under a curve 
To move the endpoints of the straight line and recalculate the area under a curve: 
Click on an endpoint and drag it to a new location on the curve. The area under 
the curve is automatically recalculated based on the new position of the straight 
line. 
To turn off Calculate Area under Curve: 
From the Options menu, deselect Calculate Area under Curve. 
Calculated value for the 
area under the curve 
Area under curve 
(shading does not appear 
in the ADAP software) 
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7.3.6.6 Copying the Contents of Graph 
The contents of Graph can be copied as a bitmap image that can be pasted into other 
software applications such as word processors. 
To copy the contents of Graph to another software application: 
1. From the Edit menu, choose Copy. The contents of Graph are copied to the 
clipboard as a bitmap image. 
2. Open or switch to the application where the bitmap image will be pasted. 
3. Paste the bitmap image into a new or existing file using the Paste command for 
the application. 
Note: Most applications have CTRL+V assigned as the Paste 
command keyboard shortcut. 
7.3.6.7 Printing the Contents of Graph 
Graph may be printed. Printing may create either hard copies or files, such as 
Acrobat PDF documents. 
To print Graph: 
1. In the File menu, choose Print. Print appears (Figure 7-27). 
Figure 7-32. Print 
2. In Printer, select the desired printer to print the information. All printers that are 
properly installed and configured on the computer are listed. 
3. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
4. Choose OK to print Graph. 
Note: If the selected printer is configured to print to a file, such as an Acrobat® PDF 
(*.pdf), a prompt asking for the filename appears. The printed file is saved to the 
ADAP software home directory. 
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7.3.7 Viewing Area Scan Measurement Results 
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Results for area scan Quick measurements are displayed in three tabs: 
• Raw Data Scan — Displays values from all measurement points across the 
well (refer to Section 7.3.7.1, Viewing Area Scan Measurement Raw Data). 
• Scan — Displays graphs of the area scan transmission profiles for all wells 
measured (refer to Section 7.3.7.2, Viewing Area Scan Transmission 
Profiles). 
• Status — Displays which samples were measured successfully and which 
were not because of errors during measurement (refer to Section 7.3.1.3, 
Viewing Sample Status). 
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7.3.7.1 Viewing Area Scan Measurement Raw Data 
For area scan measurements, Raw Data displays results for measurement points one 
well at a time (Figure 7-33). Results are displayed in a matrix that corresponds to the 
layout of the measurement points for each well. 
Note: Raw data values displayed are percentage transmission values, not 
absorbency. For example, 0.000 refers to no transmission of light, which in terms of 
OD is overflow. 100.000 refers to 100% transmission, which is 0 OD. 10.000 equals 
10% transmission, which is 1 OD. 
To view results from a different well: 
Choose Previous Well to view the measurement results from the preceding 
well. 
OR 
Choose Next Well to display results from the following well. 
To print Raw Data measurement results for all wells: 
Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data and Curve 
Info). 
Figure 7-33. Raw Data for an area scan measurement of Well A1 
Currently 
displayed well 
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7.3.7.2 Viewing Area Scan Transmission Profiles 
For area scan measurements, Scan displays three-dimensional transmission profiles 
for all measured wells on the plate (Figure 7-34). The values presented are a 
percentage of transmission. Two yellow lines indicate 0% and 100% transmission 
(Figure 7-35). 
Note: Data presented in the profiles are percentage transmission values, not 
absorbency. For example, 0.000 refers to no transmission of light, which in terms of 
OD is overflow. 100.000 refers to 100% transmission, which is 0 OD. 10.000 equals 
10% transmission, which is 1 OD. 
Figure 7-34. Measurement results — area scan transmission profiles 
Figure 7-35. Transmission profile detail 
3d View 
Use the scroll bars to 
rotate the viewing angle. 
100% 
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transmission 
0% 
transmission 
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To print area scan transmission profiles: 
Choose Print Graph to print the profiles for all wells measured (refer to Section 
7.4.3, Printing Graphs). 
To change the absorbance profile view: 
• Use the main scroll bars to view the graphs for all wells on the plate, if 
necessary. 
• Use the 3d View scroll bars in the upper left of the Scan tab to change the 
angle for all wells on the plate (refer to Section 7.3.7.2.1, Changing the 
Viewing Angle for All Wells). 
• Click on an individual well to view a detailed three-dimensional rendering of 
the transmission profile that can be rotated, zoomed, and viewed with 
different colors and textures applied (refer to Section 7.3.7.2.2, Viewing the 
Transmission Profile of a Single Well). 
Note: The ADAP Prisma software is required to view 
transmission profiles of single wells. 
7.3.7.2.1 Changing the Viewing Angle for All Wells 
The 3d View controls in the upper left of Scan allow the transmission profiles for all 
wells to be viewed from different angles. 
To change the viewing angle: 
1. Use the horizontal scroll bar to rotate the view left and right, if desired. 
2. Use the vertical scroll bar to rotate the view up and down, if desired. 
3. Choose Refresh Graph to update the display of the absorbance profiles to the 
new viewing angle. 
7.3.7.2.2 Viewing the Transmission Profile of a Single Well 
Note: The ADAP Prisma software is required to view transmission profiles of 
single wells. 
A detailed view of the transmission profile for each measured well is available in 
View3D. This 3-D image can be rotated, zoomed, and viewed with different textures 
and colors applied. 
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To display View3D: 
1. In Scan, click on the desired well to view. View 3D appears (Figure 7-36). 
Figure 7-36. View3D 
2. To change the viewing angle of the transmission profile, click and hold the left 
mouse button, and move the mouse in the desired direction of rotation. 
OR 
To zoom in or out, click and hold the right mouse button, and move the mouse 
left or right, or up or down. 
Note: When zooming, moving the mouse up and down produces the 
same zoom effect as moving the mouse left and right. 
3. If desired, change the texture and brightness of the 3-D image by choosing 
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options in the View menu: 
• Light — Brightens the 3-D image. 
• Wireframe — Hides the surface layer so that only the underlying 
wireframe, or skeleton, of the 3-D image is visible. 
• Solid — Displays the 3-D image as a solid object. 
• Shaded — Divides the surface layer into sections differentiated by 
color. 
• Transparent — Displays the 3-D image with a translucent surface 
layer. 
• Outlined — Displays only the outer outline of the 3D image. 
• Metallic — Displays the surface texture of the 3D image with a 
simulated metallic finish. 
• Atmosphere — Subtly modifies the brightness and texture of the 
surface layer. 
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If desired, change the color of the surface layer by choosing options in the Edit menu: 
• Color White — Displays the surface color of the 3-D as white. 
• Color Gradient — Blends the surface layer color of the 3-D image 
using a gradient. 
7.3.7.2.3 Saving Transmission Profiles 
3-D images of transmission profiles can be saved as image files separate from the 
measurement results. Images are saved in Dex3D (*.dex) format. 
To save a 3-D image of an transmission profile: 
1. From the File menu, select Save. Save as appears (Figure 7-37). 
Figure 7-37. Saving an transmission profile 
Browse to directory where the file will be saved and choose a File name. 
2. Choose Save to save the file. 
OR 
Choose Cancel to return to View3D without saving the image. 
Viewing Quick Measurement Results 7-51 
ADAP Software for Zenyth 200 Operating Manual 
7.3.7.2.4 Loading Transmission Profiles 
3-D images of transmission profiles saved in Dex3D (*.dex) format can be loaded 
into the ADAP software for viewing. 
View3D must be open to load a 3-D image. 
To load a 3-D image of an transmission profile: 
1. From the File menu, select Load. Open appears (Figure 7-38). 
Figure 7-38. Loading a transmission profile 
2. Browse to directory where the desired image is saved and select it. 
3. Choose Open to load the image. 
Note: Selecting Open as read-only prevents the 3-D image from 
being modified while the file is open. 
OR 
Choose Cancel to return to View3D without opening the image. 
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7.4 Printing Quick Measurement Results 
For record-keeping purposes, the ADAP software has the ability to print Quick 
measurement results and information. The printing procedure varies depending on 
which measurement results or information tab is being printed. 
To print: 
• OD, Transmission, Reduced Data, and Status — From the Setup menu 
or toolbar, choose Print (refer to Section 7.4.1, Printing General 
Measurement Results). 
• Raw Data and Curve Info — Depending on the button available within the 
tab, choose Print Raw Data or Print (refer to Section 7.4.2, Printing Raw 
Data and Curve Info). 
• Graphs — In the tab itself, choose Print Graph to print graphs for all 
measured wells or cuvette samples (refer to Section 7.4.3, Printing Graphs). 
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7.4.1 Printing General Measurement Results 
General measurement results and information from OD, Transmission, or Reduced 
Data are combined with Status into a single printout. 
To print results and information: 
1. From the Setup menu, choose Print. Print appears (Figure 7-39). 
OR 
Choose Print. Print appears (Figure 7-41). 
Note: Choosing Print from the toolbar opens a simplified type of Print 
(Figure 7-41). 
Figure 7-39. Print chosen from Setup menu 
2. In Printer, select the desired printer to print the information. All printers that are 
properly installed and configured on the computer are listed. 
3. In Options, select the desired Font, text Size, and number of Copies. 
Note: If printing from the simplified Print (Figure 7-41), in Options, 
select the desired Font and text Size. A single copy is printed 
automatically. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
Note: In range, selecting All Tests or Single Test produces the 
same printout for Quick measurements. 
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4. Choose OK. 
Note: If the selected printer is configured to print to a file, such as an 
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The 
printed file is saved to the ADAP software home directory. 
7.4.1.1 Viewing General Measurement Results Printouts 
Printouts generated from OD, Transmission, Reduced Data, and Status display 
measurement results and information in a matrix that matches the plate layout (Figure 
7-40). For each well, the first line lists the plate layout label assigned to the well, the 
second OD, Transmission, or Reduced Data results, and the third Status. 
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Figure 7-40. General measurement results — OD and Status (excerpt) 
Note: A general measurement results printout of kinetic measurement results 
includes kinetic graphs for measured wells. Kinetic graphs can also be printed 
separately by choosing Print Graph in Kinetic Graph (refer to Section 7.4.3, 
Printing Graphs). 
To print kinetic raw data, in Raw Data, choose Print Raw Data (refer to Section 
7.4.2, Printing Raw Data and Curve Info). 
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7.4.2 Printing Raw Data and Curve Info 
Raw Data, Raw Data Scan, and Curve Info can be printed from measurement 
results that include any of these tabs. 
Note: Information in the OD, Transmission, Reduced Data and Status tabs are 
printed by choosing Print in the Setup menu (refer to Section 7.4.1, Printing 
General Measurement Results). 
To print kinetic or scan graphs, choose Print Graph in Kinetic Graph or Scan 
respectively (refer to Section 7.4.3, Printing Graphs). 
To print Raw Data or Curve Info: 
1. In Raw Data or Raw Data Scan, choose Print Raw Data. 
OR 
In Curve Info, choose Print. Print appears (Figure 7-41). 
Note: Curve Info data tables may also be printed by right-clicking on 
a table within the Curve Info tab. 
Figure 7-41. Print 
2. In Printer, select the desired printer to print the information. All printers that are 
properly installed and configured on the computer are listed. 
3. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
4. Choose OK to print the raw data. 
Note: If the selected printer is configured to print to a file, such as an Acrobat® PDF 
(*.pdf), a prompt asking for the filename appears. The printed file is saved to the 
ADAP software home directory. 
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7.4.2.1 Printing Curve Info Data Tables 
Measurement results displayed in Curve Info tables may be printed using the print 
options built into the Curve Info tab (Figure 7-42). 
Figure 7-42. Curve Info print options 
To print complete tables: 
1. Right click on a results table. A menu with print, copy, and text file options 
appears (Figure 7-42). 
2. Choose a printing option: 
• Print this Table — Prints only the table right-clicked on. 
• Print all Tables — Prints both tables. 
Note: Print all Tables is available only in the ADAP Prisma 
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Software. 
3. Follow steps 2–4 in Section 7.4.2, Printing Raw Data and Curve Info, to print the 
tables. 
Curve Info 
This table appears only in the 
ADAP Prisma software. 
Print options 
Right-click on a results table 
to display print options. 
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7.4.2.2 Viewing Kinetic Raw Data Printouts 
Kinetic measurement raw data printouts display measurement results from all cycles 
sequentially for each well or cuvette sample (Figure 7-43). 
Figure 7-43. Kinetic raw data printout with three cycles (excerpt) 
Note: Wells are labeled in Row-Column format. For example, A2 represents the 
well in the first row of the second column. 
7.4.2.3 Viewing Linear Scan Raw Data Printouts 
Linear scan raw data printouts display the 25 measurement points in a column for 
each well (Figure 7-44). 
Figure 7-44. Linear scan raw data printout (excerpt) 
Note: Wells are labeled in Row-Column format. For example, A2 represents the 
well in the first row of the second column on the plate. 
Measurement points 
for well A2 
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7.4.2.4 Viewing Area Scan Raw Data Printouts 
Area scan raw data printouts display the measurement points for each well in a matrix 
that represents the layout of the measurement points (Figure 7-43). 
Figure 7-45. Area scan raw data printout (excerpt) 
Note: Wells are labeled in Row-Column format. For example, A2 represents the 
well in the first row of the second column. 
7.4.2.5 Viewing Curve Info Printouts 
Curve Info printouts for multiwavelength, spectral scan, and linear scan 
measurement results present data in the same column format displayed when viewing 
Curve Info onscreen. 
Note: The ADAP Prisma software is required to print Curve Info other than OD and 
transmission results. 
Figure 7-46. Curve Info printout for a 
multiwavelength measurement (ADAP Prisma excerpt) 
Peak, valley, and slope data 
is available only with a valid 
ADAP Prisma license. 
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7.4.3 Printing Graphs 
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Measurement result graphs can be printed from all Graphic tabs. 
To print a graph: 
1. Choose Print Graph. Print appears (Figure 7-47). 
Note: When Print Graph is chosen from a Graphic tab displaying the 
results for an individual sample, graphs for all measured samples are 
printed. 
Figure 7-47. Print 
2. In Printer, select the desired printer to use to print the information. All printers 
that are properly installed and configured on the computer are listed. 
3. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
4. Choose OK to print the information. 
Note: If the selected printer is configured to print to a file, such as an 
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The 
printed file is saved to the ADAP software home directory. 
Note: Kinetic graphs can also be printed with OD, Reduced Data, Transmission, 
and Status information by choosing Print from the Setup menu or toolbar (refer to 
Section 7.4.1, Printing General Measurement Results). 
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7.4.3.1 Viewing Kinetic Graph Printouts 
Kinetic graph printouts display kinetic graphs for all measured wells or cuvette 
samples (Figure 7-48). 
Figure 7-48. Kinetic graph printout (excerpt) 
Note: Wells are labeled in Row-Column format. For example, C2 represents the 
well in the third row of the second column. 
7.4.3.2 Viewing Linear Scan Graph Printouts 
Linear scan graph printouts display linear scan graphs for all measured wells on the 
plate. (Figure 7-49). 
Figure 7-49. Linear scan graph printout (excerpt) 
Note: Wells are labeled in Row-Column format. For example, C2 represents the 
well in the third row of the second column. 
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7.4.3.3 Viewing Area Scan Graph Printouts 
Area scan graph printouts display area scan graphs for all measured wells on the plate 
(Figure 7-50). 
Figure 7-50. Area scan graph printout (excerpt) 
Note: Well labels are not printed in area scan graph printouts. However, the layout 
matches the Row-Column format used by kinetic and linear scan graph printouts, so 
the well in the third row of the second column is C2. 
W Well C2 
W Well A1 
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7.5 Exporting Quick Measurement Results to Other 
Applications 
Quick measurement results can be exported to other applications for further analysis 
or manipulation. The ADAP software provides two methods to export data: 
• Data can be copied and pasted into another application such as a word 
processor (refer to Section 7.5.1, Copying and Pasting Measurement Results 
Into Another Application). 
• Data can be saved to a text file and then opened by or imported into another 
application (refer to Section 7.5.2, Saving Measurement Results as Text 
Files). 
7.5.1 Copying and Pasting Measurement Results 
Into Another Application 
Measurement results displayed in any tab can be copied to the clipboard. These 
results can then be pasted into another application for storage or further analysis. 
Note: For example, data from the ADAP software could be pasted into a spreadsheet 
with formulas or macros already configured to perform preliminary analysis on 
measurement results data. 
Note: The Curve Info tab for multiwavelength, spectral scan, and linear scan 
measurements includes additional options for copying data (refer to Section 7.5.1.1, 
Copying and Pasting Curve Info Results Into Another Application). 
To copy measurement results to the clipboard: 
1. Select the desired results tab to copy to the clipboard. 
2. From the Options menu, choose Copy displayed data into clipboard to 
copy only the displayed results to the clipboard. 
OR 
Choose Copy displayed data into clipboard from the toolbar. 
OR 
From the Options menu, choose Copy all data into clipboard to copy all 
results from a kinetic or scan measurement to the clipboard. 
Note: When copying Raw Data, choosing Copy displayed data 
into clipboard copies only the cycle or well displayed. To copy raw 
data results for all cycles or wells measured, choose Copy all data 
into clipboard. 
3. Open or switch to the application where the measurement results will be pasted. 
4. Paste the measurement results into a new or existing file using the Paste 
command for the application. 
Note: Most applications have CTRL+V assigned as the Paste 
command keyboard shortcut. 
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7.5.1.1 Copying and Pasting Curve Info Results Into 
Another Application 
Measurement results displayed in Curve Info tables may be copied and pasted using 
the copy options built into the Curve Info tab (Figure 7-51). 
Figure 7-51. Curve Info copy options 
To copy complete tables into another application: 
1. Right click on a results table. A menu with print, copy, and text file options 
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appears (Figure 7-51). 
2. Choose a copy option: 
• Copy this Table — Copies all data in the table clicked on to the 
clipboard. 
• Copy all Tables — Copies all data from both tables to the clipboard. 
Note: Copy all Tables is available only in the ADAP 
Prisma Software. 
3. Open or switch to the application where the measurement results will be pasted. 
4. Paste the measurement results into a new or existing file using the Paste 
command for the application. 
Note: Most applications have CTRL+V assigned as the Paste 
command keyboard shortcut. 
Curve Info 
This table appears only in the 
ADAP Prisma software. 
Copy options 
Right-click on a results table 
to display copy options. 
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To copy selected data from a table into another application: 
1. Click and drag over the table data desired to copy. The selected data is 
highlighted. 
2. Right click on a results table. A menu with print, copy, and text file options 
appears (Figure 7-51). 
3. Choose Copy Selection. The selected data is copied to the clipboard. 
4. Open or switch to the application where the measurement results will be pasted. 
5. Paste the measurement results into a new or existing file using the Paste 
command for the application. 
Note: Most applications have CTRL+V assigned as the Paste 
command keyboard shortcut. 
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7.5.2 Saving Measurement Results as Text Files 
Measurement results can be saved as text files which can be viewed in any text editor 
or imported into many statistical software packages or spreadsheet applications. 
Note: Table data in the Curve Info tab for multiwavelength, spectral scan, and linear 
scan measurements can be saved to a text file from within the Curve Info tab (refer to 
Section 7.5.2.1, Saving Curve Info Table Data as a Text File). 
To save measurement results to a text file: 
1. Select the desired results tab to save as a text file. 
2. From the Options menu, choose Save displayed data as TXT to save only 
the displayed results as a text file. 
OR 
From the Options menu, choose Save all data as TXT to save all 
measurement results as one text file. 
Note: When saving Raw Data to a text file, choosing Save 
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displayed data as TXT copies only the cycle or well displayed. To 
save raw data results for all cycles or wells measured, choose Save all 
data as TXT. 
3. Save As appears. Browse to the desired location to save the data. 
Note: If the ADAP software is configured in Setup-System to automatically save 
measurement results as text files, these files may also be opened in a text editor or 
other application. Refer to Section 3.3, Configuring System Settings for information 
about configuring the ADAP software to automatically save measurement results as 
text files. 
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7.5.2.1 Saving Curve Info Table Data as a Text File 
Table data in the Curve Info tab for multiwavelength, spectral scan, and linear scan 
measurements can be saved to a text file within the Curve Info tab. 
To save table data as a test file: 
1. Right click on a results table. A menu with print, copy, and text file options 
appears (Figure 7-51). 
2. Choose Save all Tables as TXT. Save As appears (Figure 7-52). 
Figure 7-52. Save As 
3. Browse to the desired location to save the text file. 
4. Enter a File name for the text file. 
5. Choose Save to save the file. 
OR 
Choose Cancel to return to the ADAP software without saving the curve info 
data as a text file. 
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8 Defining and Running Tests In 
the ELISA Module 
8.1 Overview 
Note: A valid license code for the ADAP Prisma software is required to access the 
functions covered in this chapter. Refer to Section 1.3, Launching the ADAP Software 
for information about license codes. 
Tests are protocols for performing and evaluating measurements using the Zenyth 
200. Tests offer more robust programming and evaluation options than Quick 
measurements, and may be saved and modified. 
Depending on the desired application, test protocols are defined using either the 
ELISA or Quantitation module (refer to Section 8.1.1, Choosing the Appropriate 
Module For Configuring Test Parameters). 
The ELISA module provides options to: 
• Define new tests (refer to Section 8.2, Defining New Tests In the ELISA 
Module). 
• Save new tests (refer to Section 8.3, Saving Test Definitions). 
• Run existing tests (refer to Section 8.4, Running Existing Tests). 
• Edit, copy, or delete test definitions (refer to Section 8.5, Editing, Copying, 
and Deleting Tests). 
• Print test definition parameters (refer to Section 8.6, Printing Test 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

Definitions). 
Note: Tests may be performed by all authorized users; however, tests may only be 
defined, edited, and deleted by Level 2 (administrator) and Level 3 (system 
administrator) users (refer to Chapter 2, User Login and System Administration). 
8-2 Defining and Running Tests In the ELISA Module 
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8.1.1 Choosing the Appropriate Module For 
Configuring Test Parameters 
Test protocols may be defined in either the ELISA or Quantitation module. While 
some functionality is common to both modules, test definition parameters should be 
configured using the module that best meets the requirements of the test. 
Choose the ELISA module to define tests that: 
• Perform qualitative evaluations using cutoff formulas (refer to Section 8.2.4, 
Configuring Qualitative Evaluations). 
• Use replicate rejection and/or validation formulas to determine the final 
measurement value (refer to Section 8.2.8, Programming Rejection/ 
Validation Formulas). 
• Can be run in multitest assays (refer to Chapter 9, Defining and Running 
Multitest Assays In the ELISA Module). 
Choose the Quantitation module to: 
• Quickly and easily define endpoint and kinetic tests that perform 
quantitative evaluations (refer to Section 10.2, Defining New Tests In the 
Quantitation Module). 
• Define spectral scan measurements (refer to Section 10.2.2, Configuring an 
Endpoint Photometric Test). 
• Perform preconfigured assays on cuvette samples (refer to Chapter 12, 
Running Cuvette Applications). 
Note: This chapter covers defining test protocols in the ELISA module. Refer to 
Chapter 10, Defining and Running Tests In the Quantitation Module, for information 
about using the Quantitation module to configure test definition parameters. 
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8.2 Defining New Tests In the ELISA Module 
Test definitions configured in the ELISA module dictate how the Zenyth 200 
performs measurements and interprets the resulting data. Tests are defined using a set 
of tabs that configure different categories of parameters. 
To define a new test: 
• Configure the options in Define Layout to select the sample format: 
microplate or cuvette, and configure the use of standards, blanks, controls, 
replicates, and samples in the test (refer to Section 8.2.1, Choosing the 
Sample Format and Configuring Sample Options). 
• Configure the options in the General tab to define basic information about 
the test, including name, instrument, shaking, measurement filters, and 
variables (refer to Section 8.2.2, Configuring General Options). 
After configuring the sample format and options in the General tab, use the 
remaining tabs to configure the appropriate options for the desired measurement type. 
• Quantitative — Configures standard curve data (refer to Section 8.2.3, 
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Configuring Quantitative Evaluations). 
Note: Quantitative evaluations configured in the ELISA module 
may use standard curves imported from previously-defined tests 
and multiplication factors. These options are not available in the 
Quantitation module. 
• Qualitative — Configures cutoff groups and formulas (refer to Section 
8.2.4, Configuring Qualitative Evaluations). 
• Options — Configures measurement results printing options and tools for 
test evaluation (refer to Section 8.2.5, Configuring Test Options). 
• Kinetic — Configures kinetic measurement parameters (refer to Section 
8.2.7, Configuring Scan Measurements). 
• Scan — Configures linear and area scan measurement parameters (refer to 
Section 8.2.7, Configuring Scan Measurements). 
Note: Linear scans configured in the ELISA module have 
more advanced options available than those configured in the 
Quantitation module. 
• Rejection/Validation — Programs replicate elimination and test validation 
formulas (refer to Section 8.2.8, Programming Rejection/Validation 
Formulas). 
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To open the ELISA module test definition configuration: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to Elisa, if 
necessary. 
2. From the Setup menu, choose Test Definition. 
OR 
From the toolbar, choose Create/Edit Calculation. The ELISA test definition 
configuration appears with the General tab open (Figure 8-1). 
Figure 8-1. ELISA module test definition configuration — General tab 
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8.2.1 Choosing the Sample Format and 
Configuring Sample Options 
The Zenyth 200 is capable of performing test measurements on microplate and 
cuvette samples. The sample format selected for a new test definition affects which 
test options are available in the configuration tabs. For example, scan measurements 
may only be performed on microplate samples. For this reason, the sample format and 
options should be configured before the options available in the other tabs. 
Microplate and cuvette parameters are configured in Define Layout, which is divided 
into four sections: 
• Options — Configures sample format parameters including plate type, strip 
use, filling direction, replicates, and well labeling format (refer to Section 
8.2.1.1, Configuring Sample Format Parameters). 
• Control-Position — Configures the type and label numbering applied to 
samples measured during the test (refer to Section 8.2.1.2, Configuring Well 
or Cuvette Types and Labels in Control-Position). 
• Plate Layout — Defines the location of standard, control, blank, and 
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sample wells on the plate. With cuvettes, defines the label of each cuvette 
measured (refer to Section 8.2.1.3, Defining Sample Location in Plate 
Layout). 
• Factor — Configures multiplication factors for samples (refer to Section 
8.2.1.4, Entering Multiplication Factors for Samples). 
To open Define Layout: 
In the ELISA module test definition configuration, choose Layout. 
OR 
In the General tab, under Test Name, choose Edit/Define Layout. Define 
Layout appears (Figure 8-2). 
Figure 8-2. Define Layout (microplate) 
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8.2.1.1 Configuring Sample Format Parameters 
Options configures sample format parameters including plate type, strip use, filling 
direction, replicates, and well labeling format. 
To configure plate parameters, in Options: 
1. In Plate Type, choose CUVETTE, or the type of microplate used in the test. 
2. In CAG-Strips, select the location of control antigen strips if they are used in the 
test. CAG wells are assigned to the plate layout: 
• No — Antigen control strips are not used. 
• 1st - Horizontal — Antigen control well is located horizontally before 
the samples. 
• 2nd - Horizontal — Antigen control well is located horizontally after 
the samples. 
• 1st - Vertical — Antigen control well is located vertically before the 
samples. 
• 2nd - Vertical — Antigen control well is located vertically after the 
samples. 
Note: When CAG-Strips is selected, the measurement of the control 
antigen well is automatically subtracted from the full antigen well. 
Note: CAG-Strips is disabled when CUVETTE is selected. 
3. In Filling Direction, select how samples are numbered based on the filling 
direction of the plate: 
• Vertical — Sample labels are numbered in ascending order column by 
column. 
• Horizontal — Sample labels are numbered in ascending order row by 
row. 
Note: Filling Direction is disabled when CUVETTE is selected. 
4. In Replicate No./Direction, select the number of replicates to be used for each 
sample, and set the filling direction of replicates: 
• Vertical — Replicate labels are numbered in ascending order column by 
column. 
• Horizontal — Replicate labels are numbered in ascending order row by 
row. 
Note: When cuvette is the selected format, Replicate No./Direction 
changes to Replicate Count. Enter the number of replicates for each 
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sample. Up to 50 samples, including replicates, can be measured in a 
test. 
5. In Well Labels, select the format of the well labels: 
• A1,A2...B1,B2. — Labels rows by letter, columns by number. 
• 1.1,1.2, 1.3...2.1,2.2, 2.3. — Labels rows and columns by number. 
Note: Well Labels is disabled when CUVETTE is selected. 
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8.2.1.2 Configuring Well or Cuvette Types and Labels in 
Control-Position 
The options in Control-Position work in conjunction with Plate Layout to configure 
well or cuvette types, label numbers, and locations of samples. Standards, controls, 
and blanks are configured using Control-Position, then placed on the plate or 
assigned to specific cuvettes using Plate Layout. 
Note: Refer to Section 8.2.1.3, Defining Sample Location in Plate Layout for 
information about defining the actual location of wells on the plate. 
To configure well or cuvette types and label numbers: 
1. In Type, select the type of wells or cuvettes to configure: 
• Standard — A well or cuvette with a known concentration used to 
develop or correct a standard curve. 
• Control — A well or cuvette with a known, expected signal used to 
verify the results of the plate. 
• Quality-Control — A control well or cuvette with a known, expected 
response value which is used to check lot-dependent variations between 
kits or reagents. 
• Positive-Control — A control well or cuvette in which a known 
amount of a target reagent is used to generate a signal that verifies 
positive results measured in sample wells. 
• Negative-Control — A control well or cuvette in which the lack of a 
target reagent produces very little or no signal, which verifies negative 
results measured in sample wells. 
• Blank — A well or cuvette that is left empty or filled only with reagents 
but no reacting sample, used to measure background noise. 
Note: The mean value of Blank samples is automatically 
subtracted from all other wells or cuvettes (refer to Section 
8.2.5.3, Configuring Blank Subtraction). 
• Sample — A well or cuvette containing a sample to measure. 
Note: The Numbers label below Type changes automatically to 
reflect the type of well chosen. 
2. In Numbers, click and drag the slider to change the well label identification 
number. 
Note: Drag the slider to the right to increase the label number, or to the 
left to reduce it. 
3. Use Plate Layout to define well locations or specific cuvettes for the configured 
Type (refer to Section 8.2.1.3, Defining Sample Location in Plate Layout). 
4. After defining well locations or specific cuvettes for the configured Type, repeat 
steps 1–3 above for each additional well type desired on the plate. 
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5. When all standards, controls, and blanks have been configured, choose Fill Plate 
With Samples to populate all remaining wells or cuvettes with samples. 
8-8 Defining and Running Tests In the ELISA Module 
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8.2.1.3 Defining Sample Location in Plate Layout 
For microplate samples, Plate Layout defines the location of standard, control, 
blank, and sample wells on the plate (Figure 8-3). Well locations may also be edited 
and deleted using the options in Plate Layout. 
Figure 8-3. Define Layout — Plate Layout tab (microplate) 
For cuvette samples, Plate Layout assigns the sample types and labels to specific 
cuvettes measured in the test (Figure 8-4). 
Figure 8-4. Define Layout — Plate Layout tab (cuvette) 
Wells selected by 
dragging mouse. 
Choosing Set actual 
column selects all 
wells in column 4. 
Choosing Set actual row 
selects all the wells in row C. 
First well 
selected. 
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To define cuvette sample types or locations on the plate for wells configured in 
Control-Position: 
1. In Plate Layout, click on the desired well or cuvette to define (Figure 8-3). 
Note: Select multiple wells or cuvettes by clicking and then dragging 
over the desired range. 
2. From the Edit menu, choose a method for selecting which wells or cuvettes will 
be defined as the type configured in Control-Position: 
OR 
Right-click on the selected well(s) or cuvette(s) and choose a method for 
selecting which wells or cuvettes will be defined as the type configured in 
Control-Position: 
• Set/De-select all wells — Populates or clears all wells on the 
microplate or all cuvette samples. 
• Set/De-select actual row — With microplates, populates or clears all 
wells in the same row as the first well selected (Figure 8-3). With 
cuvettes, populates or clears all cuvette samples. 
• Set/De-select actual column — With microplates, populates or clears 
all wells in the same column as the first well selected (Figure 8-3). With 
cuvettes, populates or clears only the first cuvette sample selected. 
• Set/De-select selected wells — Populates or clears the selected wells 
or cuvette samples. 
3. In Control-Position, configure another well Type, if desired, and repeat (refer to 
Section 8.2.1.2, Configuring Well or Cuvette Types and Labels in Control- 
Position). 
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Note: When all standards, controls, and blanks have been configured, in Control- 
Position, choose Fill Plate With Samples to populate the remaining wells or 
cuvettes with samples. 
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8.2.1.4 Entering Multiplication Factors for Samples 
Factor allows entering multiplication factors for wells on the plate or cuvette samples 
(Figure 8-5). 
Figure 8-5. Define Layout — Factor (microplate) 
To enter multiplication factors: 
1. Choose Factor. 
2. Select a well or cuvette and enter numerical value for the Factor (Figure 8-5). 
Note: Select multiple wells or cuvettes by clicking and dragging over 
the desired range. When a new factor is entered for the first well or 
cuvette selected, all selected wells or cuvettes are assigned the new 
factor. 
3. Repeat the previous step for all wells or cuvettes desired. 
Note: F can be entered in transformation formulas and refers to the individual 
multiplication factor for each well position entered in Factor. F is typically used in 
quantitative transformation formulas to correct the concentration of samples for their 
dilution factor; for example, X’ = X * F. 
First well selected with 
new Factor entered. 
Selected group of wells 
with new Factor. 
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8.2.1.5 Completing the Sample Layout 
When all parameters are configured and samples defined, save and close Define 
Layout and return to the ELISA test definition configuration to continue configuring 
the test definition. 
To close Define Layout: 
From the File menu, choose End to close Define Layout and save the new plate 
or cuvette parameters. 
OR 
From the File menu, choose Cancel to close Define Layout without saving the 
new plate or cuvette parameters. 
Note: In the File menu, Print and Open perform their respective functions on the 
complete test definition, not Define Layout, and may not be accessible if the test 
definition is not completely configured. 
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8.2.2 Configuring General Options 
The General tab provides options to set up the basic parameters of a test definition, 
including name, instrument type, shaking, measurement filters, and variables. 
Figure 8-6. ELISA module test definition configuration — General tab 
1. In Test Name, enter a name for the test. 
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Note: Test names are limited to 20 characters in length. 
2. In Instrument, select the instrument to be used to perform the test. 
Note: The type and serial number of the instrument currently 
connected or used in the previous test is automatically selected. The 
instrument setting only needs to be selected manually if a different 
instrument will be used to perform the test currently being defined. 
3. In Data Transfer Mode, if desired, select how measurement results are 
transferred from the instrument to computer: 
• Plate — Transfers data for the entire plate at one time. 
• Row — Transfers data one row at a time. 
• Well — Transfers data one well at a time. 
Note: Selecting a Data Transfer Mode is not required for cuvette 
measurements. When reading microplates or cuvette samples, the 
ADAP software automatically chooses the mode that is most applicable 
to the type of measurement being performed. 
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4. In Lot# , if desired, enter the lot number of any reagent or kits being used in the 
test and select Yes if the concentration is lot-number dependent. 
5. In Shaking, if desired, select Yes to shake the plate before the measurement is 
made. 
Note: Shaking is only available for microplate measurements, and is 
disabled when performing measurements on cuvette samples. 
Note: In kinetic measurements, the plate is shaken before each 
measurement cycle. 
6. If Shaking is selected, in Time, select the number of seconds to shake. 
7. If Shaking is selected, select Low, Medium, or High shaking intensity. 
8. In Measurement Filter, select the desired measurement wavelength. 
Note: Any wavelength within the instrument’s range of 190–1000 nm 
may be selected. 
9. To perform a bichromatic measurement, in Reference Filter, select a reference 
wavelength 
Note: When a reference filter is selected, the final measurement result 
is calculated by subtracting the reference filter measurement from that 
of the measurement filter. 
Note: If no reference filter is desired, select <-->. 
10. In Parameter, enter numeric values for up to eight variables that can be used in 
any formula defined in the test definition. 
Note: Parameter variables are typically used with test kits that have 
cutoff values or standard correction values based on lot number. 
11. In Check Variable, select Yes to display the Parameter variables after the 
measurement, but before the results are evaluated. This allows the variables to be 
changed to account for variations in lot-dependent reagents. 
Note: Changes made to Parameter variables during a test run are 
automatically saved in the test definition. 
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8.2.3 Configuring Quantitative Evaluations 
Quantitative configures parameters for standard curves, concentration values, and 
response and transformation formulas. Quantitative is divided into five sections: 
• Standards — Configures concentration and response formula parameters 
for standards (refer to Section 8.2.3.1, Configuring Standards). 
• Curve — Configures standard curve fitting parameters (refer to Section 
8.2.3.2, Configuring Standard Curve Parameters). 
• Factor — Sets a multiplication factor which enables the concentration value 
to be scaled to the desired unit (refer to Section 8.2.3.3, Configuring the 
Factor). 
• Use stored Standard Curve — Loads a stored standard curve into the test 
definition (refer to Section 8.2.3.4, Opening a Stored Standard Curve). 
• Transformation — Configures a transformation formula to apply to 
concentrations (refer to Section 8.2.4.3, Configuring a Transformation 
Formula). 
To define a standard curve for a quantitative evaluation: 
Select the Quantitative tab (Figure 8-7). 
Figure 8-7. ELISA module test definition configuration — Quantitative tab 
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8.2.3.1 Configuring Standards 
Standards configures up to 10 concentration values and response formulas. 
Note: To use parameters from a saved test definition, refer to Section 8.2.3.4, 
Opening a Stored Standard Curve. 
To configure concentration values and response formulas: 
1. Under Concentration, enter the concentration value to be plotted on the 
x-axis. 
Note: For Concentration values less than 1, enter a leading 0 before 
the decimal; for example, 0.51. Values entered without the leading 0 
produce an error when the measurement is performed. 
2. Under Response Formula, enter the response formula to plot the corresponding 
concentration on the y-axis. 
Note: Response formulas may contain any controls, standards, or 
variables defined in the test, as well as any numerical constants and 
mathematical operators +,-,*,/,(,),^. Usually, the response formula is just 
the value of a measured standard and consists only of the corresponding 
name; for example S1, S2, or S3. 
Note: For Response Formula values less than 1, enter a leading 0 
before the decimal; for example, 0.51. Values entered without the 
leading 0 produce an error when the measurement is performed. 
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8.2.3.2 Configuring Standard Curve Parameters 
Curve configures new standard curve parameters. 
Note: To use standard curve parameters from a saved test definition, (refer to 
Section 8.2.3.4, Opening a Stored Standard Curve). 
1. In Curve, select the curve fit method: Point to Point, Linear Regression, 
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Cubic Spline, or 4-Parameter Fit. 
Note: Refer to Section 8.2.3.2.1, Curve Fitting Models for detailed 
information about curve fitting methods. 
2. In Axis (X/Y), select the scale to use for the X and Y axes. 
• lin/lin — Linear/Linear 
• lin/log — Linear/Logarithmic 
• log/log — Logarithmic/Logarithmic. 
3. In Extrapolation, enter a percentage value to extrapolate the standard curve 
above and below the highest and lowest standard points in the curve, if desired. 
Note: Extrapolation percentages can be used with Linear 
Regression, Cubic Spline or 4-Parameter Fit curve fitting methods. 
Note: The percentage value entered in Extrapolation can be up to 
99.9%. 
4. In Units, enter the units of measure to be displayed in the test measurement 
results. 
Note: Units are used for documentation purposes only and do not 
impact the standard curve. Units appears in Transform in the test 
measurement results window (refer to Section 11.2.3, Viewing 
Concentration Results). 
5. In Validate Curve, choose Yes or No to validate the test based on an acceptable 
coefficient of correlation. 
Note: Validate Curve is only available with the Linear Regression 
curve fitting method. 
6. If Yes is selected in Validate Curve, in Min. Correlation, enter the minimum 
correlation percentage value for the test to be valid. 
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8.2.3.2.1 Curve Fitting Models 
Table 8-1 describes the four curve fitting models supported by the ADAP software. 
Table 8-1. Curve Fitting Models 
Method Description Example 
Linear regression 
Construction of a straight line using the least 
squares method with the highest possible 
approximation to all standard points. 
Requires a minimum of 2 standard points. 
Point to Point 
Direct connection of all standard points. 
Requires a minimum of 2 standard points. 
Cubic Spline 
All standard points are connected by the best 
fitting curve. 
Note: Can only be used for nonlinear and 
nonsigmoid functions. 
Requires a minimum of 3 standard points. 
4 Parameter Fit 
This procedure can be used only to characterize 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

sigmoid curves. The curve is calculated according 
to the formula: 
a = zero dose response (upper asymptote) 
d = infinite dose response (lower asymptote) 
c = dose level which results in a response midway 
between a and d 
b = slope factor 
Requires a minimum of 4 standard points. 
yi 
(a – d) 
1 
xi 
c 

----  
b 

+ 
= --------------------------- + d 
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8.2.3.3 Configuring the Factor 
In Factor (Figure 8-7), if desired, enter a multiplication factor to enable the 
concentration value to be scaled to the desired unit. 
8.2.3.4 Opening a Stored Standard Curve 
Use stored Standard Curve permits standard curve parameters from saved test 
definitions to be loaded into the current test definition. 
To open standard curve parameters from an existing test definition: 
1. In Use stored Standard Curve, choose Yes. Selection appears 
(Figure 8-8): 
Figure 8-8. Selection — test definitions 
2. Select the desired test and choose OK. Fields in Standards and Curve are 
automatically populated with the standard curve parameters from the selected 
test. The name of the selected test appears in Use stored Standard Curve. 
Note: Selecting No after a stored standard curve has been loaded removes the test 
name from Use stored Standard Curve, but not the parameters loaded in 
Standards and Curve. Parameters in Standards and Curve must be edited or 
deleted manually. 
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8.2.3.5 Configuring a Transformation Formula 
Transformation configures transformation formulas, which, depending on 
measurement type, are used to transform measurement or reduced data (X) based on 
an algebraic formula (X'=). 
Note: X must be included in a transformation formula. 
To configure a transformation formula: 
1. Choose Yes or No to indicate whether a transformation formula will be used. 
2. If Yes is selected, in X'=, enter the transformation formula. 
Note: The formula may contain any controls, standards, or variables 
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defined in the test, any numerical constants, as well as mathematical 
operators ( ) * +, - . / ^, ABS, SQR, L, F, X, and V (refer to Section 
8.2.8.3, Logical and Mathematical Operators). 
Standards and controls are abbreviated as: S for standard, K for control, 
QC for quality control, PC for positive control, and NC for negative 
control. 
3. Select Plate, Row, or Column to define how the transformation formula is 
applied to the wells on the plate: 
• Plate — applies the transformation formula to all wells on the plate. 
• Row — applies the transformation formula to all wells in a row with a 
defined control position. 
• Column — applies the transformation formula to all wells in a column 
with a defined control position. 
Note: With cuvette samples, the transformation formula is applied to 
all cuvettes measured in the test. 
4. In Units, enter the units of measure to be displayed in the Test measurement 
results. 
Note: Units are used for documentation purposes only and do not 
impact the standard curve. Units appears in Transform in the test 
measurement results window (refer to Section 11.2.3, Viewing 
Concentration Results). 
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8.2.4 Configuring Qualitative Evaluations 
Qualitative configures qualitative evaluations that classify measured samples 
according to defined cutoff values. Up to five groups of samples may be classified 
using cutoff formulas. Qualitative is divided into three sections: 
• Groups — Defines sample group names and cutoff formulas (refer to 
Section 8.2.4.1, Configuring Groups and Cutoff Formulas). 
• Factor — Sets a multiplication factor that enables the measurement value to 
be scaled to the desired unit (refer to Section 8.2.4.2, Configuring the 
Factor). 
• Transformation — Configures a transformation formula to apply to raw 
data (refer to Section 8.2.4.3, Configuring a Transformation Formula). 
To configure qualitative evaluation options: 
Select the Qualitative tab (Figure 8-9). 
Figure 8-9. ELISA module test definition configuration — Qualitative tab 
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8.2.4.1 Configuring Groups and Cutoff Formulas 
Groups defines group names and cutoff formulas to separate them. Up to five group 
names and four cutoff formulas may be defined. 
1. In Group 1 – Group 5, enter names for the groups to be separated by the cutoff 
formulas. 
2. In Cutoff Formula 1 – Cutoff Formula 4, enter the cutoff formulas that separate 
the samples into groups. 
Note: Each cutoff formula may be defined as one of the well types 
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defined on the plate or as a mathematical formula. The result of the 
formula is then used as the related cutoff value. 
3. In Interpretation, select the basis for the cutoff calculation: OD (Optical 
Density), Concentration, Transformation, or Transf. (Conc). 
Note: Transformation refers to the result of the qualitative 
transformation formula based on measurement values. Transf. (Conc) 
refers to the result of the quantitative transformation formula based on 
concentrations. 
8.2.4.2 Configuring the Factor 
In Factor, if desired, enter a multiplication factor to enable the measurement value to 
be scaled to the desired unit. 
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8.2.4.3 Configuring a Transformation Formula 
Transformation configures transformation formulas, which, depending on 
measurement type, are used to transform measurement or reduced data (X) based on 
an algebraic formula (X'=). 
Note: X must be included in a transformation formula. 
To configure a transformation formula: 
1. Select Yes or No to indicate whether a transformation formula will be used. 
2. If Yes is selected, in X'=, enter the transformation formula. 
Note: The formula may contain any controls, standards, or variables 
defined in the test, any numerical constants, as well as mathematical 
operators ( ) * +, - . / ^, ABS, SQR, L, F, X, and V (refer to Section 
8.2.8.3, Logical and Mathematical Operators). 
Standards and controls are abbreviated as: S for standard, K for control, 
QC for quality control, PC for positive control, and NC for negative 
control. 
3. Select Plate, Row, or Column to define how the transformation formula is 
applied to the wells on the plate: 
• Plate — applies the transformation formula to all wells on the plate. 
• Row — applies the transformation formula to all wells in a row with a 
defined control position. 
• Column — applies the transformation formula to all wells in a column 
with a defined control position. 
Note: With cuvette samples, the transformation formula is applied to 
all cuvettes measured in the test. 
4. In Units, enter the units of measure to be displayed in the test measurement 
results. 
Note: Units are used for documentation purposes only and do not 
impact the standard curve. Units appears in Transform in the test 
measurement results window (refer to Section 11.2.2, Viewing 
Transformation Formula Results). 
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8.2.5 Configuring Test Options 
Options is divided into four sections that configure replicates, printing, validating 
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blanks, and evaluating controls: 
• Replicate Mean Values — Configures how mean values for replicates are 
calculated (refer to Section 8.2.5.1, Configuring Replicate Mean Values). 
• Print Options — Configures how test measurement results reports are 
formatted (refer to Section 8.2.5.2, Configuring Print Options). 
• Blank Validation — Configures where the mean value of blanks is to be 
applied (refer to Section 8.2.5.3, Configuring Blank Subtraction). 
• Evaluate Controls — Configures how standards and controls are evaluated 
(refer to Section 8.2.5.4, Configuring Evaluate Controls). 
To configure test options: 
Select the Options tab (Figure 8-10). 
Figure 8-10. ELISA module test definition configuration — Options tab 
8-24 Defining and Running Tests In the ELISA Module 
Anthos Labtec Instruments GmbH 
8.2.5.1 Configuring Replicate Mean Values 
Replicate Mean Values configures how mean values for replicates are calculated. 
To select where replicate mean values are calculated: 
Select the mean calculation method: 
• Plate — Applies the mean calculation to all replicates of a sample or 
standard across the plate, regardless of well location. 
• Row — Applies the mean calculation to replicates of a sample or 
standard located within an individual row. 
• Column — Applies the mean calculation to replicates of a sample or 
standard located within an individual column. 
• none — Turns the mean calculation off. The first value of the replicate 
group is used for further calculation. 
Note: In none, the first value of the replicate group refers to 
the left most or uppermost replicate in the group. 
Note: With cuvette samples, the mean calculation method is applied to 
all cuvettes measured in the test. 
Note: Test results display the mean value in the first replicate position based on 
filling direction. 
Note: If the selected mean calculation does not correspond to the defined replicate 
order, no mean calculation is performed (refer to Section 8.2.1.1, Configuring Sample 
Format Parameters). 
8.2.5.2 Configuring Print Options 
Print Options configures how test measurement results reports are formatted and 
which test measurement results they include. 
1. Select how the test results are formatted on the page: Table, Matrix, or both. 
2. Select the measurement data to be printed as part of a test report after a test 
measurement is completed. 
8.2.5.3 Configuring Blank Subtraction 
Blank Subtraction configures where the mean value of blanks is applied. 
Select how mean values are applied: 
• Plate — Across the entire plate. 
• Row — Only within the row containing the blanks. 
• Column — Only within the column containing the blanks. 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

Note: With cuvette samples, the mean value of blanks are applied to all 
samples measured. 
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8.2.5.4 Configuring Evaluate Controls 
Evaluate Controls configures whether standards and controls are evaluated using 
quantitative or qualitative methods. 
For each type of standard or control, select the evaluation method: Quantitative 
or Qualitative. 
Note: In Options, standards and controls are abbreviated as: S for standard, K for 
control, QC for quality control, PC for positive control, and NC for negative control. 
8.2.6 Configuring Kinetic Photometric 
Measurements 
A kinetic photometric measurement performs a specified number of measurements 
for each selected well on a microplate. The final result of a kinetic measurement is 
produced by a specified data reduction method. Kinetic is divided into two sections: 
• Kinetic Measurement — Configures the basic parameters of a kinetic 
Measurement (refer to Section 8.2.6.1, Configuring a Kinetic Measurement). 
• Parameter — Selects and configures the data reduction method (refer to 
Section 8.2.6.2, Configuring Data Reduction Parameters). 
To configure a kinetic photometric measurement: 
Select the Kinetic tab (Figure 8-11). 
Note: Additional configuration options in Parameter are enabled only 
as needed by the Data Reduction method chosen. 
Figure 8-11. ELISA module test definition configuration — Kinetic tab 
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8.2.6.1 Configuring a Kinetic Measurement 
The options in Kinetic Measurement configure the basic parameters of a kinetic 
measurement. 
1. In Kinetic Measurement, select Yes to perform a kinetic measurement. 
2. In Cycles, enter then number of times each well will be measured. 
3. In Interval, enter the length of time, in seconds, between each measurement of 
the same well. 
4. In Temperature, set the internal instrument temperature, if desired. 
Note: Temperature may only be set for microplate measurements. 
8.2.6.2 Configuring Data Reduction Parameters 
Parameters selects and configures the data reduction method used to calculate the 
results of a kinetic measurement. The ADAP software supports 12 data reduction 
methods (see Table 8-2). 
To select and configure a data reduction method: 
1. In Data Reduction, select the method of data reduction. 
Note: Depending on the data reduction method selected, additional 
parameters may need to be configured using the four options displayed 
below Data Reduction. Refer to Table 8-2 for the additional 
configuration requirements of each data reduction method. 
2. Configure the parameters required by the data reduction method. 
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Table 8-2. Data Reduction Methods 
Data Reduction Method Description Additional 
Configuration 
Average Slope 
Determines the average slope of the reaction curve by 
calculating the average of all linear regressions 
calculated over each group of Smoothing Points in the 
kinetic reading sequence. A decreasing slope shows a 
decline. 
Smoothing Points 
Delta OD Difference between the first and last kinetic 
measurements in optical density (OD). N/A 
Delta OD — Max. Slope 
Difference in OD between the first measurement and the 
center point of the maximum slope. 
Note: The center point of the maximum slope is 
calculated by determining the center point between the 
smoothing points of the regression line with the 
maximum slope. 
Smoothing Points 
Delta Time — Absolute Time elapsed from one preselected OD value to another. Lower 
Limit 
Upper Limit 
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Delta Time — Max. Slope 
Time difference in seconds between the first 
measurement and the occurrence of the center point of 
the maximum slope. 
Note: The center point of the maximum slope is 
calculated by determining the center point between the 
smoothing points of the regression line with the 
maximum slope. 
Smoothing Points 
Delta Time — Relative 
Time elapsed in seconds from the first measurement to 
reaching a set increase/decrease amount from the first 
OD measurement. 
In-/Decrease 
Maximum Declining Slope 
Determines the maximum declining rate of the reaction 
curve by calculating a linear regression over each group 
of Smoothing Points in the kinetic reading sequence. 
Smoothing Points 
Maximum Inclining Slope 
Determines the maximum inclining rate of the reaction 
curve by calculating a linear regression over each group 
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of Smoothing Points in the kinetic reading sequence. 
Smoothing Points 
Maximum Slope 
Maximum slope of the curve in OD/min. The line with 
the highest slope is calculated. Also the maximum 
reaction speed. 
Note: The accuracy of this calculation depends on the 
number of measurement cycles selected. 
Smoothing Points 
Mean Determines the mean value per sample within a 
sequence of measurements. N/A 
Time Peak Value Used to detect the time elapsed until the peak value is 
reached. Smoothing Points 
Peak Value Used to detect the highest value per sample within a 
sequence of measurements. Smoothing Points 
Table 8-2. Data Reduction Methods 
Data Reduction Method Description Additional 
Configuration 
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8.2.7 Configuring Scan Measurements 
Linear and area scan measurements may be performed on microplate samples. A scan 
measurement makes a series of measurements at defined points within a well. Three 
types of scan measurements may be configured in the ELISA module: 
• Normal Scan Measurement/96 Well Plate — Configures a linear scan 
with up to 25 user-defined measurement points (refer to Section 8.2.7.1, 
Configuring a Normal Scan Measurement). 
• Area Scan/6, 12, 24, 48 or 96 Well Plate — Configures an area scan with 
user-defined measurement points and resolution (refer to Section 8.2.7.2, 
Configuring an Area Scan Measurement). 
• Scan All/96 Well Plate — Configures a linear scan with 27 measurement 
points across the well (refer to Section 8.2.7.3, Configuring a Scan All 
Measurement). 
Note: Scan measurements are available only for microplate samples. The message, 
Selected Plate is not supported, appears when attempting to run a scan 
measurement on cuvette samples. 
Note: Evaluation functions such as qualitative and quantitative analysis, and 
transformation, rejection, and validation formulas are not available with scan 
measurements. Any configured evaluation functions are ignored. 
To configure a linear or area scan measurement: 
1. Define the plate layout if it has not been done (refer to Section 8.2.1, Choosing 
the Sample Format and Configuring Sample Options). 
2. Select the Scan tab (Figure 8-12). 
Figure 8-12. ELISA module test definition configuration — Scan tab 
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8.2.7.1 Configuring a Normal Scan Measurement 
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Normal Scan Measurement/96 Well Plate performs a linear scan of measurement 
points across the center of each well measured on a 96-well plate. The number and 
location of measurement points are user defined. 
To perform a Normal Scan Measurement/96 Well Plate: 
1. Select Perform normal Scan measurement. 
2. Select each measurement point to be scanned individually. 
Note: 25 measurement points are available and are labeled -12 to +12, 
with point 0 being the center of the well. 
OR 
Choose a selection option: 
• Select all automatically selects all 25 measurement points, if desired. 
• Deselect all deselects all measurement points, if desired. 
• Invert Selection selects the opposite set of measurement points from 
those currently selected. Points selected prior to choosing Invert 
Selection are deselected. 
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8.2.7.2 Configuring an Area Scan Measurement 
Area Scan Measurement/6, 12, 24, 48, 96 Well Plate performs an area scan of 
measurement points arranged in grid across the well. The distance between and 
number of measurement points are user-defined. Area scan measurements may be 
performed on 6-, 12-, 24-, 48-, and 96-well plates. 
Note: The plate format must be defined in Define Plate before configuring an area 
scan measurement (refer to Section 8.2.1, Choosing the Sample Format and 
Configuring Sample Options). 
To perform an Area Scan Measurement/6, 12, 24, 48, 96 Well Plate: 
1. Select Perform Area Scan Measurement. 
2. In Points (Height and Width), select the number of measurement points. 
Note: The number of points selected in Points defines how many 
points will be measured both vertically and horizontally; for example 
choosing 6 means that 36 measurement points will be laid out in a 6 x 6 
grid across the well. 
The number of point selections available depends upon the plate format 
selected in the plate layout. 12-well plates have a resolution of about 
20 x 20 points; 24-well plates about 14 x 14; 96-well plates about 8 x 8. 
The exact resolution depends on plate type. 
3. In Resolution, select the resolution, or space, between each measurement point. 
The highest resolution value is 1, where the distance between measurement 
points is the smallest. 
Note: Well displays the layout and resolution of measurement points 
currently selected. Reducing resolution maintains the same coverage, 
but spaces fewer measurement points further apart; increasing 
resolution adds measurement points to the same coverage area. 
8.2.7.3 Configuring a Scan All Measurement 
Scan All Measurement performs a linear scan of 27 measurement points across the 
center of each well measured on a 96-well plate. 
To perform a Scan All Measurement: 
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Select Perform Scan All Measurement. 
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8.2.8 Programming Rejection/Validation 
Formulas 
Formulas programmed in Rejection/Validation are used to reject replicates or 
invalidate tests that do not meet certain conditions. After the first replicate 
elimination, the mean value of the remaining replicates is recalculated and the 
condition re-evaluated. If necessary, the elimination cycle is repeated. If a minimum 
number of replicates is still available, the test is considered valid. If not, the test is 
marked invalid on the printout. 
Note: Refer to Section 8.2.8.1.1, Replicate Rejection Examples and Section 
8.2.8.2.1, Test Validation Examples for examples of rejection and validation formulas. 
Rejection/Validation is divided into two sections: 
• Replicate Rejection — Programs up to 12 replicate rejection formulas 
(refer to Section 8.2.8.1, Programming Replicate Rejection Formulas). 
• Validation — Programs up to 12 validation formulas for tests (refer to 
Section 8.2.8.2, Programming Test Validation Formulas). 
To program replicate rejection or test validation formulas: 
Select the Rejection/Validation tab (Figure 8-13). 
Figure 8-13. ELISA module test definition configuration — Rejection/Validation tab 
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8.2.8.1 Programming Replicate Rejection Formulas 
Replicate rejection formulas eliminate individual replicates which do not fulfill 
conditions defined in the formula. 
To program replicate rejection formulas: 
1. In Name, enter the type of well to be evaluated by the formula; for example PC1 
for wells designated as positive controls. 
Note: Well types entered in Name should match those configured in 
Define Layout (refer to Section 8.2.1, Choosing the Sample Format 
and Configuring Sample Options). 
2. In Formula, enter the replicate rejection formula used to evaluate the replicates. 
Note: The original measurement value, X, must be used in the 
replicate rejection formula. 
Note: Refer to Section 8.2.8.1.1, Replicate Rejection Examples for 
examples of replicate rejection formulas. 
Note: Replicate rejection formulas may contain any controls, 
standards, or variables defined in the test, any numerical constants, 
mathematical operators ( +,-,*,/,(,),^, <=, >=, = ), and the additional 
mathematical and logical operators listed in Table 8-3. 
3. In Min. Repl. (Minimum Replicates), enter the minimum number of replicates 
that must be left after elimination for the test to remain valid. 
Note: If, after elimination, the minimum number of replicates for a 
well type is not met, the test is marked Invalid. 
4. In Base, select the basis for the evaluation: 
• OD — The raw data. 
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• Transformation — Calculated using the transformation formula configured 
in Qualitative to operate on the raw data (refer to Section 8.2.4, Configuring 
Qualitative Evaluations). 
• Concentration — Calculated using the standard curve configured in 
Quantitative (refer to Section 8.2.3, Configuring Quantitative Evaluations). 
5. Repeat steps, 2 – 4 to program additional replicate rejection formulas. 
Note: A total of 12 replicate rejection formulas may be entered at one 
time. 
6. Choose Replicate Rejection 7 - 12 to toggle back and forth between formulas 
1–6 and 7–12. 
Note: When replicate rejection formulas 7 – 12 are displayed, 
Replicate Rejection 7 - 12 is named Replicate Rejection 1 - 6. 
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8.2.8.1.1 Replicate Rejection Examples 
Table 8-3 illustrates several practical applications where replicate rejection formulas 
are used. All examples use the measurement data as the Base for the evaluation of 
formulas. The Replicate Rejection formula is applied to all wells of the type 
specified in Name when evaluating replicates. 
Note: In replicate rejection formulas, the variable X can be used to refer to the 
individual replicates of the control specified by Name. The name itself refers to the 
mean value of currently valid replicates. Both may be used in the same formula. 
Table 8-3. Example replicate rejection formulas 
Application Name Replicate Rejection Formula 
The absorption of a blank well may not exceed 0.020 OD. BL X<=0.02 
The absorption of each negative control well NC1 must be 
less than or equal to 0.150 OD. NC1 X<=0.15 
Each standard well S1 must not deviate from the mean 
value of all standard wells S1 by more than 20%. S1 S1*0.8<X<S1*1.2 
The absorption of each negative control well NC1 must be 
less than 0.200 OD. Additionally, they must not deviate 
from the mean value of all negative control wells NC1 by 
more than 30%. 
NC1 X<0.2 AND 0.7*NC1<X<1.3*NC1 
The absorption of each positive control well PC1 must be 
greater than the mean value of the first two standard wells 
(S1 and S2) and less than the mean value of the last two 
standard wells (S3 and S4). 
PC1 (S1+S2)*0.5<X<(S3+S4)*0.5 
This formula uses the logical operator, AND, to examine 
each individual replicate of PC1 to find if it is smaller than 
the mean plus 10% and if it is bigger than the mean minus 
10%. 
PC 1 X<PC1*1.1 AND X>PC1*.09 
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8.2.8.2 Programming Test Validation Formulas 
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Test validation formulas invalidate tests that do not meet certain conditions. 
To program test validation formulas: 
1. In Formula, enter the validation formula used to evaluate the test. 
Note: Refer to Section 8.2.8.2.1, Test Validation Examples for 
examples of validation formulas. 
Note: The validation formula may contain any controls, standards, or 
variables defined in the test, any numerical constants, mathematical 
operators ( +,-,*,/,(,),^, <=, >=, = ), and the additional mathematical and 
logical operators listed in Table 8-3. 
2. In Base, select the basis for the evaluation: 
• OD — The raw data. 
• Transformation — Calculated using the transformation formula 
configured in Qualitative to operate on the raw data (refer to Section 
8.2.4, Configuring Qualitative Evaluations). 
• Concentration — Calculated using the standard curve configured in 
Quantitative (refer to Section 8.2.3, Configuring Quantitative 
Evaluations). 
3. Repeat steps, 1 and 2 to program additional test validation formulas. 
Note: A total of 12 test validation formulas may be entered at one 
time. 
4. Choose Validation Formula 7 - 12 to toggle back and forth between formulas 
1–6 and 7–12. 
Note: When validation formulas 7 – 12 are displayed, Validation 
Formula 7 - 12 is named Validation Formula 1 - 6. 
8.2.8.2.1 Test Validation Examples 
Table 8-4 illustrates several practical applications using test validation formulas. All 
examples use the OD measurement data as the Base for the evaluation of formulas. 
Table 8-4. Example test validation formulas 
Application Test Validation Formula 
The test is valid only if the mean 
absorption value of the positive control 
wells PC2 is less than or equal to 0.8 OD. 
PC2<=0.8 
The test is valid only if both controls are 
within the linear range of the photometer. 0.1<=K1<=3.0 AND 0.1<=K2<=3.0 
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8.2.8.3 Logical and Mathematical Operators 
Replicate elimination and validation conditions may include any of the logical or 
mathematical operators defined in Table 8-5. 
Table 8-5. Logical and mathematical operators 
Operator Definition 
AND True if all conditions are fulfilled. 
OR True if one of more of the conditions 
are fulfilled. 
NOT True if the condition is not fulfilled. 
XOR True if exactly one of the conditions 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

is fulfilled. 
ABS Absolute value. 
POW Raises a number to the power of an 
exponent. 
SQR Returns the square root of a number. 
L Returns the natural logarithm of a 
number. 
CV CV% value of replicates 
V Variable 1 to variable 6 
F (Rejection formulas only) Well factor (dilution) 
X (Rejection formulas only) Actual well value of base (OD, 
Transformation, or Concentration) 
during calculation 
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8.3 Saving Test Definitions 
When the plate layout and all required parameters for a test definition have been 
properly configured, the test definition may be saved. Test definitions must be saved 
before measurements can be performed. 
To save a test definition and return to the main ADAP screen: 
1. From the File menu, choose Save. The test definition is saved in the database 
and may be used to run a test. 
2. From the File menu, choose End to return to the main ADAP screen. 
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8.4 Running Existing Tests 
Tests may be run as soon as they are defined and saved. All test definitions are stored 
in the ADAP software database. 
To run a test: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to Elisa, if 
necessary. 
Note: If the Elisa/Quantitation selection button is toggled to 
Quantitation, only tests defined in the Quantitation module will be 
available to run. 
2. From the Reading menu, choose Single Test. 
OR 
Choose Measure single test. Selection appears (Figure 8-14). 
Figure 8-14. Selection — test definitions 
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3. Select a test definition and choose OK. Numbers of Samples appears 
(Figure 8-15). 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 8.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
Figure 8-15. Numbers of Samples 
4. Enter the number of samples to be measured on the plate and choose OK. The 
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measurement results screen appears and the measurement procedure begins. 
After the measurement is complete, the results are displayed (refer to Chapter 11, 
Viewing Test and Multitest Assay Measurement Results). 
8.4.1 Using Matchcode to Search for Test 
Definitions Stored In the ADAP Software 
Database 
Matchcode is the search feature included in Selection. Depending on from which 
screen or tab Selection is accessed, Matchcode performs searches for test 
definitions or measurement results stored in the ADAP database. 
Matchcode provides wildcard operators, * and ?, which simplify searching by 
allowing users to search for a set of possible characters in the plate-ID name (see 
Table 8-6). 
To search for an existing test definition: 
1. From Selection, choose Matchcode. Plate-ID appears (Figure 8-16). 
Figure 8-16. Plate-ID 
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2. In Input Plate-ID, enter a plate ID or test definition name. 
Note: Input Plate-ID also refers to saved measurement results for 
cuvette samples and test definition names. 
3. Choose OK. Plate IDs or test definition names that match the search query 
appear in Selection. 
Note: If Matchcode finds no matches to the search query, choose update list to 
display the entire list of test definitions again. 
Table 8-6. Matchcode wildcard operators 
Wildcard Pattern Result 
*a* Lists all plate IDs or test definition names 
with an a in the ID or name. 
a* Lists all plate IDs or test definition names 
with an a at the beginning of the ID or name. 
*a Lists all plate IDs or test definition names 
with an a at the end of the ID or name. 
alph? Lists all plate IDs or test definition names 
with alph followed by an additional 
character. For example, alpha or alphb. 
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8.5 Editing, Copying, and Deleting Tests 
Tests stored in the database can be edited, copied, or deleted using the ADAP 
software. 
Note: Tests may edited, copied, and deleted only by Level 2 (administrator) and 
Level 3 (system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
8.5.1 Editing Tests 
Test definition parameters may be edited by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
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To edit a test stored in the ADAP software database: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to Elisa, if 
necessary. 
Note: If the Elisa/Quantitation selection button is toggled to 
Quantitation, only tests defined in the Quantitation module will be 
available to edit. 
2. From the Setup menu, choose Test Definition. 
OR 
Choose Create/Edit Calculation. The ELISA module test definition 
configuration appears (Figure 8-17). 
Figure 8-17. ELISA module test definition configuration 
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3. From the File menu, choose Open. Selection appears with a list of saved test 
definitions (Figure 8-18). 
Figure 8-18. Selection — test definitions 
4. Select a test to edit and choose OK. The chosen test definition appears. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 8.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
5. Edit the desired test definition parameters. 
Note: Refer to Section 8.2, Defining New Tests In the ELISA Module 
for detailed information about defining test definition parameters. 
6. From the File menu, choose Save. The test definition is saved in the database 
and may be used to run a test. 
7. From the File menu, choose End to return to the ELISA module test definition 
setup screen. 
Note: Refer to Section 8.3, Saving Test Definitions for more 
information about different methods of saving test definition data and 
returning to the main ADAP screen. 
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8.5.2 Copying Tests 
Test definition parameters may be copied by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
To copy a test definition: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to Elisa, if 
necessary. 
Note: If the Elisa/Quantitation selection button is toggled to 
Quantitation, only tests defined in the Quantitation module will be 
available to copy. 
2. From the Setup menu, choose Test Definition. 
OR 
Choose Create/Edit Calculation. The Eliza module test definition 
configuration appears (Figure 8-19). 
Figure 8-19. ELISA module test definition configuration 
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3. From the File menu, choose Open. Selection appears with a list of saved tests 
(Figure 8-20). 
Figure 8-20. Selection — test definitions 
4. Select a test to copy and choose OK. The chosen test definition appears. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 8.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
5. In Test Name, enter a new name for the test (Figure 8-19). 
Note: Test names are limited to 20 characters in length. 
6. From the File menu, choose Save. The test definition is saved in the database 
with the new name and may be used to run a test. 
7. From the File menu, choose End to return to the ELISA module test definition 
setup screen. 
Note: Refer to Section 8.3, Saving Test Definitions for more 
information about different methods of saving test definition data and 
returning to the main ADAP screen. 
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8.5.3 Deleting Tests 
Test definition parameters may be deleted by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
To delete a test definition: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to Elisa, if 
necessary. 
Note: If the Elisa/Quantitation selection button is toggled to 
Quantitation, only tests defined in the Quantitation module will be 
available to delete. 
2. From the Setup menu, choose Test Definition. 
OR 
Choose Create/Edit Calculation.The ELISA module test definition 
configuration appears (Figure 8-21). 
Figure 8-21. ELISA module test definition configuration 
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3. From the File menu, choose Open. Selection appears with a list of saved tests 
(Figure 8-22). 
Figure 8-22. Selection — test definitions 
4. Select a test definition(s) to delete. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 8.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
Note: To select multiple test definitions, hold Ctrl while selecting each 
test definition name. 
5. Choose Delete. Message appears (Figure 8-23). 
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Figure 8-23. Message — Delete selected Tests? 
6. Choose Yes to delete the test definition, or No to cancel the deletion and return 
to Selection. 
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8.6 Printing Test Definitions 
Test definitions may be printed out to provide a record of the test protocol. 
Note: Test definitions may be printed by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
To print a test definition: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to Elisa, if 
necessary. 
Note: If the Elisa/Quantitation selection button is toggled to 
Quantitation, only tests defined in the Quantitation module will be 
available to print. 
2. From the Setup menu, choose Test Definition. 
OR 
Choose Create/Edit Calculation. The ELISA module test definition 
configuration appears (Figure 8-24). 
Figure 8-24. ELISA module test definition configuration 
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3. From the File menu, choose Open. Selection appears with a list of saved test 
definitions (Figure 8-25). 
Figure 8-25. Selection — test definitions 
4. Select a test to be printed and choose OK. The chosen test definition appears. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 8.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
5. From the File menu, select Print. Print appears (Figure 8-26). 
Figure 8-26. Print 
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6. In Printer, select the desired printer to use to print the information. All printers 
that are properly installed and configured on the computer are listed. 
7. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
8. Choose OK print the data. 
Note: If the selected printer is configured to print to a file, such as an Acrobat® PDF 
(*.pdf), a prompt asking for the filename appears. The printed file is saved to the 
ADAP software home directory where the application, database, and support files are 
stored. 
ADAP Software for Zenyth 200 Operating Manual 
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9 Defining and Running Multitest 
Assays In the ELISA Module 
9.1 Overview 
Note: A valid license code for the ADAP Prisma software is required to access the 
functions covered in this chapter. Refer to Section 1.3, Launching the ADAP Software 
for information about license codes. 
Tests created in the ELISA module may be combined in Multitest assays. A 
Multitest assay may combine up to twelve user-selected tests, with as many as 
six tests combined on one plate. 
To define a Multitest assay, test definitions are selected, sample IDs are assigned, and 
single or multiple tests are selected to be performed on each sample ID. Based on the 
parameters of the tests selected, the ADAP software automatically creates plate 
layouts for the assay, combining tests on plates, if possible. 
Note: Multitest assays are ideal for use with commercial ELISA kits that use 
removable well strips. 
Defining and running Multitest assays includes: 
• Selecting tests to be performed (refer to Section 9.2, Defining a Multitest 
Assay). 
• Assigning sample IDs and tests to specific samples (refer to Section 9.2.2, 
Assigning Sample IDs). 
• Creating and viewing plate layouts (refer to Section 9.2.3, Creating and 
Viewing a Multitest Plate Layout). 
• Deleting Multitest configurations (refer to Section 9.3, Deleting Multitest 
Configurations). 
• Performing the Multitest assay (refer to Section 9.4, Running a Multitest 
Assay Measurement). 
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9.2 Defining a Multitest Assay 
Defining a Multitest assay is a four-step process: 
• Select up to twelve previously defined tests (refer to Section 9.2.1, Selecting 
Tests to Use in a Multitest Assay). 
• Assign sample IDs (refer to Section 9.2.2, Assigning Sample IDs). 
• Select which tests will be performed on each sample ID (refer to Section 
9.2.2.3, Selecting Tests to Perform on Sample IDs). 
• Creating and Viewing a Multitest Plate Layouts (refer to Section 9.2.3, 
Creating and Viewing a Multitest Plate Layout). 
Note: Multitest definitions are not saved to external files. Instead, all plates 
configured for a Multitest assay are saved by default after the plate layouts have been 
determined (refer to Section 9.2.3, Creating and Viewing a Multitest Plate Layout). 
To define a Multitest assay: 
From the Setup menu, choose Multitest. 
OR 
Choose Create Multitest. Multitest appears (Figure 9-1). 
Figure 9-1. Multitest assay definition 
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9.2.1 Selecting Tests to Use in a Multitest Assay 
Up to 12 previously defined tests may be selected for use in a Multitest assay. 
Selected tests are not automatically performed on every sample ID. The tests 
performed on each sample ID are selected independently. 
To select the tests to use: 
1. In Select Test, select up to 12 previously defined tests. 
Note: All existing tests in the database are available for use in multitest 
assays. 
2. For each test, select Combine to combine the tests onto one plate, if desired. 
In order for tests to be combined on a single plate, the selected tests must have the 
following test definition parameters: 
• Identical measurement and reference filters (refer to Section 8.2, Defining 
New Tests In the ELISA Module). 
• Identical plate type and filling direction (refer to Section 8.2.2, Configuring 
General Options). 
• Individual strips must also fit in the same plate frame. 
• Identical temperature settings (refer to Section 3.2.3, Setting the Instrument 
Temperature). 
Note: From the File menu, choose End or the End button to return to the ADAP 
software main screen. Tests selected for the Multitest assay are automatically saved. 
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9.2.2 Assigning Sample IDs 
Sample IDs must be assigned to wells before a Multitest assay can be performed. 
Sample IDs may be entered manually or imported from text files. 
Note: The ADAP software is capable of handling up to 32,000 sample IDs at a time. 
9.2.2.1 Entering Sample IDs Manually 
To enter sample IDs manually in a Multitest assay configuration: 
1. In Select Sample IDs, click a SampleID field and enter the sample ID (Figure 
9-2). 
Note: Sample IDs may not include spaces or exceed 20 characters in 
length. 
Figure 9-2. Multitest assay with tests selected and sample IDs assigned 
2. Repeat step 1 for as many sample IDs as desired. 
Note: Up to 32,000 sample IDs may be assigned to wells. 
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9.2.2.2 Importing Sample IDs From Text Files 
Sample IDs can be imported from text (*.txt) files. To import correctly, each sample 
ID must be listed on a separate line in the text file. 
Note: The ADAP software is capable of handling up to 32,000 sample IDs at a time. 
To import a text file: 
1. From the File menu, choose Open. 
OR 
Choose Open Sample ID File. Open appears (Figure 9-3). 
Figure 9-3. Opening a sample ID text file 
2. Browse to and select the desired sample ID text file to import, and then choose 
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Open. The list of sample IDs is imported to the Multitest assay configuration. 
9.2.2.3 Selecting Tests to Perform on Sample IDs 
After assigning sample IDs, the specific tests to perform on each must be selected. 
To select tests to perform on sample IDs: 
1. In Select Sample IDs, click the desired test selection field(s) next to each 
sample ID. An X indicates the test will be performed on the sample ID. 
Note: Deselect a specific test by clicking the X in the test selection 
field. 
A test may be selected or deselected for all sample IDs by clicking the 
test number in the header line of Select Sample IDs. 
2. Repeat until all desired tests are assigned to the desired sample IDs. 
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3. When all sample IDs and tests are configured, choose View/Make Plate 
Layout to set up and view the plate layout for the Multitest assay (refer to 
Section 9.2.3, Creating and Viewing a Multitest Plate Layout). 
Note: Choose Select Sample IDs to toggle to Sort Sample IDs (refer to Section 
9.2.2.4, Sorting Sample Sequences). 
9.2.2.4 Sorting Sample Sequences 
Sample IDs may be sorted into groups based on tests performed. 
To sort sample IDs: 
1. Choose Select Sample IDs. The mode toggles to Sort Sample IDs. 
2. Click the test number header to sort sample IDs by test performed. For example, 
choosing test 3 sorts all sample IDs on which test 3 will be performed. Sample 
IDs that meet the sort criteria are grouped to the top of the list. 
Note: Sample IDs can only be sorted by one test at a time. 
Note: Click the Sample ID column header to sort the list back into 
ascending order by Sample ID. 
Note: Choose Sort Sample IDs to toggle to Select Sample IDs (refer to Section 
9.2.2.3, Selecting Tests to Perform on Sample IDs). 
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9.2.3 Creating and Viewing a Multitest Plate 
Layout 
After sample IDs and tests have been assigned, the ADAP software needs to create 
plate layouts for the Multitest assay. If Combine is selected, multiple tests will be 
combined on a single plate, if possible (refer to Section 9.2.2.3, Selecting Tests to 
Perform on Sample IDs). To combine tests on a single plate, several test parameters, 
such as measurement filter and plate orientation, must match. If tests cannot, or are 
not selected to be combined, several plate layouts are designed for the assay. 
To create and view the Multitest plate layout: 
From Multitest, choose View/Make Plate Layout. Plate Layout appears 
(Figure 9-4). 
Figure 9-4. Plate Layout 
The Plate Layout grid displays the optimal plate layout. When tests are combined on 
a plate, each starts in a new column or row depending on the orientation set in the test 
definitions. 
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Information indicates via color and test name, which tests and samples are displayed 
in the Plate Layout grid. Two colors represent each test on the layout. The darker 
shade on the left represents samples, while the lighter shade on the right represents 
standards, controls, and blanks. 
The plate ID appears below the color key. 
Note: To optimize the use of strips, select a smaller or greater number of sample IDs 
for each test to avoid empty positions, or to rearrange the sequence of tests. 
Note: Choose OK to close Plate Layout and return to Multitest. 
Samples Standards, controls, 
and blanks 
Multitest plate ID Test names 
A Plate Layout grid 
with 4 tests 
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9.2.3.1 Viewing Additional Multitest Plate Layouts 
Multiple plates are designed for the Multitest assay when Combine is not selected, 
test parameters are incompatible, or there are more samples in the assay than can fit 
on one plate. 
To view all plates in the Multitest assay: 
Choose Next Plate to display the layout for the following plate. 
OR 
Choose Previous Plate to view the layout for the preceding plate. 
Note: Choose OK to close Plate Layout and return to Multitest. 
9.2.3.2 Printing Multitest Layout Information 
Multitest plate layout information can be printed for record-keeping purposes. To 
print the Multitest layout: 
1. Choose Print. Print appears (Figure 9-5). 
Figure 9-5. Print — Multitest layout 
2. In Printer, select the desired printer to use to print the information. All printers 
that are properly installed and configured on the computer are listed. 
3. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
4. Choose OK to print the layout information. The position and plate where each 
sample ID is located is printed. 
Note: If the selected printer is configured to print to a file, such as an 
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The 
printed file is saved to the ADAP software home directory. 
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9.3 Deleting Multitest Configurations 
The current Multitest configuration, which includes selected tests, sample IDs, and 
plate layouts, can be deleted to start a new Multitest configuration. 
Note: Multitest configurations are not saved to an external file. All plates configured 
for a Multitest assay are saved by default when the Multitest plate layout has been 
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determined. 
To delete the existing selections and layouts, 
1. Choose Delete Parameters. 
OR 
From the File menu, choose New. Message appears (Figure 9-6). 
Figure 9-6. Message — Delete current Layout 
2. Choose OK to delete the current configuration. 
OR 
Choose Cancel to return to the current configuration. 
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9.4 Running a Multitest Assay Measurement 
Once a Multitest assay has been configured and the plate layouts designed, the 
measurement can be performed. 
To perform a Multitest assay measurement: 
1. In the ADAP software main screen, from the Reading menu, choose Multitest. 
OR 
Choose Measure Multitest. Plate Selection appears (Figure 9-7). 
Figure 9-7. Plate selection 
2. Select the desired plate to measure. 
3. Choose OK to begin the measurement of all tests on the specified plate. 
Note: To manage the sometimes large number of plates designed for 
Multitest assays, select Delete Plate after Reading from List to 
delete the plate layout after the measurement has been performed. 
OR 
Choose Cancel to return to the ADAP software main screen. 
After the all tests are completed and evaluated, the test results are displayed in the 
ADAP software main screen. 
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10 Defining and Running Tests In 
the Quantitation Module 
10.1 Overview 
Note: A valid license code for the ADAP Prisma software is required to access the 
functions covered in this chapter. Refer to Section 1.3, Launching the ADAP Software 
for information about license codes. 
Tests are protocols for performing and evaluating measurements using the Zenyth 
200. Tests offer more robust programming and evaluation options than Quick 
measurements, and may be saved and modified. 
Depending on the desired application, test protocols are defined using either the 
Quantitation or ELISA module (refer to Section 10.1.1, Choosing the Appropriate 
Module For Configuring Test Parameters). 
The Quantitation module provides options to: 
• Define new tests (refer to Section 10.2, Defining New Tests In the 
Quantitation Module). 
• Save new tests (refer to Section 10.3, Saving New Tests). 
• Run existing tests (refer to Section 10.4, Running Existing Tests). 
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• Edit, copy, or delete test definitions (refer to Section 10.5, Editing, Copying, 
and Deleting Test Definitions). 
• Print test definition parameters (refer to Section 10.6, Printing Test 
Definitions). 
• Run preconfigured cuvette applications. Refer to Chapter 12, Running 
Cuvette Applications for information about running cuvette applications. 
Note: Tests may be performed by all authorized users; however, tests may only be 
defined, edited, and deleted by Level 2 (administrator) and Level 3 (system 
administrator) users (refer to Chapter 2, User Login and System Administration). 
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10.1.1 Choosing the Appropriate Module For 
Configuring Test Parameters 
Test protocols may be defined in either the Quantitation or ELISA module. While 
some functionality is common to both modules, test definition parameters should be 
configured using the module that best meets the requirements of the test. 
Choose the Quantitation module to: 
• Quickly and easily define endpoint and kinetic tests that perform 
quantitative evaluations (refer to Section 10.2.2, Configuring an Endpoint 
Photometric Test and Section 10.2.4, Configuring a Kinetic Photometric 
Test). 
• Define spectral scan measurements (refer to Section 10.2.2, Configuring an 
Endpoint Photometric Test). 
• Perform preconfigured assays on cuvette samples (refer to Chapter 12, 
Running Cuvette Applications). 
Choose the ELISA module to define tests that: 
• Perform qualitative evaluations using cutoff formulas (refer to Chapter 8.2.4, 
Configuring Qualitative Evaluations). 
• Use replicate rejection and/or validation formulas to determine the final 
measurement value (refer to Section 8.2.8, Programming Rejection/ 
Validation Formulas). 
• Can be run in multitest assays (refer to Chapter 9, Defining and Running 
Multitest Assays In the ELISA Module). 
Note: This chapter covers defining test protocols in the Quantitation module. Refer 
to Chapter 8, Defining and Running Tests In the ELISA Module, for information about 
using the ELISA module to configure test definition parameters. 
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10.2 Defining New Tests In the Quantitation Module 
Test definitions configured in the Quantitation module dictate how the Zenyth 200 
performs measurements and interprets the resulting data. Test type and parameters are 
defined using two tabs: 
• General — Sets test name and defines sample format, test type, and 
applicable measurement parameters. The parameters available change 
dynamically based on which sample format and test type are selected. 
• Quantitation — Configures standards and standard curve fitting for 
endpoint and kinetic test measurements (refer to Section 10.2.8, Configuring 
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Quantitative Evaluations). 
Note: A third tab, Applications, is also available in the Quantitation module. Use 
this tab to run preconfigured cuvette tests. Refer to Chapter 12, Running Cuvette 
Applications, for information about running preconfigured cuvette tests. 
To define a new test: 
• Select the sample format: microplate or cuvette, and configure the use of 
standards, blanks, controls, replicates, and samples in the test (refer to 
Section 10.2.1, Choosing the Sample Format and Configuring Sample 
Options). 
• Choose the type of measurement to perform, and configure the measurement 
parameters available. Available measurement types are: 
• Endpoint photometric — performs a single-wavelength or bichromatic 
endpoint measurement (refer to Section 10.2.2, Configuring an 
Endpoint Photometric Test). 
• Multiwavelength photometric — performs up to eight absorbance or 
transmission measurements at different wavelengths (refer to Section 
10.2.3, Configuring a Multiwavelength Photometric Test). 
• Kinetic photometric — performs a series of single-wavelength or 
bichromatic measurements over a specified time interval for each 
sample (refer to Section 10.2.4, Configuring a Kinetic Photometric 
Test). 
• Spectral scan photometric — performs a spectral scan measurement at 
all wavelengths within a specified bandwidth (refer to Section 10.2.5, 
Configuring a Spectral Scan Test). 
• Area scan photometric — performs a series of absorbance 
measurements at a number of points across each well (refer to Section 
10.2.6, Configuring an Area Scan Photometric Test). 
Note: Area scan test measurements may only be performed 
on microplate samples. 
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• Linear scan photometric — performs a series of transmission 
measurements along a linear axis that crosses the center of each well 
(refer to Section 10.2.7, Configuring a Linear Scan Photometric Test). 
Note: Linear scan test measurements may only be 
performed on microplate samples. 
• For endpoint, multiwavelength, and kinetic test measurements, configure 
standards and standard curve fitting, if desired (refer to Section 10.2.8, 
Configuring Quantitative Evaluations). 
To open Quantitation Module Test Definition: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to 
Quantitation, if necessary. 
2. From the Setup menu, choose Test Definition. 
OR 
From the toolbar, choose Create/Edit Calculation. Quantitation Module 
Test Definition appears with the General tab open (Figure 10-1). 
Figure 10-1. Quantitation Module Test Definition — General tab 
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Quantitation Module Test Definition is divided into seven sections with options that 
automatically change to reflect the sample format selected and the type of 
measurement being configured: 
• Assay — Selects a name for the test. 
• Method — Selects the type of test to perform: Endpoint, Kinetic, or 
Spectrum (spectral scan). 
• Plates — Chooses the sample format: Cuvette or Plates (refer to Section 
10.2.1, Choosing the Sample Format and Configuring Sample Options). 
• Temperature — Sets the internal temperature of the instrument. 
Note: Temperature is available only for tests performed on 
microplate samples. 
• Shaking — Sets the time and intensity of microplate shaking. 
Note: Shaking is available only for tests performed on 
microplate samples. 
• Set Measurement Parameter — Configures measurement parameters. 
Options available automatically change to reflect the type of measurement 
being configured. 
• Variable — When defining endpoint and multiwavelength tests, configures 
numeric values for up to eight variables that can be used in any formula 
defined in the test definition. 
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10.2.1 Choosing the Sample Format and 
Configuring Sample Options 
The Zenyth 200 is capable of performing test measurements on microplate and 
cuvette samples. The sample format selected for a new test definition affects which 
test options are available in the General tab. For example, scan measurements may 
be performed only on microplate samples. For this reason, the sample format and 
options should be configured before the options available in the other sections. 
To choose the sample format and configure sample options: 
• Choose the sample format in Plates (refer to Section 10.2.1.1, Choosing the 
Sample Format). 
• Configure sample options in Define Layout (refer to Section 10.2.1.2, 
Configuring Sample Options). 
10.2.1.1 Choosing the Sample Format 
The sample format is chosen in the Plates section of the General tab (Figure 10-2). 
Figure 10-2. Quantitation Module Test Definition — configuring sample format 
Plates 
Choose the sample format, configure 
Background correction for microplate 
samples, and access Define Layout. 
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To choose the sample format: 
1. In the General tab, under Plates, choose the desired sample format: Cuvette or 
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Plates. 
2. If Plates is the selected format, choose Background correction, if desired. 
Note: Background correction is available for endpoint, kinetic, and 
spectral scan (spectrum) measurements. 
Note: Background correction removes background noise from 
measurement values. To remove background noise, the plate is read 
twice during a test. The first measurement is made with a buffer; the 
second with the analyte of interest. Two levels of background correction 
are available: Low and High. 
3. If Background correction is chosen, choose Low. 
Note: Select Low when background noise is relatively constant across 
the entire plate. Low background correction averages the buffer 
measure-ment values from all wells read, and then subtracts the average 
value from the analyte measurement value for each well. 
OR 
If Background correction is chosen, choose High. 
Note: Select High when background noise is high and variable across 
the entire plate; for example when performing measurements in the low 
UV range on samples on a plastic microplate. High background 
correction subtracts the buffer measurement value of a well from the 
analyte measurement value for the same well. 
4. Choose Edit/Define Layout to configure sample options (refer to Section 
10.2.1.2, Configuring Sample Options). 
10.2.1.2 Configuring Sample Options 
Microplate and cuvette parameters are configured in Define Layout, which is divided 
into four sections: 
• Options — Configures sample format parameters including plate type, strip 
use, filling direction, replicates, and well labeling format (refer to Section 
10.2.1.2.1, Configuring Sample Format Parameters). 
Note: Options is only available when configuring tests that are 
performed on microplate samples. 
• Control-Position — Configures the type and label numbering applied to 
samples measured during the test (refer to Section 10.2.1.2.2, Configuring 
Well or Cuvette Types and Labels). 
• Plate Layout — Defines the location of standard, control, blank, and 
sample wells on the plate. With cuvettes, defines the label of each cuvette 
measured (refer to Section 10.2.1.2.3, Defining Sample Location in Plate 
Layout). 
• Factor — Configures multiplication factors for samples (refer to Section 
10.2.1.2.4, Entering Multiplication Factors for Samples). 
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To open Define Layout: 
In the General tab, under Plates, choose Edit/Define Layout. Define Layout 
appears (Figure 10-3). 
Figure 10-3. Define Layout (microplate) 
10.2.1.2.1 Configuring Sample Format Parameters 
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Options configures microplate sample format parameters including plate type, strip 
use, filling direction, replicates, and well labeling format. 
Note: Options is only available when configuring sample format parameters for 
microplates. 
To configure plate parameters, in Options: 
1. In Plate Type, choose the type of microplate used in the test. 
2. In Filling Direction, select how samples are numbered based on the filling 
direction of the plate: 
• Vertical — Sample labels are numbered in ascending order column by 
column. 
• Horizontal — Sample labels are numbered in ascending order row by 
row. 
3. In Replicate No./Direction, select the number of replicates to be used for each 
sample, and set the filling direction of replicates: 
• Vertical — Replicate labels are numbered in ascending order column by 
column. 
• Horizontal — Replicate labels are numbered in ascending order row by 
row. 
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4. In Well Labels, select the format of the well labels: 
• A1,A2...B1,B2. — Labels rows by letter, columns by number. 
• 1.1,1.2, 1.3...2.1,2.2, 2.3. — Labels rows and columns by number. 
10.2.1.2.2 Configuring Well or Cuvette Types and Labels 
The options in Control-Position work in conjunction with Plate Layout to configure 
well or cuvette types, label numbers, and locations of samples. Standards, controls, 
and blanks are configured using Control-Position, then placed on the plate or 
assigned to specific cuvettes using Plate Layout. 
Note: Refer to Section 10.2.1.2.3, Defining Sample Location in Plate Layout, for 
information about defining the actual location of wells on the plate. 
To configure well or cuvette types and label numbers: 
1. In Type, select the type of wells or cuvettes to configure: 
• Standard — A well or cuvette with a known concentration used to 
develop or correct a standard curve. 
• Positive-Control — A control well or cuvette in which a known 
amount of a target reagent is used to generate a signal that verifies 
positive results measured in sample wells. 
• Negative-Control — A control well or cuvette in which the lack of a 
target reagent produces very little or no signal, which verifies negative 
results measured in sample wells. 
• Blank — A well or cuvette that is left empty or filled only with reagents 
but no reacting sample, used to measure background noise. 
• Sample — A well or cuvette containing a sample to measure. 
Note: The Numbers label below Type changes automatically to 
reflect the type of well chosen. 
2. In Numbers, click and drag the slider to change the well label identification 
number. 
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Note: Drag the slider to the right to increase the label number, or to the 
left to reduce it. 
3. Use Plate Layout to define well locations or specific cuvettes for the configured 
Type (refer to Section 10.2.1.2.3, Defining Sample Location in Plate Layout). 
4. After defining well locations or specific cuvettes for the configured Type, repeat 
steps 1–3 above for each additional well type desired on the plate. 
5. When all standards, controls, and blanks have been configured, choose Fill Plate 
With Samples to populate all remaining wells or cuvettes with samples. 
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10.2.1.2.3 Defining Sample Location in Plate Layout 
For microplate samples, Plate Layout defines the location of standard, control, 
blank, and sample wells on the plate (Figure 10-4). Well locations may also be edited 
and deleted using the options in Plate Layout. 
Figure 10-4. Define Layout — Plate Layout tab (microplate) 
For cuvette samples, Plate Layout assigns the sample types and labels to specific 
cuvettes measured in the test (Figure 10-5). 
Figure 10-5. Define Layout — Plate Layout tab (cuvette) 
Wells selected by 
dragging mouse. 
Choosing Set actual 
column selects all 
wells in column 4. 
Choosing Set actual row 
selects all the wells in row C. 
First well 
selected. 
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To define cuvette sample types or locations on the plate for wells configured in 
Control-Position: 
1. In Plate Layout, click on the desired well or cuvette to define (Figure 10-4). 
Note: Select multiple wells or cuvettes by clicking and then dragging 
over the desired range. 
2. From the Edit menu, choose a method for selecting which wells or cuvettes will 
be defined as the type configured in Control-Position: 
OR 
Right-click on the selected well(s) or cuvette(s) and choose a method for 
selecting which wells or cuvettes will be defined as the type configured in 
Control-Position: 
• Set/De-select all wells — Populates or clears all wells on the 
microplate or all cuvette samples. 
• Set/De-select actual row — With microplates, populates or clears 
all wells in the same row as the first well selected (Figure 10-4). With 
cuvettes, populates or clears all cuvette samples. 
• Set/De-select actual column — With microplates, populates or 
clears all wells in the same column as the first well selected (Figure 10- 
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4). With cuvettes, populates or clears only the first cuvette sample 
selected. 
• Set/De-select selected wells — Populates or clears the selected 
wells or cuvette samples. 
3. In Control-Position, configure another well Type, if desired, and repeat (refer to 
Section 10.2.1.2.2, Configuring Well or Cuvette Types and Labels). 
Note: When all standards, controls, and blanks have been configured, in Control- 
Position, choose Fill Plate With Samples to populate the remaining wells or 
cuvettes with samples. 
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10.2.1.2.4 Entering Multiplication Factors for Samples 
Factor allows entering multiplication factors for wells on the plate or cuvette samples 
(Figure 10-6). 
Figure 10-6. Define Layout — Factor (microplate) 
To enter multiplication factors: 
1. Choose Factor. 
2. Select a well or cuvette and enter numerical value for the Factor (Figure 10-6). 
Note: Select multiple wells or cuvettes by clicking and dragging over 
the desired range. When a new factor is entered for the first well or 
cuvette selected, all selected wells or cuvettes are assigned the new 
factor. 
3. Repeat the previous step for all wells or cuvettes desired. 
Note: F can be entered in transformation formulas and refers to the individual 
multiplication factor for each well position entered in Factor. F is typically used in 
quantitative transformation formulas to correct the concentration of samples for their 
dilution factor; for example, X’ = X * F. 
First well selected with 
new Factor entered. 
Selected group of wells 
with new Factor. 
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10.2.1.2.5 Completing the Sample Layout 
When all parameters are configured and samples defined, save and close Define 
Layout and return to the General tab to continue configuring the test definition. 
To close Define Layout and continue configuring the test: 
1. From the File menu, choose End to close Define Layout and save the new plate 
or cuvette parameters. 
OR 
From the File menu, choose Cancel to close Define Layout without saving the 
new plate or cuvette parameters. 
Note: In the File menu, Print and Open perform their respective functions on the 
complete test definition, not Define Layout. Both functions may not be accessible if 
the test definition is not completely configured. 
2. Configure the desired measurement type by following the steps listed in its 
respective section: 
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• Endpoint photometric (refer to Section 10.2.2, Configuring an Endpoint 
Photometric Test). 
• Multiwavelength photometric (refer to Section 10.2.3, Configuring a 
Multiwavelength Photometric Test). 
• Kinetic photometric (refer to Section 10.2.4, Configuring a Kinetic 
Photometric Test). 
• Spectral scan photometric (refer to Section 10.2.5, Configuring a 
Spectral Scan Test). 
• Area scan photometric (refer to Section 10.2.6, Configuring an Area 
Scan Photometric Test). 
Note: Area scan test measurements may only be performed 
on microplate samples. 
• Linear scan photometric (refer to Section 10.2.7, Configuring a Linear 
Scan Photometric Test). 
Note: Linear scan test measurements may only be 
performed on microplate samples. 
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10.2.2 Configuring an Endpoint Photometric Test 
An endpoint photometric test performs a single absorbance or transmission 
measurement on samples at a user-specified wavelength between 190 and 1000 nm. If 
desired, a bichromatic endpoint measurement may also be performed. Bichromatic 
measurements perform a second measurement using a Reference Filter. This 
measurement is subtracted from the first to calculate the final result. 
Note: Endpoint photometric transmission measurements may be performed only on 
cuvette samples. 
To configure an endpoint photometric test measurement: 
1. Choose the sample format and configure sample options following the steps in 
Section 10.2.1, Choosing the Sample Format and Configuring Sample Options. 
2. In Assay, enter a Name for the test. 
3. In Method, choose Endpoint. Options available in the General tab change to 
include only those applicable for endpoint measurements and the selected sample 
format (Figure 10-7). 
Figure 10-7. Configuring an endpoint photometric test (microplate) 
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4. In Temperature, if desired, enter an incubation temperature for the test. 
Note: Temperature is available only for tests performed on 
microplate samples. 
Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
Note: To turn temperature control off, in Set Temperature, enter 0. 
5. In Shaking, if desired, choose Yes to shake the microplate before performing 
the measurement. 
Note: Shaking may be performed only on microplate samples. 
Note: If shaking is not desired, go to step 8. 
6. If Shaking is enabled, select the Time to shake, in seconds. 
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7. If Shaking is enabled, select the intensity: Low, Medium, or High. 
8. In Set Measurement Parameter, leave Wavelength set at the default 1. 
Note: Changing the Wavelength configures a multiwavelength 
measurement (refer to Section 10.2.3, Configuring a Multiwavelength 
Photometric Test). 
9. Under Set Measurement Parameter, in WL1, enter the desired measurement 
wavelength. 
10. To perform a bichromatic measurement, under Set Measurement Parameter, 
in Reference, enter the desired wavelength. 
11. If configuring a cuvette measurement, under Set Measurement Parameter, 
select Transmission to perform a transmission measurement, if desired. 
12. In Variable, enter numeric values for up to eight variables that can be used in any 
formula defined in the test definition. 
Note: Variables are typically used with test kits that have cutoff values 
or standard correction values based on lot number. 
13. Under Set Measurement Parameter, in X’=, enter a transformation formula, if 
desired. 
Note: The formula may contain any controls, standards, or variables 
defined in the test, any numerical constants, as well as mathematical 
operators ( ) * +, - . / ^, ABS, SQR, L, F, X, and V (refer to Section 
8.2.8.3, Logical and Mathematical Operators). 
Standards and controls are abbreviated as: S for standard, PC for 
positive control, and NC for negative control. 
14. If desired, use the Quantitation tab to configure standards and standard curve 
fitting (refer to Section 10.2.8, Configuring Quantitative Evaluations). 
15. Save the test definition following the steps in Section 10.3, Saving New Tests. 
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10.2.3 Configuring a Multiwavelength 
Photometric Test 
A multiwavelength photometric test performs up to eight absorbance or transmission 
measurements at different user-specified wavelengths between 190 and 1000 nm. 
To perform a multiwavelength photometric test measurement: 
1. Choose the sample format and configure sample options following the steps in 
Section 10.2.1, Choosing the Sample Format and Configuring Sample Options. 
2. In Assay, enter a Name for the test. 
3. In Method, choose Endpoint. Options available in the General tab change to 
include only those applicable for multiwavelength measurements and the 
selected sample format (Figure 10-8). 
Figure 10-8. Configuring a multiwavelength photometric test (microplate) 
4. In Temperature, if desired, enter an incubation temperature for the test. 
Note: Temperature is available only for tests performed on 
microplate samples. 
Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
Note: To turn temperature control off, in Set Temperature, enter 0. 
Defining and Running Tests In the Quantitation Module 10-17 
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5. In Shaking, if desired, choose Yes to shake the microplate before performing 
the measurement. 
Note: Shaking may be performed only on microplate samples. 
Note: If shaking is not desired, go to step 8. 
6. If Shaking is enabled, select the Time to shake, in seconds. 
7. If Shaking is enabled, select the intensity: Low, Medium, or High. 
8. Under Set Measurement Parameter, in Wavelength choose the number of 
wavelengths to measure. A field for each wavelength appears (Figure 10-8). 
9. Under Set Measurement Parameter, enter the desired wavelength for each 
measurement. 
10. If configuring a cuvette measurement, under Set Measurement Parameter, 
select Transmission to perform a transmission measurement, if desired. 
11. In Variable, enter numeric values for up to eight variables that can be used in any 
formula defined in the test definition. 
Note: Variables are typically used with test kits that have cutoff values 
or standard correction values based on lot number. 
12. Under Set Measurement Parameter, in X’=, enter a transformation formula, if 
desired. 
Note: The formula may contain any controls, standards, or variables 
defined in the test, any numerical constants, as well as mathematical 
operators ( ) * +, - . / ^, ABS, SQR, L, F, X, and V (refer to Section 
8.2.8.3, Logical and Mathematical Operators). 
Standards and controls are abbreviated as: S for standard, PC for 
positive control, and NC for negative control. 
13. If desired, use the Quantitation tab to configure standards and standard curve 
fitting (refer to Section 10.2.8, Configuring Quantitative Evaluations). 
14. Save the test definition following the steps in Section 10.3, Saving New Tests. 
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10.2.4 Configuring a Kinetic Photometric Test 
A kinetic photometric test performs a user-specified series of absorbance or 
transmission measurements on each sample at user-specified intervals. Single or 
bichromatic measurements may be performed at user-specified wavelengths between 
190 and 1000 nm. Bichromatic measurements perform a second measurement in each 
cycle using a reference filter. This measurement is subtracted from the first, then final 
measurement results are calculated using a data reduction method. 
Note: Kinetic photometric transmission measurements may only be performed on 
cuvette samples. 
To perform a kinetic photometric test measurement: 
1. Choose the sample format and configure sample options following the steps in 
Section 10.2.1, Choosing the Sample Format and Configuring Sample Options. 
2. In Assay, enter a Name for the test. 
3. In Method, choose Kinetic. Options available in the General tab change to 
include only those applicable for kinetic measurements and the selected sample 
format (Figure 10-9). 
Figure 10-9. Configuring a kinetic photometric test (microplate) 
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4. In Temperature, if desired, enter an incubation temperature for the test. 
Note: Temperature is available only for tests performed on 
microplate samples. 
Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
Note: To turn temperature control off, in Set Temperature, enter 0. 
5. In Shaking, if desired, choose Yes to shake the microplate during the 
measurement. 
Note: Shaking may be performed only on microplate samples. 
Note: If shaking is not desired, go to step 9. 
6. If Shaking is enabled, select the Time to shake, in seconds. 
7. If Shaking is enabled, select the intensity: Low, Medium, or High. 
8. If Shaking is enabled, select when microplates are shaken: 
• Before Measurement — The microplate is shaken for the selected 
time and intensity before the instrument reads the plate. 
• Between Cycles — The microplate is shaken for the selected time 
and intensity before the instrument reads the plate, and in between each 
measurement cycle. 
9. Under Set Measurement Parameter, in Wavelength choose the measurement 
wavelength. 
10. To perform a bichromatic measurement, under Set Measurement Parameter, 
in Reference, enter the desired wavelength. 
11. Under Set Measurement Parameter, in Data Reduction, choose a data 
reduction method. Refer to Table 10-1 for more information about data reduction 
methods. 
Note: Depending on the data reduction method selected, additional 
parameters, such as smoothing points and in-/decrease, may need to be 
configured in the field below Data Reduction. Refer to Table 10-1 for 
the additional configuration requirements of each data reduction 
method. 
12. If configuring a cuvette measurement, under Set Measurement Parameter, 
select Transmission to perform a transmission measurement, if desired. 
13. Under Set Measurement Parameter, in X’=, enter a transformation formula, if 
desired. 
Note: The formula may contain any controls or standards defined in 
the test, any numerical constants, as well as mathematical operators ( ) * 
+, - . / ^, ABS, SQR, L, F, X, and V (refer to Section 8.2.8.3, Logical 
and Mathematical Operators). 
Standards and controls are abbreviated as: S for standard, PC for 
positive control, and NC for negative control. 
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14. Under Set Measurement Parameter, enter a Name for the results calculated 
by the transformation formula, if desired. The name is displayed in the kinetic 
measurement results tab. 
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15. If desired, use the Quantitation tab to configure standards and standard curve 
fitting (refer to Section 10.2.8, Configuring Quantitative Evaluations). 
16. Save the test definition following the steps in Section 10.3, Saving New Tests. 
10.2.4.1 Data Reduction Methods 
In kinetic measurements, data reduction methods are used to determine a single value 
per sample based on the results of a sequence of measurements over a period of time. 
Table 10-1 describes the twelve data reduction methods supported by the ADAP 
software. 
Table 10-1. Data Reduction Methods 
Data Reduction Method Description Additional 
Configuration 
Average Slope 
Determines the average slope of the reaction curve by 
calculating the average of all linear regressions 
calculated over each group of Smoothing Points in the 
kinetic reading sequence. A decreasing slope shows a 
decline. 
Smoothing Points 
Delta OD Difference between the first and last kinetic 
measurements in optical density (OD). N/A 
Delta OD — Max. Slope 
Difference in OD between the first measurement and the 
center point of the maximum slope. 
Note: The center point of the maximum slope is 
calculated by determining the center point between the 
smoothing points of the regression line with the 
maximum slope. 
Smoothing Points 
Delta Time — Absolute Time elapsed from one preselected OD value to another. Lower 
Limit 
Upper Limit 
Delta Time — Max. Slope 
Time difference in seconds between the first 
measurement and the occurrence of the center point of 
the maximum slope. 
Note: The center point of the maximum slope is 
calculated by determining the center point between the 
smoothing points of the regression line with the 
maximum slope. 
Smoothing Points 
Delta Time — Relative 
Time elapsed in seconds from the first measurement to 
reaching a set increase/decrease amount from the first 
OD measurement. 
In-/Decrease 
Maximum Declining Slope 
Determines the maximum declining rate of the reaction 
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curve by calculating a linear regression over each group 
of Smoothing Points in the kinetic reading sequence. 
Smoothing Points 
Maximum Inclining Slope 
Determines the maximum inclining rate of the reaction 
curve by calculating a linear regression over each group 
of Smoothing Points in the kinetic reading sequence. 
Smoothing Points 
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Maximum Slope 
Maximum slope of the curve in OD/min. The line with 
the highest slope is calculated. Also the maximum 
reaction speed. 
Note: The accuracy of this calculation depends on the 
number of measurement cycles selected. 
Smoothing Points 
Mean Determines the mean value per sample within a 
sequence of measurements. N/A 
Time Peak Value Used to detect the time elapsed until the peak value is 
reached. Smoothing Points 
Peak Value Used to detect the highest value per sample within a 
sequence of measurements. Smoothing Points 
Table 10-1. Data Reduction Methods 
Data Reduction Method Description Additional 
Configuration 
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10.2.5 Configuring a Spectral Scan Test 
A spectral scan test performs absorbance or transmission measurements at all 
wavelengths within a user-specified bandwidth. 
To perform a spectral scan test measurement: 
1. Choose the sample format and configure sample options following the steps in 
Section 10.2.1, Choosing the Sample Format and Configuring Sample Options. 
2. In Assay, enter a Name for the test. 
3. In Method, choose Spectrum. Options available in the General tab change to 
include only those applicable for spectral scan measurements and the selected 
sample format (Figure 10-10). 
Figure 10-10. Configuring a spectral scan photometric test (microplate) 
4. In Temperature, enter an incubation temperature for the test, if desired. 
Note: Temperature is available only for tests performed on 
microplate samples. 
Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
Note: To turn temperature control off, in Set Temperature, enter 0. 
Defining and Running Tests In the Quantitation Module 10-23 
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5. In Shaking, if desired, choose Yes to shake the microplate during the 
measurement. 
Note: Shaking may be performed only on microplate samples. 
Note: If shaking is not desired, go to step 8. 
6. If Shaking is enabled, select the Time to shake, in seconds. 
7. If Shaking is enabled, select the intensity: Low, Medium, or High. 
8. Under Set Measurement Parameter, in Start Wavelength, enter the shortest 
wavelength to be measured in the spectral scan. 
9. Under Set Measurement Parameter, in End Wavelength, enter the longest 
wavelength to be measured in the spectral scan. 
10. Under Set Measurement Parameter, select Transmission to measure 
transmission instead of absorbance, if desired. 
11. Under Set Measurement Parameter, select a Data Reduction method, if 
desired: 
• Maximum Peak — The highest optical density (OD) or transmission value 
measured. 
• Maximum Peak Wavelength — The wavelength of the maximum optical 
density (OD) or transmission measured. 
• Minimum Valley — The lowest optical density (OD) or transmission value 
measured. 
• Minimum Valley Wavelength — The wavelength of the minimum 
optical density (OD) or transmission measured. 
12. If a data reduction method is selected, enter the number of Smoothing Points 
to use in the calculation. 
13. Save the test definition following the steps in Section 10.3, Saving New Tests 
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10.2.6 Configuring an Area Scan Photometric Test 
Area scan test measurements perform absorbance or transmission measurements at a 
number of points across each well. Area scans can measure samples on 6-, 12-, 24-, 
48-, and 96-well microplates, and are performed at the maximum resolution allowed 
by the plate type. 
Note: Area scan test measurements may be performed only on microplate samples. 
To perform an area scan test measurement: 
1. In Plates, choose Plates and configure sample options following the steps in 
Section 10.2.1, Choosing the Sample Format and Configuring Sample Options. 
2. In Assay, enter a Name for the test. 
3. In Method, choose Endpoint. Options available in the General tab change to 
include only those applicable for endpoint scan measurements and the selected 
sample format. 
4. In Set Measurement Parameter, choose Area Scan. The applicable 
configuration options for an area scan measurement appear in Set 
Measurement Parameter (Figure 10-11). 
Figure 10-11. Configuring an area scan photometric test 
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5. In Temperature, enter an incubation temperature for the test, if desired. 
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Note: Temperature is available only for tests performed on 
microplate samples. 
Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
Note: To turn temperature control off, in Set Temperature, enter 0. 
6. In Shaking, if desired, choose Yes to shake the microplate during the 
measurement. 
Note: Shaking may be performed only on microplate samples. If 
shaking is not desired, go to step 9. 
7. If Shaking is enabled, select the Time to shake, in seconds. 
8. If Shaking is enabled, select the intensity: Low, Medium, or High. 
9. In Set Measurement Parameter, leave Wavelength set at the default 1. 
Note: Changing the Wavelength configures a multiwavelength 
measurement (refer to Section 10.2.3, Configuring a Multiwavelength 
Photometric Test). 
10. Under Set Measurement Parameter, in WL1, enter the desired measurement 
wavelength. 
11. Under Set Measurement Parameter, in Points (Height and Width), select 
the number of measurement points. 
Note: The number of points selected in Points defines how many 
points will be measured both vertically and horizontally; for example 
choosing 6 means that 36 measurement points will be laid out in a 6 x 6 
grid across the well. 
The number of point selections available depends upon the plate format 
selected in the plate layout. 12-well plates have a resolution of about 
20 x 20 points; 24-well plates about 14 x 14; 96-well plates about 8 x 8. 
The exact resolution depends on plate type. 
12. Under Set Measurement Parameter, in Resolution, select he resolution, or 
space, between each measurement point. The highest resolution value is 1, where 
the distance between measurement points is the smallest. 
Note: The graphic depicting a well displays the layout and resolution 
of measurement points currently selected. Reducing resolution 
maintains the same coverage, but spaces fewer measurement points 
further apart; increasing resolution adds measurement points to the same 
coverage area. 
13. Save the test definition following the steps in Section 10.3, Saving New Tests 
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10.2.7 Configuring a Linear Scan Photometric Test 
Linear scan test measurements perform transmission measurements at 25 points along 
a linear axis crossing the center of each measured well on a 96-well microplate. 
Note: Area scan test measurements may be performed only on microplate samples. 
To perform a linear scan test measurement: 
1. In Plates, choose Plates and configure sample options following the steps in 
Section 10.2.1, Choosing the Sample Format and Configuring Sample Options. 
2. In Assay, enter a Name for the test. 
3. In Method, choose Endpoint. Options available in the General tab change to 
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include only those applicable for endpoint scan measurements and the selected 
sample format. 
4. In Set Measurement Parameter, choose Linear Scan. The applicable 
configuration options for a linear scan measurement appear in Set 
Measurement Parameter (Figure 10-12). 
Figure 10-12. Configuring a linear scan photometric test 
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5. In Temperature, enter an incubation temperature for the test, if desired. 
Note: Temperature is available only for tests performed on 
microplate samples. 
Note: The incubation temperature must be a minimum of 4° C (7.2° F) 
above ambient. The maximum incubation temperature is 45° C (113° F). 
Note: To turn temperature control off, in Set Temperature, enter 0. 
6. In Shaking, if desired, choose Yes to shake the microplate during the 
measurement. 
Note: Shaking may be performed only on microplate samples. 
Note: If shaking is not desired, go to step 9. 
7. If Shaking is enabled, select the Time to shake, in seconds. 
8. If Shaking is enabled, select the intensity: Low, Medium, or High. 
9. In Set Measurement Parameter, leave Wavelength set at the default 1. 
Note: Changing the Wavelength configures a multiwavelength 
measurement (refer to Section 10.2.3, Configuring a Multiwavelength 
Photometric Test). 
10. Under Set Measurement Parameter, in WL1, enter the desired measurement 
wavelength. 
11. Save the test definition following the steps in Section 10.3, Saving New Tests 
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10.2.8 Configuring Quantitative Evaluations 
For endpoint, multiwavelength, and kinetic measurements, the Quantitation tab 
configures parameters for standard curves, concentration values, and response 
formulas. 
Note: Quantitation is available only when endpoint, multiwavelength, or kinetic 
measurements are being configured. 
Quantitation is divided into two sections: 
• Standards — Configures concentration and response formula parameters 
for standards (refer to Section 10.2.8.1, Configuring Standards). 
• Standard curve — Configures standard curve fitting parameters (refer to 
Section 10.2.8.2, Configuring Standard Curve Parameters). 
To configure quantitative parameters: 
Select the Quantitation tab (Figure 10-13). 
Figure 10-13. Quantitation Module Test Definition — Quantitation tab 
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10.2.8.1 Configuring Standards 
Standards configures up to 10 concentration values and response formulas. 
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To configure concentration values and response formulas: 
1. Under Concentration, enter the concentration value to be plotted on the 
x-axis. 
Note: For Concentration values less than 1, enter a leading 0 before 
the decimal; for example, 0.51. Values entered without the leading 0 
produce an error when the measurement is performed. 
2. Under Response Formula, enter the response formula to plot the corresponding 
concentration on the y-axis. 
Note: Response formulas may contain any controls, standards, or 
variables defined in the test, as well as any numerical constants and 
mathematical operators +,-,*,/,(,),^. Usually, the response formula is just 
the value of a measured standard and consists only of the corresponding 
name; for example S1, S2, or S3. 
Note: For Response Formula values less than 1, enter a leading 0 
before the decimal; for example, 0.51. Values entered without the 
leading 0 produce an error when the measurement is performed. 
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10.2.8.2 Configuring Standard Curve Parameters 
Standard curve configures new standard curve parameters. 
To configure standard curve parameters. 
1. Under Standard curve, select the curve fitting method: Point to Point, Linear 
Regression, Cubic Spline, or 4-Parameter Fit. 
Note: Refer to Section 10.2.8.2.1, Curve Fitting Models for detailed 
information about curve fitting methods. 
2. In Axis (X/Y), select the scale to use for the X and Y axes: 
• lin/lin — Linear/Linear 
• lin/log — Linear/Logarithmic 
• log/log — Logarithmic/Logarithmic. 
3. In Extrapolation, enter a percentage value to extrapolate the standard curve 
above and below the highest and lowest standard points in the curve, if desired. 
Note: Extrapolation percentages can be used with Linear 
Regression, Cubic Spline or 4-Parameter Fit curve fitting methods. 
Note: The percentage value entered in Extrapolation can be up to 
99.9%. 
4. In Units, enter the units of measure to be displayed in the test measurement 
results. 
Note: Units are used for documentation purposes only and do not 
impact the standard curve. Units appears in Transform in the test 
measurement results window (refer to Section 11.2.3, Viewing 
Concentration Results). 
5. In Validate Curve, choose Yes or No to validate the test based on an acceptable 
coefficient of correlation. 
Note: Validate Curve is only available with the Linear Regression 
curve fitting method. 
6. If Yes is selected in Validate Curve, in Min. Correlation, enter the minimum 
correlation percentage value for the test to be valid. 
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10.2.8.2.1 Curve Fitting Models 
Table 10-2 describes the four curve fitting models supported by the ADAP software. 
Table 10-2. Curve Fitting Models 
Method Description Example 
Linear regression 
Construction of a straight line using the least 
squares method with the highest possible 
approximation to all standard points. 
Requires a minimum of 2 standard points. 
Point to Point 
Direct connection of all standard points. 
Requires a minimum of 2 standard points. 
Cubic Spline 
All standard points are connected by the best 
fitting curve. 
Note: Can only be used for nonlinear and 
nonsigmoid functions. 
Requires a minimum of 3 standard points. 
4 Parameter Fit 
This procedure can be used only to characterize 
sigmoid curves. The curve is calculated according 
to the formula: 
a = zero dose response (upper asymptote) 
d = infinite dose response (lower asymptote) 
c = dose level which results in a response midway 
between a and d 
b = slope factor 
Requires a minimum of 4 standard points. 
yi 
(a – d) 
1 
xi 
c 

----  
b 

+ 
= --------------------------- + d 
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10.3 Saving New Tests 
When the plate layout and all required parameters for the test have been properly 
configured, the test definition may be saved. Test definitions must be saved before 
measurements can be performed. 
To save a test definition during configuration: 
From the File menu, choose Save. The test definition remains open for further 
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editing. 
Note: Before a test definition can be saved, the test must be named and 
samples must be configured in Define Layout. 
To save a test definition and return to the main ADAP screen: 
From the File menu, choose Close. The test definition is saved in the database 
and may be used to run a test. 
To return to the main ADAP screen without saving the test definitions: 
1. From the File menu, choose Cancel. Message appears (Figure 10-14) 
Figure 10-14. Message — Save Data 
2. Choose No to close Quantitation Module Test Definition without saving the 
test definition. 
OR 
Choose Yes to save the test definition to the database and close Quantitation 
Module Test Definition. 
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10.4 Running Existing Tests 
Tests may be run as soon as they are defined and saved. All test definitions are stored 
in the ADAP software database. 
To run a test: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to 
Quantitation, if necessary. 
Note: If the Elisa/Quantitation selection button is toggled to Elisa, 
only tests defined in the ELISA module will be available to run. 
2. From the Reading menu, choose Single Test. 
OR 
Choose Measure single test. Selection appears (Figure 10-15). 
Figure 10-15. Selection — test definitions 
10-34 Defining and Running Tests In the Quantitation Module 
Anthos Labtec Instruments GmbH 
3. Select a test definition and choose OK. Numbers of Samples appears 
(Figure 10-16). 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 10.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
Figure 10-16. Numbers of Samples 
4. Enter the number of samples to be measured on the plate and choose OK. The 
measurement results screen appears and the measurement procedure begins. 
After the measurement is complete, the results are displayed (refer to Chapter 11, 
Viewing Test and Multitest Assay Measurement Results). 
10.4.1 Using Matchcode to Search for Test 
Definitions Stored In the ADAP Software 
Database 
Matchcode is the search feature included in Selection. Depending on from which 
screen or tab Selection is accessed, Matchcode performs searches for test 
definitions or measurement results stored in the ADAP database. 
Matchcode provides wildcard operators, * and ?, which simplify searching by 
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allowing users to search for a set of possible characters in the plate-ID name (see 
Table 10-3). 
Table 10-3. Matchcode wildcard operators 
Wildcard Pattern Result 
*a* Lists all plate IDs or test definition names 
with an a in the ID or name. 
a* Lists all plate IDs or test definition names 
with an a at the beginning of the ID or name. 
*a Lists all plate IDs or test definition names 
with an a at the end of the ID or name. 
alph? Lists all plate IDs or test definition names 
with alph followed by an additional 
character. For example, alpha or alphb. 
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To search for an existing test definition: 
1. From Selection, choose Matchcode. Plate-ID appears (Figure 10-17). 
Figure 10-17. Plate-ID 
2. In Input Plate-ID, enter a plate ID or test definition name. 
3. Input Plate-ID also refers to saved measurement results for cuvette samples and 
test definition names. 
4. Choose OK. Plate IDs or test definition names that match the search query 
appear in Selection. 
Note: If Matchcode finds no matches to the search query, choose update list 
(Figure 10-15) to display the entire list of test definitions again. 
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10.5 Editing, Copying, and Deleting Test Definitions 
Tests stored in the database can be edited, copied, or deleted using the ADAP 
software. 
Note: Tests may be edited, copied, and deleted only by Level 2 (administrator) and 
Level 3 (system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
10.5.1 Editing Tests 
Test definition parameters may be edited by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
To edit a test stored in the ADAP software database: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to 
Quantitation, if necessary. 
Note: If the Elisa/Quantitation selection button is toggled to Elisa, 
only tests defined in the ELISA module will be available to edit. 
2. From the Setup menu, choose Calculation. 
OR 
Choose Create/Edit Calculation. Quantitation Module Test Definition 
appears (Figure 10-18). 
Figure 10-18. Quantitation Module Test Definition 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

Defining and Running Tests In the Quantitation Module 10-37 
ADAP Software for Zenyth 200 Operating Manual 
3. From the File menu, choose Open. Selection appears with a list of saved test 
definitions (Figure 10-19). 
Figure 10-19. Selection — test definitions 
4. Select a test to edit and choose OK. The chosen test definition appears. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 10.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
5. Edit the desired test definition parameters. 
Note: Refer to Section 10.2, Defining New Tests In the Quantitation 
Module for detailed information about defining test definition 
parameters. 
6. From the File menu, choose Save. The test definition is saved in the database 
and may be used to run a test. 
7. From the File menu, choose End to return to the ELISA module test definition 
setup screen. 
Note: Refer to Section 10.3, Saving New Tests for more information 
about different methods of saving test definition data and returning to 
the main ADAP screen. 
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10.5.2 Copying Tests 
Test definition parameters may be copied by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
To copy a test definition: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to 
Quantitation, if necessary. 
Note: If the Elisa/Quantitation selection button is toggled to Elisa, 
only tests defined in the ELISA module will be available to copy. 
2. From the Setup menu, choose Calculation. 
OR 
Choose Create/Edit Calculation. Quantitation Module Test Definition 
appears (Figure 10-20). 
Figure 10-20. Quantitation Module Test Definition 
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3. From the File menu, choose Open. Selection appears with a list of saved tests 
(Figure 10-21). 
Figure 10-21. Selection — test definitions 
4. Select a test to copy and choose OK. The chosen test definition appears. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 10.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
5. In Test Name, enter a new name for the test (Figure 10-20). 
Note: Test names are limited to 20 characters in length. 
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6. From the File menu, choose Save. The test definition is saved in the database 
with the new name and may be used to run a test. 
7. From the File menu, choose End to return to the ELISA module test definition 
setup screen. 
Note: Refer to Section 10.3, Saving New Tests for more information 
about different methods of saving test definition data and returning to 
the main ADAP screen. 
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10.5.3 Deleting Tests 
Test definition parameters may be deleted by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
To delete a test definition: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to 
Quantitation, if necessary. 
Note: If the Elisa/Quantitation selection button is toggled to Elisa, 
only tests defined in the ELISA module will be available to delete. 
2. From the Setup menu, choose Calculation. 
OR 
Choose Create/Edit Calculation. Quantitation Module Test Definition 
appears (Figure 10-22). 
Figure 10-22. Quantitation Module Test Definition 
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3. From the File menu, choose Open. Selection appears with a list of saved tests 
(Figure 10-23). 
Figure 10-23. Selection — test definitions 
4. Select a test definition(s) to delete. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 10.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
Note: To select multiple test definitions, hold Ctrl while selecting each 
test definition name. 
5. Choose Delete. Message appears (Figure 10-24). 
Figure 10-24. Message — Delete selected Tests? 
6. Choose Yes to delete the test definition. 
OR 
Choose No to cancel the deletion and return to Selection. 
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10.6 Printing Test Definitions 
Test definitions may be printed out to provide a record of the test protocol. 
Note: Test definitions may be printed by Level 2 (administrator) and Level 3 
(system administrator) users (refer to Chapter 2, User Login and System 
Administration). 
To print a test definition: 
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1. From the toolbar, toggle the Elisa/Quantitation selection button to 
Quantitation, if necessary. 
Note: If the Elisa/Quantitation selection button is toggled to Elisa, 
only tests defined in the ELISA module will be available to print. 
2. From the Setup menu, choose Calculation. 
OR 
Choose Create/Edit Calculation. Quantitation Module Test Definition 
appears (Figure 10-25). 
Figure 10-25. Quantitation Module Test Definition 
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3. From the File menu, choose Open. Selection appears with a list of saved test 
definitions (Figure 10-26). 
Figure 10-26. Selection — test definitions 
4. Select a test to be printed and choose OK. The chosen test definition appears. 
Note: Choose Matchcode to search for test definitions by name 
(refer to Section 10.4.1, Using Matchcode to Search for Test Definitions 
Stored In the ADAP Software Database). 
5. From the File menu, select Print. Print appears (Figure 10-27). 
Figure 10-27. Print 
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6. In Printer, select the desired printer to use to print the information. All printers 
that are properly installed and configured on the computer are listed. 
7. In Options, select the desired Font and text Size. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
8. Choose OK print the data. 
Note: If the selected printer is configured to print to a file, such as an Acrobat® PDF 
(*.pdf), a prompt asking for the filename appears. The printed file is saved to the 
ADAP software home directory where the application, database, and support files are 
stored. 
ADAP Software for Zenyth 200 Operating Manual 
11-1 
11 Viewing Test and Multitest 
Assay Measurement Results 
11.1 Overview 
Note: A valid license code for the ADAP Prisma software is required to access the 
functions covered in this chapter. Refer to Section 1.3, Launching the ADAP Software 
for information about license codes. 
After performing a test configured in the ELISA or Quantitation module, or a series 
of tests in a Multitest assay, the measurement results are displayed in a series of tabs 
in the ADAP software main window. The tabs displayed vary depending on the 
module used to configure the test definition, the type of measurement performed, and 
the options selected in the test definition (refer to Chapter 8, Defining and Running 
Tests In the ELISA Module and Chapter 10, Defining and Running Tests In the 
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Quantitation Module). 
Test measurement results are stored in the ADAP software database and may be 
exported to another application or printed. 
Measurement results can be: 
• Viewed in the ADAP software (refer to Section 11.2, Viewing Test 
Measurement Results and Section 11.3, Viewing Multitest Measurement 
Results). 
• Recalculated with different parameters following the measurement (refer to 
Section 11.4, Recalculating Test Results). 
Note: Only tests configured in the ELISA module may be 
recalculated; tests configured in the Quantitation module may not. 
• Printed to view and store a hard copy (refer to Section 11.5, Printing 
Measurement Results). 
• Exported to view in another application (refer to Section 11.6, Exporting 
Measurement Results to Other Applications). 
• Stored in the ADAP software database (refer to Section 11.7, Working with 
Measurement Results Stored in the ADAP Database). 
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11.2 Viewing Test Measurement Results 
Test measurement results are displayed in a series of tabs in the ADAP software main 
window. The tabs displayed depend on the module used to configure the test 
definition, the type of measurement performed, and the options selected in the test 
definition. 
Test measurement results include: 
Note: The following tabs also appear in Quick measurement results. Which tabs 
appear depends on the type of measurement performed. Refer to Chapter 7, Viewing 
Quick Measurement Results, for more information about each tab. 
• OD — In photometric measurement results, displays the optical density 
measurement for each well measured (refer to Section 7.3.1, Viewing 
Endpoint Photometric Measurement Results). 
• Status — In all measurements, displays the status for all measured wells 
(refer to Section 7.3.1.2, Viewing Transmission Measurement Results). 
• Raw Data Kinetic — In kinetic measurements, displays measurement 
results for each cycle of a kinetic photometric measurement (refer to Section 
7.3.2, Viewing Kinetic Photometric Measurement Results). 
• Kinetic Graph — In kinetic measurements, displays a graph of the kinetic 
results over time for each well (refer to Section 7.3.2.3, Viewing Kinetic 
Measurement Graphs). 
• Raw Data Scan — In linear scan measurements, displays the values for 
each of the 25 points measured across wells (refer to Section 7.3.5.1, 
Viewing Linear Scan Measurement Raw Data). In area scan measurements, 
displays the values for all points measured within wells on the plate (refer to 
Section 7.3.7.1, Viewing Area Scan Measurement Raw Data). 
• Scan — In linear scan measurements, displays a graph of the linear 
absorption profile for each well on the plate (refer to Section 7.3.5.2, 
Viewing Linear Scan Graphs). In area scan measurements, displays a threedimensional 
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graph of the results of the area scan from each well (refer to 
Section 7.3.7.2, Viewing Area Scan Transmission Profiles). 
• Curve Info — In multiwavelength measurements, displays the OD and 
transmission values at each wavelength measured (refer to Section 7.3.3.4, 
Viewing Multiwavelength Measurement Curve Info). In spectral scan 
measurements, displays the OD and transmission values at all wavelengths 
measured (refer to Section 7.3.4.3, Viewing Spectral Scan Curve Info). 
Note: The following results screens appear depending on the module used to 
configure the test definition, the type of measurement performed, and the options 
selected in the test definition. 
• Mean — Displays mean values of replicates based on the mean calculation 
mode selected in the test definition (refer to Section 11.2.1, Viewing Mean 
Results Data). 
• Transform — Displays calculated measurement values for each well based 
on the transformation formula entered in the test definition (refer to Section 
11.2.2, Viewing Transformation Formula Results). 
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• Concentration — Displays calculated concentration of each well based on 
the standard curve data entered in the test definition (refer to Section 11.2.3, 
Viewing Concentration Results). 
• Concentration Transformation — Displays calculated concentration 
values for each well based on the concentration transformation formula 
entered in the test definition (refer to Section 11.2.4, Viewing Concentration 
Transformation Results) 
• Qualitative — Displays the cutoff group name for each well if cutoff 
formulas and groups are configured in the test definition (refer to Section 
11.2.5, Viewing Qualitative Results). 
• Plate Layout — Displays the layout of the plate as defined in the test 
definition (refer to Section 11.2.6, Viewing Plate Layout). 
• Sample ID — In Multitest assays, displays the sample identification 
number for each well (refer to Section 11.3.1, Viewing Sample IDs For 
Multitest Assays). 
• CV% — Displays the coefficient of variation of the mean values of a 
replicate group (refer to Section 11.2.7, Viewing CV% Results). 
• Factor — Displays multiplication factors for each well as defined in the test 
definition (refer to Section 11.2.8, Viewing Factor). 
• Standard Curves — Displays the standard curve of the measurement if 
quantitative parameters are configured in the test definition (refer to Section 
11.2.9, Viewing Standard Curves) 
• Test Status — Displays a summary of all steps in a test definition, 
indicating if each step was performed correctly or if there was an error (refer 
to Section 11.2.10, Viewing Test Status Information). 
• Evaluation Summary — Displays a summary of test evaluation data (refer 
to Section 11.2.11, Viewing Evaluation Summary Results). 
Note: In any measurement result screen that displays the results in plate layout 
format, double-click on a well position to see a summary of measurement results for 
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the well. 
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11.2.1 Viewing Mean Results Data 
Mean displays the mean value of each replicate group on the plate (Figure 11-1). The 
mean value is displayed in the first position of the replicate group. 
Note: For a kinetic measurement, the Mean value represents the mean of the data 
reduction value for each replicate group. 
Note: If replicates are not used in the test definition, the Mean tab displays the same 
values as OD (Figure 7-1). 
Figure 11-1. Measurement results — Mean 
Replicate group — mean value 
displayed in the first position 
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11.2.2 Viewing Transformation Formula Results 
Transform (Figure 11-2) displays measurement values for each well calculated using 
the transformation formula configured in Qualitative (refer to Section 8.2.4, 
Configuring Qualitative Evaluations) or in a kinetic test defined in the Quantitation 
module (refer to Section 10.2.4, Configuring a Kinetic Photometric Test). 
Note: Transform is the default label for this tab. If Units for the transformation 
formula is defined, that name appears instead (refer to Section 8.2.4.3, Configuring a 
Transformation Formula). 
Figure 11-2. Measurement results — Transformation 
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11.2.3 Viewing Concentration Results 
If standard curve parameters were configured in Quantitative, Concentrat displays 
the calculated concentration of each well based on the standard curve data results 
(refer to Section 8.2.3, Configuring Quantitative Evaluations). 
Note: Values outside of the valid range of the standard curve are displayed as 
< or >. 
Note: Concentrat is the default label for this tab. If Units for the standard curve is 
defined, that name appears instead (refer to Section 8.2.3.2, Configuring Standard 
Curve Parameters). 
Figure 11-3. Measurement results — Concentrat 
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11.2.4 Viewing Concentration Transformation 
Results 
Index Conc displays the calculated concentration values for each well as a result of 
the transformation formula entered in the Quantitative parameters of a test definition 
configured in the ELISA module (refer to Section 8.2.3, Configuring Quantitative 
Evaluations). 
Note: Index Conc is the default label for this tab. If Units for the transformation 
formula is defined, that name appears instead (refer to Section 8.2.3.5, Configuring a 
Transformation Formula). 
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Figure 11-4. Measurement results — Index Conc 
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11.2.5 Viewing Qualitative Results 
Results displays cutoff group names for each well (Figure 11-5). Cutoff groups are 
created by configuring cutoff formulas in Qualitative (refer to Section 8.2.4, 
Configuring Qualitative Evaluations). 
Figure 11-5. Measurement results — Results 
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11.2.6 Viewing Plate Layout 
Plate Layout (Figure 11-6) displays the layout of the plate as defined in the test 
definition (refer to Section 8.2.1, Choosing the Sample Format and Configuring 
Sample Options). 
Figure 11-6. Measurement results — Plate Layout 
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11.2.7 Viewing CV% Results 
CV% displays the coefficient of variation of the mean values of a replicate group 
(Figure 11-7). To calculate a CV, a sample or well type must have at least 2 replicates. 
The CV% value is displayed in the first position of the replicate group. If there are no 
replicates for a well type, the CV for the well is displayed as 0. 
Note: The formula for CV% is standard deviation divided by mean value, multiplied 
by 100. 
Figure 11-7. Measurement results — CV% 
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11.2.8 Viewing Factor 
Factor (Figure 11-8) displays the multiplication factors for each well configured in 
Define Layout in the test definition (refer to Section 8.2.1.4, Entering Multiplication 
Factors for Samples). 
Figure 11-8. Measurement results — Factor 
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11.2.9 Viewing Standard Curves 
Graphic (Figure 11-9) displays the standard curve based on the results of the 
concentration and response formula configured in Quantitative in the test definition 
(refer to Section 8.2.3, Configuring Quantitative Evaluations). 
Note: If the ADAP software main window is resized, choose Refresh Graph to 
redraw the graph display so that it fits the new window size properly. 
Note: To copy the standard curve graph, right-click on the graph and choose Copy 
graph into clipboard. The graph can then be pasted into another application such 
as a word processor. 
Figure 11-9. Standard curve displayed in measurement results — Graphic tab 
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11.2.10 Viewing Test Status Information 
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Info-Calculation displays a summary of each step in the test definition and indicates 
if each step was successful or failed (Figure 11-10). Results are displayed as OK or 
Error. 
Figure 11-10. Measurement results — Info-Calculation 
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11.2.11 Viewing Evaluation Summary Results 
Result-List (Figure 11-11) displays a summary of test evaluation data including 
standard curve results, cutoff groups, replicate rejection and test validation formula 
summaries, and individual well data (Figure 11-11). 
Note: Use the scroll bar to view all information displayed in Result-List. 
Note: This Result-List contains different data than the Result-List for individual 
sample IDs (refer to Section 11.3.1.3, Viewing, Printing, and Copying Individual 
Sample ID Information). 
Figure 11-11. Measurement results — Result-List 
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11.3 Viewing Multitest Measurement Results 
After a Multitest measurement is completed, all applicable measurement results are 
displayed for each test performed. Measurement results are displayed one test at a 
time (Figure 11-12). 
Note: Sample IDs assigned during the Multitest configuration are displayed in the 
Sample-ID tab (refer to Section 11.3.1, Viewing Sample IDs For Multitest Assays). 
Figure 11-12. Multitest measurement results 
Note: Refer to Section 7.3, Viewing Quick Measurement Results, and Section 11.2, 
Viewing Test Measurement Results, to learn more about the individual measurement 
result tabs. 
To view results from another test on the plate: 
Choose next Test to view the following test results. 
OR 
Choose previous Test to view the preceding test results. 
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11.3.1 Viewing Sample IDs For Multitest Assays 
In measurement results for Multitest assays, Sample-ID (Figure 11-13) displays the 
sample IDs assigned when the Multitest assay was defined (refer to Section 9.2.2, 
Assigning Sample IDs). Existing sample IDs may be edited in Sample-ID. 
In measurement results for a single test, sample IDs must be added after the test is 
performed; they cannot be assigned in the test definition. Sample IDs may be 
assigned manually or imported from a text (*txt) file, and can be saved and edited as 
desired. 
Note: In Multitest assay measurement results, sample IDs are displayed one test at a 
time. The name of the displayed test appears in the title bar. Choose previous Test 
or next Test to view sample IDs from other tests in the assay. 
Figure 11-13. Measurement results — Sample-ID 
Sample ID data may be: 
• Manually entered in Sample-ID (refer to Section 11.3.1.1, Manually 
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Entering Sample IDs). 
• Imported from text files (refer to Section 11.3.1.2, Importing Sample IDs 
From Text Files). 
• Viewed in detail on an individual well basis (refer to Section 11.3.1.3, 
Viewing, Printing, and Copying Individual Sample ID Information). 
• Printed out or copied to another application (refer to Section 11.3.1.3.1, 
Printing Sample ID Information). 
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11.3.1.1 Manually Entering Sample IDs 
Sample IDs may be entered one at a time for individual wells. 
To manually enter sample IDs: 
1. Choose Sample-ID. 
2. From the Options menu, choose Edit Sample-ID>Manual (Figure 11-14). 
Note: The Edit Sample-ID function is only available when Sample- 
ID is the tab displayed. 
Figure 11-14. Edit Sample-ID 
3. Click the desired well in the layout and enter the new sample ID. 
4. Repeat step 3 until all desired sample IDs are entered. 
11.3.1.2 Importing Sample IDs From Text Files 
Sample IDs may be imported from standard text files or text files configured 
specifically for 96-well plates. 
To import sample IDs from a text file: 
1. Choose Sample-ID. 
2. In the Option menu, select Edit Sample-ID>: 
• File H12 x V8 to import a text file specifically configured for a 96-well 
plate with 12 horizontal positions and 8 vertical positions. 
OR 
• File H8 x V12 to import a text file specifically configured for a 96-well 
plate with 8 horizontal positions and 12 vertical positions. 
OR 
• List of Sample-ID to import any text file. 
Note: Sample IDs in a standard text file must be listed on 
separate lines. 
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11.3.1.3 Viewing, Printing, and Copying Individual 
Sample ID Information 
Test information relevant to each sample ID well may be viewed, printed or copied to 
another file. Sample ID information that may be viewed includes sample ID, test 
name, well data results, plate layout position, plate number, and validation status. 
To view individual sample ID information: 
1. Choose List Sample-ID. Selection appears (Figure 11-15). 
Figure 11-15. Selection — sample IDs 
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2. Select the desired sample ID to view and choose OK. Result-List appears 
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(Figure 11-16) 
Note: To select several sample IDs to display in Result-List, hold Ctrl 
while selecting sample IDs. 
Note: Choose Matchcode to search for specific sample IDs by 
characters in the sample ID name (refer to Section 8.4.1, Using 
Matchcode to Search for Test Definitions Stored In the ADAP Software 
Database). 
Figure 11-16. Sample ID information in Result-List 
Note: If a sample ID has been used in several tests, results for all tests are displayed 
by date in Result-List. 
Note: Choose Close to return to the test measurement results. 
The sample ID data in Result-List can be printed or copied into another application. 
• To print the contents of Result-List, refer to Section 11.3.1.3.1, Printing 
Sample ID Information. 
• To copy the contents of Result-List so that it can be used in another 
application, refer to Section 11.3.1.3.2, Copying Sample ID Information to 
Another Application. 
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11.3.1.3.1 Printing Sample ID Information 
Sample ID data displayed in Result-List may be printed. 
To print sample ID data: 
1. Choose Print. Print appears (Figure 11-17). 
Figure 11-17. Print — Result-List 
2. In Printer, select the desired printer to use to print the information. All printers 
that are properly installed and configured on the computer are listed. 
3. In Mode, select Form feed after each Sample-ID to print each sample ID on 
a separate page, if desired. 
4. In Options, select the desired Font for the report, the Size of the printed text, 
and the number of Copies to print. 
Note: Body text is printed in the selected Font and Size. Headlines, 
headings, and table text are printed using formatting defined by the 
ADAP software. 
5. Choose OK to print the raw data. 
6. Choose OK to print the sample ID data, or Cancel to abort printing. 
Note: If the selected printer is configured to print to a file, such as an Acrobat® PDF 
(*.pdf), a prompt asking for the filename appears. The printed file is saved to the 
ADAP software home directory. 
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11.3.1.3.2 Copying Sample ID Information to Another 
Application 
Sample ID data can be copied into another application, such as a word processor, 
using the clipboard. 
To copy sample ID data to the clipboard: 
1. Choose Clipboard. Sample ID data is copied to the clipboard. 
2. Open or switch to the application you want to paste the sample ID data to, and 
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paste the data. 
Note: Most applications have CTRL+V assigned as the Paste 
command keyboard shortcut. 
Note: Choose Close to return to the Multitest results. 
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11.4 Recalculating Test Results 
After the completion of tests configured in the ELISA module, raw data associated 
with the test can be recalculated with different parameters, such as cutoff formulas, 
validation formulas, standards, and standard curve fits. 
Individual wells may be rejected as outliers. Tests can be recalculated with these 
outliers eliminated. 
Note: Only tests configured in the ELISA module may be recalculated; tests 
configured in the Quantitation module may not. 
11.4.1 Recalculating Test Results 
To recalculate results: 
1. From the Options menu, select Formula. 
OR 
Right-click on the displayed measurement results, and select Formula. The 
name of the most recently run test appears (Figure 11-18). 
Figure 11-18. Choosing Point_2, the most recently run test, to recalculate 
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2. Choose the test definition name. A window named for the test definition name 
appears (Figure 11-19). 
Figure 11-19. Point_2 to recalculate 
3. In Cutoff Formula, if desired, enter up to four new formulas to create new cutoff 
groups (refer to Section 8.2.4.1, Configuring Groups and Cutoff Formulas). 
4. In Validation, if desired, enter up to five new test validation formulas to use to 
validate the measurement results (refer to Section 8.2.8, Programming Rejection/ 
Validation Formulas). 
5. In Standards, if desired, enter new response formulas and concentrations to 
create a new standard curve and recalculate concentration values (refer to Section 
8.2.3.1, Configuring Standards). 
6. In Standards, if desired, choose a new Curve fit method to plot a new standard 
curve and recalculate the concentration values (refer to Section 8.2.3.2, 
Configuring Standard Curve Parameters). 
7. In Standards, if desired, select a new Axis scale to plot the standard curve on a 
new scale (refer to Section 8.2.3.2, Configuring Standard Curve Parameters). 
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8. When the new parameters have been entered as desired, choose OK. The test is 
automatically recalculated and the new measurement results displayed. 
Note: A message may appear stating that the plate data exists (Figure 
11-1). Choose Yes to overwrite the existing plate data with the 
recalculated plate data, No to enter a new plate ID and save the 
recalculated plate data as a separate plate, or Cancel to cancel any 
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changes and return to the measurement results of the test. 
Figure 11-1. Plate exists message 
OR 
Choose Cancel to cancel any changes and return to the original test 
measurement results. 
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11.4.2 Rejecting Outliers and Recalculating 
Results 
Individual wells may be rejected as outliers. Tests can be recalculated with these 
outliers eliminated. 
Note: Only tests configured in the ELISA module may be recalculated with outliers 
eliminated; tests configured in the Quantitation module may not. 
To reject outliers and recalculate test results: 
1. In any measurement results tab that displays well data in plate format, click the 
well to reject. 
2. From the Options menu, choose Delete Well. 
OR 
Right click the well to reject and select Delete Well. The selected well is labeled 
Rejected. 
Note: To reject multiple wells simultaneously, click and drag over the 
wells to be rejected and choose Delete Well as described in step 2 
above. 
3. When all wells to be rejected have been marked as such, on the toolbar, choose 
Calculate. Message appears (Figure 11-20). 
Figure 11-20. Message — Are you sure you want to recalculate? 
4. Choose Yes to recalculate the test measurements. 
OR 
Choose No to cancel the recalculation. 
Note: A message appears stating that the plate data exists (Figure 11- 
1). Choose Yes to overwrite the existing plate data with the recalculated 
plate data, No to enter a new plate ID and save the recalculated plate 
data as a separate plate, or Cancel to cancel any changes and return to 
the original measurement results of the test. 
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11.4.3 Restoring Wells Rejected in Prior 
Calculations 
Raw data from wells rejected as outliers is not included in recalculated 
measurements. However, this raw data has not been deleted from the database and 
may be restored in future calculations, if desired. 
To restore a rejected well: 
1. In any measurement results tab that displays well data in plate format, click the 
well to restore. 
Note: Wells can be restored in any test measurement tab that displays 
well data in plate format. To easily find out which wells have been 
rejected, view the Plate Layout or Sample-ID display. 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

2. From the Options menu, choose Restore Well. 
OR 
Right-click the well to restore and choose Restore Well. The selected well is 
labeled Restored. 
Note: To restore multiple wells simultaneously, click and drag over the 
wells to restore and choose Restore Well as described in step 2 above. 
3. When all wells to be restored have been marked as such, on the toolbar, choose 
Calculate. Message appears (Figure 11-20). 
4. Choose Yes to recalculate the test measurements. 
OR 
Choose No to cancel the recalculation. 
Note: A message may appear stating that the plate data exists (Figure 
11-1). Choose Yes to overwrite the existing plate data with the 
recalculated plate data, No to enter a new plate ID and save the 
recalculated plate data as a separate plate, or Cancel to cancel any 
changes and return to the measurement results of the test. 
Viewing Test and Multitest Measurements 11-27 
ADAP Software for Zenyth 200 Operating Manual 
11.5 Printing Measurement Results 
A summary of the measurement results can be printed to any connected printer or to a 
file; for example, a PostScript® or Acrobat® PDF file. 
The summary printout includes information about who performed the measurement, 
when it was performed, and when the results were printed. Figure 11-21 shows how 
the actual measurement results are laid out on the page. Results for each well are laid 
out according to the Legend. 
Note: The measurement results that are included in the printout are selected in 
Options when configuring the test definition (refer to Section 8.2.5, Configuring Test 
Options). 
Figure 11-21. Test measurement results printout (excerpt) 
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To print out the measurement results summary: 
1. From the Setup menu, select Print. Print appears (Figure 11-22). 
Figure 11-22. Print 
2. In Printer, select the desired printer to use to print the measurement results 
summary. All printers that are properly installed and configured on the computer 
are listed. 
3. In range, select whether to print All Tests or a Single Test. 
Note: Selecting All Tests is only applicable for Multitest assays. 
4. In Test, select the Test to print summary results for. 
5. In Options, select the desired Font, text Size, and number of Copies. 
Note: Body text is printed in the selected Font and Size. Headlines 
and headings are printed using formatting defined by the ADAP 
software. 
6. Choose OK to print the measurement results summary. 
Note: If the selected printer is configured to print to a file, such as an 
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The 
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printed file is saved to the ADAP software home directory. 
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11.6 Exporting Measurement Results to Other 
Applications 
Measurement results can be exported to other applications for further analysis or 
manipulation. The ADAP software provides three methods to export test 
measurement data: 
• Data can be copied to the clipboard and pasted into another application such 
as a word processor (refer to Section 11.6.1, Copying Measurement Results 
to Clipboard). 
• Data can be saved to a text file and then opened by or imported into another 
application (refer to Section 11.6.2, Saving Measurement Results as Text 
Files). 
• The entire test measurement database can be exported and opened in 
Microsoft® Access or a compatible database application (refer to Section 
11.6.3, Exporting the Database). 
11.6.1 Copying Measurement Results to 
Clipboard 
The measurement results displayed in any tab can be copied to the clipboard. The data 
in the clipboard can then be pasted into any other application for storage or further 
analysis. 
Note: For example, the clipboard data could be pasted into a Microsoft® Excel 
spreadsheet with formulas or macros already created such that some preliminary 
analysis is automatically performed once the data is pasted into the document. 
To copy measurement results to the clipboard: 
1. Select the desired results tab to copy to the clipboard. 
Note: When copying the Raw Data tab, only the measurement results 
shown for the cycle are copied. To copy all raw data results, each cycle 
needs to be copied individually, or Copy all data into clipboard needs 
to be selected. 
2. From the Options menu, choose Copy displayed data into clipboard to 
copy only the displayed results to the clipboard. 
OR 
Choose Copy all data into clipboard to copy all measurement results to the 
clipboard. 
3. Open or switch to the application where measurement results will be pasted. 
4. Paste the measurement results into a new or existing file using the Paste 
command for the application. 
Note: Most applications have a standard shortcut of CTRL+V 
assigned to the Paste command. 
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11.6.2 Saving Measurement Results as Text Files 
Measurement results can be saved to text files which can be viewed in any text editor 
or imported into many statistical software packages or spreadsheet applications. 
To save measurement results to a text file: 
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1. Select the desired results tab to save as a text file. 
2. From the Options menu, choose Save displayed data as TXT to save only 
the displayed results as a text file. 
OR 
From the Options menu, choose Save all data as TXT to save all 
measurement results in one text file. 
OR 
Select the desired command from the toolbar. 
Note: When saving Raw Data to a text file, choosing Save 
displayed data as TXT copies only the cycle or well displayed. To 
save raw data results for all cycles or wells measured, choose Save all 
data as TXT. 
3. Save As appears. Browse to the desired location to save the data. 
Note: If the ADAP software is configured in Setup-System to automatically save 
measurement results as text files, these files may also be opened in a text editor or 
other application. Refer to Section 3.3, Configuring System Settings for information 
about configuring the ADAP software to automatically save measurement results as 
text files. 
11.6.3 Exporting the Database 
To preserve data integrity, all measurement results are stored in a database that can 
only be accessed by the ADAP software. However, the database can be exported in 
Microsoft® Access format and opened by Access or a compatible database 
application. 
To export the database: 
1. From the Database menu, choose Export Database. A copy of the database 
named PlateDataReplica.mdb is exported to the ADAP software default 
directory. 
2. Choose OK when prompted to complete the export. 
3. Open PlateDataReplica in Access or a compatible database application. 
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11.7 Working with Measurement Results Stored in 
the ADAP Database 
The ADAP software automatically saves raw data from all measured plates and 
cuvettes in a database. Saved data for any measured plate or cuvette can be accessed 
from the Database menu. 
The Database menu contains options to: 
• Open or delete saved measurement results (refer to Section 11.7.1, Opening 
or Deleting Measurement Results Stored In the Database). 
• Save plate data to the database (refer to Section 11.7.2, Saving Measurement 
Results to the Database). 
• Repair the database (refer to Section 11.7.3, Repairing and Compressing the 
Database). 
• Compress the database (refer to Section 11.7.3, Repairing and Compressing 
the Database). 
11.7.1 Opening or Deleting Measurement Results 
Stored In the Database 
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To open or delete measurement results from the database: 
1. From the Database menu, select Open Saved Plate. Selection appears and 
displays a list of all the stored plates and cuvettes (Figure 11-23). 
Figure 11-23. Selection — stored plates and cuvettes 
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2. Select the desired plate or cuvette to open or delete. 
Note: To narrow the list by date, select dates in from and to, and 
choose update list. 
To search for a specific plate ID by characters in the Plate ID name, 
choose Matchcode (refer to Section 8.4.1, Using Matchcode to Search 
for Test Definitions Stored In the ADAP Software Database). 
3. Choose OK to open the measurement results for viewing. 
OR 
Double-click the desired plate. The measurement results appear in the main 
window. 
OR 
Choose Delete to remove the measurement results for the selected plate or 
cuvette from the database. 
11.7.2 Saving Measurement Results to the 
Database 
Raw data of measured plates and cuvettes is automatically saved to the database when 
a measurement is complete. Measurement results can also be saved to the database 
manually or to a text file outside the database. 
To save measurement results to the database: 
From the Database menu, choose Save Actual Data. The plate data is saved 
to the database. 
To save measurement results as a text file separate from the database: 
From the Database menu, choose Save as TXT-File. The measurement results 
are saved as a text file that is separate from the database and can be opened by 
many applications such as text editors, word processors, and spreadsheets. 
11.7.3 Repairing and Compressing the Database 
When measurement results or test definitions are removed from the database, only the 
data is deleted from the fields. The empty data fields remain, which increases the size 
of the database, which may slow down access. Periodically, it is recommended to 
remove empty fields using Compress Database. Repair Database removes 
unassigned entries from the database before compressing it. 
To repair or compress the database: 
From the Database menu, choose Repair Database to remove unassigned 
entries and empty fields. The database is repaired. 
OR 
From the Database menu, select Compress Database to remove empty 
fields. The database is compressed. 
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12 Running Cuvette Applications 
12.1 Overview 
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Note: A valid license code for the ADAP Prisma software is required to access the 
functions covered in this chapter. Refer to Section 1.3, Launching the ADAP Software 
for information about license codes. 
The ADAP software provides a set of predefined cuvette applications. All nine 
applications are configured and run from the Applications tab in the Quantitation 
Module Test Definition (Figure 12-1). All authorized users may configure and 
perform cuvette applications. 
Figure 12-1. Cuvette Applications 
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To configure, run, and view measurement results for a cuvette application: 
• Open the Applications tab, choose the desired application, and configure 
Application Parameters (refer to Section 12.2, Configuring Cuvette 
Applications). 
• Run the application (refer to Section 12.3, Running Cuvette Applications). 
• View the measurement results (refer to Section 12.4, Viewing Cuvette 
Application Measurement Results). 
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12.2 Configuring Cuvette Applications 
Cuvette applications are selected, configured, and run from the Applications tab in 
Quantitation Module Test Definition. 
To open the Applications tab: 
1. From the toolbar, toggle the Elisa/Quantitation selection button to 
Quantitation, if necessary. 
2. From the Setup menu, choose Test Definition. 
OR 
From the toolbar, choose Create/Edit Calculation. Quantitation Module 
Test Definition appears (Figure 12-2). 
Note: For users with User Level 1 access, Quantitation Module Test 
Definition opens with only the Applications tab visible. For users with 
higher access levels, Quantitation Module Test Definition opens to 
the General tab. 
Figure 12-2. Quantitation Module Test Definition 
3. If the General tab is displayed, choose the Applications tab to configure 
cuvette applications. 
Applications tab 
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4. Choose the desired Application and configure Application Parameters 
following the steps listed in its respective section: 
• Cell counting (refer to Section 12.2.1, Configuring a Cell Counting Cuvette 
Application). 
• DNA — Concentration and Purity (refer to Section 12.2.2, Configuring a 
DNA — Concentration and Purity Cuvette Application). 
• DNA — Oligo Long Concentration Melting Point (refer to Section 12.2.3, 
Configuring a DNA — Oligo Long Concentration Melting Point Cuvette 
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Application). 
• DNA — Oligo Short Concentration Melting Point (refer to Section 
12.2.4, Configuring a DNA — Oligo Short Concentration Melting Point 
Cuvette Application). 
• DNA — pure dsDNA Concentration (refer to Section 12.2.5, Configuring 
a DNA — Pure dsDNA Concentration Cuvette Application). 
• DNA — pure ssDNA Concentration (refer to Section 12.2.6, Configuring 
a DNA — Pure ssDNA Concentration Cuvette Application). 
• UV-Quantitation Protein (refer to Section 12.2.7, Configuring a UVQuantitation 
Protein Cuvette Application). 
• RNA — Oligo Concentration (refer to Section 12.2.8, Configuring an RNA 
— Oligo Concentration Cuvette Application). 
• RNA — pure RNA Concentration (refer to Section 12.2.9, Configuring an 
RNA — Pure RNA Concentration Cuvette Application). 
Note: To perform cuvette applications on a standalone Zenyth 200st using the 
ADAP software, put the instrument in Remote Control mode. Refer to the 
instrument user’s manual for more information about Remote Control mode. 
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12.2.1 Configuring a Cell Counting Cuvette 
Application 
The cell counting cuvette application is useful for monitoring the growth of bacterial 
cultures. An absorbance measurement is made at 600 nm. The measurement value is 
multiplied by a dilution factor and conversion factor to determine the concentration of 
cells per ml. 
To configure the cell counting cuvette application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications 
2. In the Applications pane, if a + appears to the left of Cells, choose the + or 
Cells to open the tree view. Cell counting appears under Cells. 
3. Choose Cell counting. Application Parameters displays parameters that can 
be configured and information about the application (Figure 12-3). 
Figure 12-3. Cell counting cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Enter a new Conversion factor, if desired. 
Note: The conversion factor is multiplied by the absorbance 
measurement and dilution factor to calculate the concentration of cells 
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per ml. 
Note: The default conversion factor is 5*10^8 (5x108). Use this 
format for exponential notation. 
7. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.1, Viewing Cell Counting Measurement Results, for 
information about how measurement results for this application are reported. 
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12.2.2 Configuring a DNA — Concentration and 
Purity Cuvette Application 
The DNA — Concentration and Purity cuvette application measures the approximate 
purity of nucleic acid preparations by calculating the ratio between absorbance at 260 
nm and 280 nm. Pure DNA preparations have ratios of about 1.8; pure RNA 
preparations have ratios of about 2.0. If desired, background correction may be 
applied to measurements. 
To configure the DNA — Concentration and Purity cuvette application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications 
2. In the Applications pane, if a + appears to the left of DNA, choose the + or DNA 
to open the tree view. Concentration and Purity appears in the list under DNA. 
3. Choose Concentration and Purity. Application Parameters displays 
parameters that can be configured and information about the application (Figure 
12-4). 
Figure 12-4. DNA — Concentration and Purity cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Select Background Correction, if desired. 
Note: Background Correction performs a third measurement at 320 
nm. This value is subtracted from the 260 nm and 280 nm values before 
the ratio between them is calculated. 
7. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.2, Viewing DNA — Concentration and Purity 
Measurement Results, for information about how measurement results for this 
application are reported. 
Running Cuvette Applications 12-9 
ADAP Software for Zenyth 200 Operating Manual 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

12.2.3 Configuring a DNA — Oligo Long 
Concentration Melting Point Cuvette 
Application 
The DNA — Oligo Long Concentration Melting Point cuvette application calculates 
the concentration and melting point of oligos with base sequences containing a 
minimum of 25 base pairs. If desired, background correction and a salt factor may be 
applied to measurements. 
Note: Use the DNA — Oligo Short Concentration Melting Point cuvette application 
to calculate concentration and melting points of oligos with base sequences 
containing fewer than 25 base pairs (refer to Section 12.2.4, Configuring a DNA — 
Oligo Short Concentration Melting Point Cuvette Application). 
To configure the DNA — Oligo Long Concentration Melting Point cuvette 
application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications 
2. In the Applications pane, if a + appears to the left of DNA, choose the + or DNA 
to open the tree view. Oligo Long Concentration Melting Point appears in the 
list under DNA. 
3. Choose Oligo Long Concentration Melting Point. Application 
Parameters displays parameters that can be configured and information about 
the application (Figure 12-5). 
Figure 12-5. DNA — Oligo Long Concentration Melting Point cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Enter the Base Sequence of the oligo; for example, 
ctagctgtagtcgatcgattagatgcgca. The base sequence must contain a 
minimum of 25 base pairs. 
Note: Use the DNA — Oligo Short Concentration Melting Point 
cuvette application to calculate concentration and melting points on 
oligos with base sequences containing fewer than 25 base pairs (refer to 
Section 12.2.4, Configuring a DNA — Oligo Short Concentration 
Melting Point Cuvette Application). 
7. Enter a new Salt factor, if desired. 
Note: The salt factor compensates for the salinity of the DNA solution. 
The default salt factor is 10. 
8. Select Background correction, if desired. 
Note: Background Correction performs a second measurement at 
320 nm. This value is subtracted from the 260 nm measurement value 
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before calculating the final measurement results. 
9. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.3, Viewing DNA and RNA Oligo Measurement Results, 
for information about how measurement results for this application are reported. 
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12.2.4 Configuring a DNA — Oligo Short 
Concentration Melting Point Cuvette 
Application 
The DNA — Oligo Short Concentration Melting Point cuvette application calculates 
the concentration and melting point of oligos with base sequences containing fewer 
than 25 base pairs. If desired, background correction and a salt factor may be applied 
to measurements. 
Note: Use the DNA — Oligo Long Concentration Melting Point cuvette application 
to calculate concentration and melting points of oligos with base sequences 
containing 25 or more base pairs (refer to Section 12.2.3, Configuring a DNA — 
Oligo Long Concentration Melting Point Cuvette Application). 
To configure the DNA — Oligo Short Concentration Melting Point cuvette 
application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications 
2. In the Applications pane, if a + appears to the left of DNA, choose the + or DNA 
to open the tree view. Oligo Short Concentration Melting Point appears in the 
list under DNA. 
3. Choose Oligo Short Concentration Melting Point. Application 
Parameters displays parameters that can be configured and information about 
the application (Figure 12-6). 
Figure 12-6. DNA — Oligo Short Concentration Melting Point cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Enter the Base Sequence of the oligo; for example, agctagctagctagctagct. 
The base sequence must contain a fewer than 25 base pairs. 
Note: Use the DNA — Oligo Long Concentration Melting Point 
cuvette application to calculate concentration and melting points on 
oligos with base sequences containing 25 or more base pairs (refer to 
Section 12.2.3, Configuring a DNA — Oligo Long Concentration 
Melting Point Cuvette Application). 
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7. Enter a new Salt factor, if desired. 
Note: The salt factor compensates for the salinity of the DNA solution. 
The default salt factor is 10. 
8. Select Background correction, if desired. 
Note: Background Correction performs a second measurement at 
320 nm. This value is subtracted from the 260 nm measurement value 
before calculating the final measurement results. 
9. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.3, Viewing DNA and RNA Oligo Measurement Results, 
for information about how measurement results for this application are reported. 
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12.2.5 Configuring a DNA — Pure dsDNA 
Concentration Cuvette Application 
The DNA — Pure dsDNA Concentration cuvette application measures nucleic acid 
concentrations of dsDNA by performing a measurement at 260 nm, and then 
multiplying the measurement value by a conversion factor and a dilution factor. If 
desired, background correction may be applied to measurements. 
To configure the DNA — Pure dsDNA Concentration cuvette application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications. 
2. In the Applications pane, if a + appears to the left of DNA, choose the + or DNA 
to open the tree view. pure dsDNA Concentration appears in the list under 
DNA. 
3. Choose pure dsDNA Concentration. Application Parameters displays 
parameters that can be configured and information about the application 
(Figure 12-7). 
Figure 12-7. DNA — Pure dsDNA Concentration cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Enter a new Conversion Factor, if desired. 
Note: The default conversion factor is 50. 
7. Select Background correction, if desired. 
Note: Background Correction performs a second measurement at 
320 nm. This value is subtracted from the 260 nm measurement value 
before calculating the final measurement results. 
8. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
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application. 
Note: Refer to Section 12.4.4, Viewing Pure dsDNA, ssDNA, and RNA 
Concentration Measurement Results, for information about how measurement results 
for this application are reported. 
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12.2.6 Configuring a DNA — Pure ssDNA 
Concentration Cuvette Application 
The DNA — Pure ssDNA Concentration cuvette application measures nucleic acid 
concentrations of ssDNA by performing a measurement at 260 nm, and then 
multiplying the measurement value by a conversion factor and a dilution factor. If 
desired, background correction may be applied to measurements. 
To configure the DNA — Pure ssDNA Concentration cuvette application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications 
2. In the Applications pane, if a + appears to the left of DNA, choose the + or DNA 
to open the tree view. Pure ssDNA Concentration appears in the list under 
DNA. 
3. Choose Pure ssDNA Concentration. Application Parameters displays 
parameters that can be configured and information about the application 
(Figure 12-8). 
Figure 12-8. DNA — Pure ssDNA Concentration cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Enter a new Conversion Factor, if desired. 
Note: The default conversion factor is 37. 
7. Select Background correction, if desired. 
Note: Background Correction performs a second measurement at 
320 nm. This value is subtracted from the 260 nm measurement value 
before calculating the final measurement results. 
8. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.4, Viewing Pure dsDNA, ssDNA, and RNA 
Concentration Measurement Results, for information about how measurement results 
for this application are reported. 
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12.2.7 Configuring a UV-Quantitation Protein 
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Cuvette Application 
The UV-Quantitation Protein cuvette application calculates protein concentrations in 
nucleic acid backgrounds such as crude cell extracts. The application performs 
measurements at 260 and 280 nm. A background reading is made at 320 nm, and is 
subtracted from both measurements. Two conversion factors are required—one for 
each measurement result—and multiplied by the measurement results. 
To configure the UV-Quantitation Protein application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications 
1. In the Applications pane, if a + appears to the left of Protein, choose the + or 
Protein to open the tree view. UV-Quantitation Protein appears under Protein. 
2. Choose UV-Quantitation Protein. Application Parameters displays 
parameters that can be configured and information about the application (Figure 
12-9). 
Figure 12-9. UV-Quantitation Protein cuvette application 
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3. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
4. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
5. Enter a new Conversion factor 1, if desired. 
Note: The default value for conversion factor 1 is 1.55. 
6. Enter a new Conversion factor 2, if desired. 
Note: The default value for conversion factor 2 is 0.76. 
7. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.5, Viewing UV-Quantitation Protein Measurement 
Results, for information about how measurement results for this application are 
reported. 
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12.2.8 Configuring an RNA — Oligo 
Concentration Cuvette Application 
The RNA — Oligo Concentration cuvette application calculates the concentration 
of oligos. If desired, background correction may be applied to measurements. 
To configure the RNA — Oligo Concentration cuvette application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications 
2. In the Applications pane, if a + appears to the left of RNA, choose the + or RNA 
to open the tree view. Oligo Concentration appears in the list under RNA. 
3. Choose Oligo Concentration. Application Parameters displays parameters 
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that can be configured and information about the application (Figure 12-10). 
Figure 12-10. RNA — Oligo Concentration cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Enter the Base Sequence of the oligo; for example, acgacgacuuacgacagc. 
7. Select Background correction, if desired. 
Note: Background Correction performs a second measurement at 
320 nm. This value is subtracted from the 260 nm measurement value 
before calculating the final measurement results. 
8. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.3, Viewing DNA and RNA Oligo Measurement Results, 
for information about how measurement results for this application are reported. 
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12.2.9 Configuring an RNA — Pure RNA 
Concentration Cuvette Application 
The RNA — Pure RNA Concentration cuvette application measures nucleic acid 
concentrations of RNA by performing a measurement at 260 nm, and then 
multiplying the measurement value by a conversion factor and a dilution factor. If 
desired, background correction may be applied to measurements. 
To configure the RNA — Pure RNA Concentration cuvette application: 
1. Open the Applications tab following the steps in Section 12.2, Configuring 
Cuvette Applications. 
2. In the Applications pane, if a + appears to the left of RNA, choose the + or RNA 
to open the tree view. Pure RNA Concentration appears in the list under RNA. 
3. Choose Pure RNA Concentration. Application Parameters displays 
parameters that can be configured and information about the application 
(Figure 12-11). 
Figure 12-11. RNA — Pure RNA Concentration cuvette application 
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4. In Application Parameters enter a Sample Count. 
Note: Up to 50 cuvette samples may be measured in a single cuvette 
application. 
5. Enter a new Dilution Factor, if desired. 
Note: The dilution factor specifies the dilution of the samples 
measured, which the ADAP software uses to calculate the concentration 
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of an undiluted sample. 
Note: The dilution factor is the same for all samples run in a 
measurement. 
6. Enter a new Conversion Factor, if desired. 
Note: The default conversion factor is 40. 
7. Select Background correction, if desired. 
Note: Background Correction performs a second measurement at 
320. This value is subtracted from the 260 nm measurement value 
before calculating the final measurement results. 
8. Follow the steps in Section 12.3, Running Cuvette Applications to start the 
application. 
Note: Refer to Section 12.4.4, Viewing Pure dsDNA, ssDNA, and RNA 
Concentration Measurement Results, for information about how measurement results 
for this application are reported. 
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12.3 Running Cuvette Applications 
Cuvette samples are manually loaded into the cuvette holder at the back of the 
instrument after the cuvette application is configured and the light output from the 
lamp has stabilized. 
Running cuvette measurements is controlled from Cuvette Reading, which includes 
options to perform blank measurements and re-read samples. When the measurement 
is complete, the results are previewed in Cuvette Reading. 
Note: Refer to Section 12.3.1, Reading Cuvette Blank Samples for more information 
about reading blank samples. 
To run a cuvette application: 
1. After configuring the Application Parameters, in the Applications tab, choose 
Run Application (Figure 12-12). Cuvette Reading appears (Figure 12-13). 
Figure 12-12. Applications tab 
Run Application 
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2. In Samples to read, select the sample ID for the first sample to read. 
Note: Action provides instructional prompts throughout the reading. 
Note: Do not insert the cuvette into the cuvette holder until prompted. 
Note: The instrument can be initialized by choosing Initialize 
Instrument from the Option menu. Refer to Table 4-1 for more 
information about initializing the instrument. 
Figure 12-13. Cuvette Reading — Select sample to read 
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3. Choose Read to start the measurement. Before inserting the cuvette into 
the cuvette holder, allow the instrument to initialize and stabilize the light output 
of the lamp (Figure 12-14). Place Cuvette appears in Action when the cuvette 
may be loaded. 
Note: To perform a blank measurement before reading cuvette 
samples, refer to Section 12.3.1, Reading Cuvette Blank Samples. 
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Note: Time left displays the time remaining until lamp stabilization is 
complete. Lamp stabilization may take up to 60 seconds. 
After 10 minutes of inactivity, the Zenyth 200 automatically turns the 
lamp off. The next cuvette measurement performed will require the 
maximum 60-second lamp stabilization time. 
Figure 12-14. Cuvette Reading — Lamp stabilization 
4. When lamp stabilization is complete, insert the cuvette into the cuvette holder 
within 20 seconds (Figure 12-15). The measurement begins automatically. 
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5. When Place Cuvette appears in Action, insert the cuvette into the cuvette 
holder with the clear sides facing the left and right sides of the instrument (Figure 
12-15). The measurement begins automatically once the cuvette is loaded. 
Note: For all types of measurements except kinetic, the cuvette must 
be placed in the holder within 20 seconds after Place Cuvette appears. 
Time left displays the time remaining to insert the cuvette. If the 20 
seconds expires before the cuvette is inserted in the cuvette holder, the 
error, Bright measurement not valid any longer, appears. Choose 
Read to perform a new lamp stabilization. 
Note: The cuvette holder door does not need to be closed during the 
measurement. Refer to the instrument user manual for more details on 
inserting cuvettes into the cuvette holder. 
Note: Choose Stop Measurement or File>Cancel to cancel an 
application in progress. 
Figure 12-15. Cuvette Reading — Place Cuvette 
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6. When the measurement is complete, remove the cuvette. Samples Read 
displays sample IDs and the status of the measurement: OK or Error. The OD 
measured is displayed in Actual Value (Figure 12-16). 
Figure 12-16. Cuvette Reading — endpoint results with Actual Value 
7. In Samples to read, select the next sample to read and repeat steps 3 – 6 to 
perform the cuvette application again. 
Note: The number of samples to read is entered in Sample Count in 
the Applications tab. 
OR 
If desired, in Samples read, select a sample, choose Reread, and repeat steps 4 
and 6 to perform the cuvette application on that sample again. 
OR 
From the File menu, choose End to close Cuvette Reading and save the 
measurement results. Plate-ID appears (Figure 12-17). 
Figure 12-17. Plate-ID for a cuvette measurement 
Actual Value 
Displays OD after an 
endpoint measurement. 
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8. In Input Plate-ID, rename the measurement results, if desired. 
9. Choose OK to save the measurement results to the database. 
Note: The default name format for saved cuvette measurements is YYYYMMDDNc, 
where YYYY is the year, MM the month, DD the day, N the number of the 
measurement made that day, and c denotes cuvette. 
Note: Refer to Section 12.4, Viewing Cuvette Application Measurement Results for 
information about how measurement results are reported. 
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12.3.1 Reading Cuvette Blank Samples 
A blank sample may be run before running the cuvette application on samples. The 
blank value is subtracted from the measurement results for subsequent samples 
measured in the cuvette application. 
Note: If desired, a new blank sample can be read at any point during a cuvette 
application. The new blank value is then subtracted from subsequent measurements. 
To read a blank sample: 
1. Choose Read Blank. Before inserting the blank sample into the cuvette holder, 
the instrument must stabilize the light output of the lamp. 
Note: Time left displays the time remaining until lamp stabilization is 
complete. Lamp stabilization may take up to 60 seconds. 
Figure 12-18. Cuvette Reading — Lamp stabilization time 
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2. When Place Cuvette appears in Action, insert the cuvette into the cuvette 
holder with the clear sides facing the left and right sides of the instrument. The 
blank measurement begins automatically once the cuvette is loaded. 
Note: For all types of measurements except kinetic, the cuvette must 
be placed in the holder within 20 seconds after Place Cuvette appears. 
Time left displays the time remaining to insert the cuvette. If the 20 
seconds expires before the cuvette is inserted in the cuvette holder, the 
error, Bright measurement not valid any longer, appears. Choose 
Read Blank to perform a new lamp stabilization. 
Note: The cuvette holder door does not need to be closed during the 
measurement. Refer to the instrument user manual for more details on 
inserting cuvettes into the cuvette holder. 
Note: Choose Stop Measurement to cancel a blank measurement in 
progress. 
3. When the blank measurement is complete, remove the cuvette. The blank value 
obtained will be automatically subtracted from following cuvette measurements. 
Note: *Blank Active* is displayed onscreen when a blank 
measurement is being used in the calculation of measurement results. 
4. To perform measurements on cuvette samples and save the measurement results, 
follow steps 2–8 in Section 6.4, Running and Saving Quick Measurements on 
Cuvette Samples. 
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12.4 Viewing Cuvette Application Measurement 
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Results 
After measurements are performed on all samples in a cuvette application, the 
measurement results are displayed in a series of tabs in the ADAP software main 
window. The tabs displayed vary depending on which cuvette application was 
performed: 
• Cell Counting — Displays OD, Info-Calc, Result-List, and Status (refer to 
Section 12.4.1, Viewing Cell Counting Measurement Results) 
• DNA Concentration and Purity — Displays Status, Graphic, Info-Calc, 
Result-List, and Curve Info (refer to Section 12.4.2, Viewing DNA — 
Concentration and Purity Measurement Results). 
• DNA and RNA Oligo — Displays OD, Info-Calc, Result-List, and Status 
(refer to Section 12.4.3, Viewing DNA and RNA Oligo Measurement 
Results). 
• Pure dsDNA, ssDNA, and RNA Concentration — Displays OD, Info-Calc, 
Result-List, and Status (refer to Section 12.4.4, Viewing Pure dsDNA, 
ssDNA, and RNA Concentration Measurement Results). 
• UV-Quantitation Protein — Displays Status, Graphic, Info-Calc, Result- 
List, and Curve Info (refer to Section 12.4.5, Viewing UV-Quantitation 
Protein Measurement Results). 
This chapter covers only tabs that present information unique to cuvette applications. 
Tabs that appear identical to Quick or test measurement results are covered in detail in 
Chapter 7, Viewing Quick Measurement Results, and Chapter 11, Viewing Test and 
Multitest Assay Measurement Results. 
Cuvette application measurement results are stored in the ADAP software database 
and may be: 
• Printed to view and store a hard copy (refer to Section 11.5, Printing 
Measurement Results). 
• Exported to view in another application (refer to Section 11.6, Exporting 
Measurement Results to Other Applications). 
• Opened for viewing at any time (refer to Section 11.7, Working with 
Measurement Results Stored in the ADAP Database). 
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12.4.1 Viewing Cell Counting Measurement 
Results 
Measurement results for the cell counting cuvette application are displayed in four 
tabs: 
• OD — Displays the optical density for each sample measured (refer to 
Section 7.3.1.1, Viewing Optical Density (OD) Measurement Results). 
• Info-Calc — Displays a summary of each step performed in the cuvette 
application and indicates the success or failure of each step (refer to Section 
11.2.10, Viewing Test Status Information). 
• Result-List — Displays a summary of the data evaluated by the application, 
including parameters and measurement results (refer to Section 12.4.1.1, 
Viewing the Result-List For the Cell Counting Cuvette Application). 
• Status — Displays which samples were measured successfully and which 
were not because of errors during measurement (refer to Section 7.3.1.3, 
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Viewing Sample Status). 
12.4.1.1 Viewing the Result-List For the Cell Counting 
Cuvette Application 
Result-List displays a summary of data evaluated by the cell counting cuvette 
application, including parameters and measurement results (Figure 12-19). 
Figure 12-19. Result-List for the cell counting cuvette application 
Running Cuvette Applications 12-33 
ADAP Software for Zenyth 200 Operating Manual 
12.4.2 Viewing DNA — Concentration and Purity 
Measurement Results 
Measurement results for the cell counting cuvette application are displayed in five 
tabs: 
• Status — Displays which samples were measured successfully and which 
were not because of errors during measurement (refer to Section 7.3.1.3, 
Viewing Sample Status). 
• Graphic — Displays graphs of measurement results for each sample 
measured (refer to Section 7.3.3.2, Viewing Multiwavelength Measurement 
Graphs). 
• Info-Calc — Displays a summary of each step performed in the cuvette 
application and indicates the success or failure of each step (refer to Section 
11.2.10, Viewing Test Status Information). 
• Result-List — Displays a summary of the data evaluated by the application, 
including parameters and measurement results (refer to Section 12.4.2.1, 
Viewing the Result-List For the DNA — Concentration and Purity Cuvette 
Application). 
• Curve Info — Displays detailed information about the curve, including peak 
and valley data. Optical density and percentage transmission values for 
samples at each wavelength measured are also displayed (refer to Section 
12.4.2.2, Viewing Curve Info For the DNA — Concentration and Purity 
Cuvette Application). 
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12.4.2.1 Viewing the Result-List For the DNA — 
Concentration and Purity Cuvette Application 
Result-List displays a summary of data evaluated by the DNA — Concentration 
and Purity cuvette application, including parameters and measurement results 
(Figure 12-20). 
Figure 12-20. Result-List for the DNA — Concentration 
and Purity cuvette application 
Note: Formulas used in calculations: 
DNA concentration = abs(260-320)*62.9 +abs(280-320)*-36.0 
protein concentration = abs(260-320) *-757.29 + abs(280-320)*1552 
Warburg, O., Christian, W. (1941). Biochem. Z. 310, 384. 
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12.4.2.2 Viewing Curve Info For the DNA — Concentration 
and Purity Cuvette Application 



   
 

Biochrom ADAP Prisma Software: User’s Manual Version 3.0 
  

Curve Info displays detailed information about the curve, including peak and valley 
data. Optical density and percentage transmission values for samples at each 
wavelength measured are also displayed (Figure 12-21). 
Figure 12-21. Curve Info for the DNA — Concentration 
and Purity cuvette application 
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12.4.3 Viewing DNA and RNA Oligo Measurement 
Results 
Measurement results for the DNA and RNA oligo cuvette applications are displayed 
in four tabs: 
• OD — Displays the optical density for each sample measured (refer to 
Section 7.3.1.1, Viewing Optical Density (OD) Measurement Results). 
• Info-Calc — Displays a summary of each step performed in the cuvette 
application and indicates the success or failure of each step (refer to Section 
11.2.10, Viewing Test Status Information). 
• Result-List — Displays a summary of the data evaluated by the application, 
including parameters and measurement results (refer to Section 12.4.3.1, 
Viewing the Result-List For DNA and RNA Oligo Cuvette Applications). 
• Status — Displays which samples were measured successfully and which 
were not because of errors during measurement (refer to Section 7.3.1.3, 
Viewing Sample Status). 
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12.4.3.1 Viewing the Result-List For DNA and RNA Oligo 
Cuvette Applications 
Result-List displays a summary of data evaluated by the DNA and RNA oligo 
cuvette applications, including parameters and measurement results (Figure 12-22). 
Figure 12-22. Result-List for DNA and RNA oligo cuvette applications 
Note: Formulas used in calculations: 
Molecular Weight: 
DNA: MW= (#A*312.2)+(#C*288.2)+(#G*328.2)+(#T*303.2)-61 
RNA: MW= (#A*312.2)+(#C*288.2)+(#G*328.2)+(#U*289.2)-61 
Molar Extinction Coefficient: (ε): liter/mole/cm 
DNA:ε = (#A*15480)+(#C*7340)+(#G*11760)+(#T*8850) liter/mole/cm 
RNA: ε = (#A*15480)+(#C*7340)+(#G*11760)+(#U*9000) liter/mole/cm 
Concentration = A/ε* 106 pmole/μl=(μg/ml) *(1000)/MW 
Concentration = A/ε* MW*103μg/ml= (pmol/μl)*(MW)/1000 
Fasman, G. D., ed. (1975). Sequence: See optical properties of nucleic acids, 
absorption, and circular dichroism spectra, CRC Handbook of Biochemistry 
and Molecular Biology 3rd Edition, Nucleic Acids: Volume I. 
(p. 589). CRC Press. 
Melting Point (DNA oligo long) 
TM = 81.5 +16.6 log10[Na] + 0.41(%GC)-600/size 
Bolton, E. and McCarthy, B.J. (1962). PNAS 48:139-1397. 
Melting Point (DNA oligo short) 
TM = (#A+#T)*2+(#G+#C)*4=°C 
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Melting Point 
Appears only in DNA 
oligo results 
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12.4.4 Viewing Pure dsDNA, ssDNA, and RNA 
Concentration Measurement Results 
Measurement results for the Pure dsDNA, ssDNA, and RNA Concentration 
Measurement cuvette applications are displayed in four tabs: 
• OD — Displays the optical density for each sample measured (refer to 
Section 7.3.1.1, Viewing Optical Density (OD) Measurement Results). 
• Info-Calc — Displays a summary of each step performed in the cuvette 
application and indicates the success or failure of each step (refer to Section 
11.2.10, Viewing Test Status Information). 
• Result-List — Displays a summary of the data evaluated by the application, 
including parameters and measurement results (refer to Section 12.4.4.1, 
Viewing the Result-List For dsDNA, ssDNA, and RNA Concentration 
Measurement Cuvette Applications). 
• Status — Displays which samples were measured successfully and which 
were not because of errors during measurement (refer to Section 7.3.1.3, 
Viewing Sample Status). 
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12.4.4.1 Viewing the Result-List For dsDNA, ssDNA, 
and RNA Concentration Measurement Cuvette 
Applications 
Result-List displays a summary of data evaluated by the DNA and RNA oligo 
cuvette applications, including parameters and measurement results (Figure 12-23). 
Figure 12-23. Result-List for Pure dsDNA, ssDNA, 
and RNA Concentration cuvette applications 
Note: Formulas used in calculations: 
Pure ssDNA Concentration: 
OD value x 37 = ssDNA in μg/ml 
Pure dsDNA Concentration: 
OD value x 50 = dsDNA in μg/ml 
Pure RNA Concentration: 
OD value x 37 = RNA in μg/ml 
Maniatis, T., Fritch, E. F., Sambrook, J. (1989). Molecular cloning: A 
laboratory handbook (p. 3). 
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12.4.5 Viewing UV-Quantitation Protein 
Measurement Results 
Measurement results for the UV-Quantitation Protein cuvette application are 
displayed in five tabs: 
• Status — Displays which samples were measured successfully and which 
were not because of errors during measurement (refer to Section 7.3.1.3, 
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Viewing Sample Status). 
• Graphic — Displays graphs of measurement results for each sample 
measured (refer to Section 7.3.3.2, Viewing Multiwavelength Measurement 
Graphs). 
• Info-Calc — Displays a summary of each step performed in the cuvette 
application and indicates the success or failure of each step (refer to Section 
11.2.10, Viewing Test Status Information). 
• Result-List — Displays a summary of the data evaluated by the application, 
including parameters and measurement results (refer to Section 12.4.5.1, 
Viewing the Result-List For the UV-Quantitation Protein Cuvette 
Application). 
• Curve Info — Displays detailed information about the curve, including peak 
and valley data. Optical density and percentage transmission values for 
samples at each wavelength measured are also displayed (refer to Section 
12.4.5.2, Viewing Curve Info For the UV-Quantitation Protein Cuvette 
Application). 
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12.4.5.1 Viewing the Result-List For the UV-Quantitation 
Protein Cuvette Application 
Result-List displays a summary of data evaluated by the UV-Quantitation Protein 
cuvette application, including parameters and measurement results 
(Figure 12-24). 
Figure 12-24. Result-List for the UV-Quantitation Protein cuvette application 
Note: Source for formulas used in calculations: Warburg, O., Christian, W. (1941). 
Biochem. Z. 310, 384. 
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12.4.5.2 Viewing Curve Info For the UV-Quantitation 
Protein Cuvette Application 
Curve Info displays detailed information about the curve, including peak and valley 
data. Optical density and percentage transmission values for samples at each 
wavelength measured are also displayed (Figure 12-25). 
Figure 12-25. Curve Info for the UV-Quantitation Protein cuvette application 
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